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Vítejte

Gratulujeme ke koupi Vašeho Palm® Treo™ 500 smartphonu!

VÝHODY: 

·   VOLÁNÍ A PŘIJÍMÁNÍ HOVORŮ

·   SPRAVOVÁNÍ VAŠICH 
KONTAKTŮ,KALENDÁŘE A ÚKOLŮ

·   ODESÍLÁNÍ A PŘIJÍMÁNÍ 
ELEKTRONICKÉ POŠTY

·   SURFOVÁNÍ PO INTERNETU

·   VYUŽITÍ Bluetooth® HANDS-FREE 
(sluchátka nejsou součástí balíčku) 

KAPITOLA

1
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Váš nový 
smartphone

Ve Vašem kompaktním
a nepostradatelném zařízení - Palm 
Treo 500 Smartphone - naleznete 
toto:

·   vyspělý bezdrátový smartphone   
·   Window Mobile organizer s mož-

ností rozšíření paměti (micro SD 
karty - nejsou součástí balíčku)

·   s vysokorychlostním datovým 
přenosem  s podporou GPRS
a UMTS (3G)

·   dvoumegapixelový digitální 
fotoaparát

·   podpora bezpočtů mobilních 
elektronických emailových účtů

·   messaging pro odesílání
a přijímání textových
a multimediálních zpráv

·   Windows Media Player Mobile
·   Microsoft Office Viewer 

 TIP Zde vždy naleznete užitečné   
 informace

Balení obsahuje
 

Hardware
·   Treo 500 smartphone
·   dobíjecí baterii (1200 mAh)
·   nabíječku (s redukcemi)
·   USB synchronizační kabel
·   stereo sluchátka

Dokumentace a software
·   Read this first brožuru
·   Treo Smartphone Quick Referen-

ce (osvědčení)
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· Windows Mobile Getting Started 
CD, které obsahuje následující:

· ActivSync desktop software pro 
Windows XP, Windows Mobile 
Device Center pro Windows Vista

· Microsoft Office Outlook 

· uživatelskou příručku

· záruční list

· licenční smlouvu s koncovým 
uživatelem
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Korporační podpůrná
síť / váš IT administrátor
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Nastavení

Právě se chystáte objevit mnoho věcí o vašem smartphonu, které 
vám pomohou lépe řídit váš život a bavit se.

Až se více obeznámíte s vašim smartphonem, budete si chtít 
vytvořit osobní nastavení a přidat vlastní aplikace k tomu, aby se stal 
jedinečným a zcela podle vašich představ. Ale nejprve následujte 
těchto pár snadných kroků k uvedení smartphonu do chodu.

VÝHODY: 

·  Zjistíte kde jsou umístěny ovládací prvky 

·   Začněte používat váš smartphone 
hned teď

KAPITOLA

2
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Palm® Treo™ 500 smartphone přehled

Overview

Earpiece

Microphone

5-way navigator 
with Center button

Back

MiniUSB 
connector (for 
synchronization 
and charging)

2.5 mm headset jack

Home

Phone/Send 

End 

Volume

Left softkey

Right softkey

Lanyard 
connector

Side button

Indicator light (visible 
when smartphone is 
being charged)

Ukazatel směru
(viditelný když se 
smartphone nabíjí)

Reproduktor

5-ti polohová 
kurzorová klávesa

Mikrofon

MiniUSB konektor
(pro synchronizaci 
a nabíjení)

Zpět

Konec

Pravý softkey

2,5 mm konektor 
sluchátek

Úchyt na zavěšení 
šnůrky-pásku

Pohled zepředu

Home

Volat/odeslat

Levý softkey

Boční tlačítko

Hlasitost
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Battery door 

Camera lens SpeakerMicroSD expansion 
card tray (located 
inside battery 
compartment, 
beneath battery)

SIM card slot 
(located inside 
battery 
compartment, 
beneath battery)

Smartphone 
contacts (located 
on side of battery 
compartment)

Battery

Battery contacts

Pohled zezadu

Baterie

Místo pro uloženi 
rozšiřující MicroSD 
karty (v části pro 
uložení baterie
-pod baterii)

Čočka fotoaparátu

Kontakty baterie

Kryt baterie

Slot pro uložení 
SIM karty (také
v části pro 
uložení baterie 
- pod baterii)

Kontakty 
smartphonu
(na stranách v části 
pro uložení baterie)

Mikrofon

TIP Dávejte pozor, abyste nepoškrabali 
nebo nerozdrtili obrazovku smartphonu.  
Nenechávejte jej v místech, kde by jej 
mohli poškodit jiné předměty.

VĚDĚLI JSTE, ŽE? 
Zmáčknutím a přidržením bočního 
tlačítka otevřete Internet Explorer 
Mobile (dále v sekci: Prohlížení 
webových stránek)

TIP Pro připnutí  pásku (prodává se 
odděleně), odstraňte kryt baterie, 
připněte pásek a vraťte kryt baterie zpět.
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DŮLEŽITÉ:
Reproduktor smartphonu obsahuje  
magnet, proto se ujistěte, že se 
nenalézá v blízkosti kreditních karet 
nebo jiných předmětů, které mohou být 
demagnetizovány. 

TIP Před použitím smartphonu sejměte 
modré ochranné folie z obrazovky 
a čočky fotoaparátu.

Vložení SIM karty 
a baterie

Vaše SIM karta obsahuje
informace o účtu například
o vašem telefonním čísle a čísle 
hlasové pošty .
Proto k tomu, aby jste mohli použít 
váš Smartphone - telefon, email 
a internet, potřebujete vložit SIM 
kartu. 

Pokud není SIM karta součástí va-
šeho balíčku,  je třeba si ji zakoupit 
u mobilního operátora.

1.  Otočte telefon obrazovkou dolů. 
Použitím dvou nebo více prstů 
zatlačte na kryt, zároveň tahem 
dolu otevřete zadní část smart-
phonu.

Power

Pohled shora
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NotchZářez

Battery 
contacts

Smartphone 
contacts

Kontakty 
baterie

Kontakty 
Smartphonu

2.  Pokud je instalovaná baterie, 
vyjměte ji, a to tak, že vsunete 
prst po levé straně pod baterii a 
nadzvednete ji. 

3.  Místo pro SIM kartu se nalézá v 
levém rohu prostoru pod baterií. 
Otočte SIM kartu kovovými 
kontakty směrem dolů a vsuňte 
dovnitř. Zkontrolujte zda karta 
zapadla přesně na místo. 

4.  Ujistěte se, že zlaté kontakty 

baterie se kryjí přesně s kontakty 
smartphonu. Pod úhlem 45 stup-
ňů vsuňte baterii zpět .

5. Uzavřete krytem.

6.  Stiskněte a přidržte tlačítko 
Power   dokud se
neobjeví logo Palm®.

TIP Pokud se váš smartphone nezapne po-
tom co vložíte baterii, připojte jej na nabíječku 
a dobijte baterii (viz nabíjení
baterie). Pokud se i přesto nezapne proveďte 
měkký reset (viz. řešení problémů).

7.  Jestli není SIM karta ještě 
aktivována, následujte instrukce 
vašeho operátora nebo kontaktuj-
te operátora pro asistenci.
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Jestli plánujete používat email
a webový prohlížeč, potřebujete 
navíc k vaší smlouvě datovou služ-
bu(servis)od  operátora.
A také službu pro přijímaní MMS. 

Nabíjení baterie
Ačkoli baterie může být dostateč-
ně nabitá pro dokončení procesu 
nastavení. Doporučujeme vám, aby 
jste po nastavení nabíjeli dále váš 
smartphone po tři hodiny.(dokud 
nebude indikátor nabití zelený) 
Podívejte se na maximalizování 
životnosti baterie, aby vaše baterie 
vydržela déle.

TIP Pro delší cesty nebo přenos velkého 
množství dat, doporučujeme zakoupit si
rezervní baterii. Kvůli správné funkci 
smartphonu a proti zrušení záruky, se 
vždy ujistěte, že kupujte pouze baterie
s označením PALM. Navštivte
www.palm.com. 

Předtím než začnete 
nabíjet
Než začnete nabíjet, ujistěte se, že 
je baterie vložená ve vašem smart-
phonu. Pokud omylem začnete 
nabíjet bez baterie smartphone nic 
se přístroji nestane. 

1.  V balíčku se smartphonem 
naleznete adaptéry k nabíječce, 
vyberte ten správný dle vaší 
zásuvky.

2. Vsuňte nabíječku do zásuvky

3. Připojte smartphone. 

Indicator light
                                       

Indikátor nabíjení
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4.  Zkontrolujte indikátor baterie a 
ujistěte se, že probíhá nabíjení.

     ·  červené světlo - signalizuje 
nabíjení

     ·  zelené světlo - signalizuje plně 
nabitou baterii.

VĚDĚLI JSTE, ŽE? 
Před vybitím baterie začne blikat červeně 
indikátor baterie.

Kdy je váš smartphone zapnutý,
na obrazovce se objeví stav baterie:

Tato ikona signalizuje, že se 
baterie nabíjí.

Tato ikona signalizuje, že je 
baterie plně nabitá.

Tato ikona signalizuje, že 
baterie potřebuje neprodleně 
nabít.

VĚDĚLI JSTE, ŽE? 
I přesto, že dojde k úplnému vybití 
baterie, vaše data nejsou ztracena.
Pro jejich zpřístupnění musíte jen baterii 
smartphonu znovu dobít. 

TIP Baterii smartphonu můžete také 
nabíjet připojením k vašemu počítači
synchronizačním kabelem.

Maximalizování životnosti baterie 
Životnost baterie závisí na tom jak 
využíváte váš smartphone. Její životnost
můžete maximalizovat následovně:

·  Nabíjejte smartphone kdykoli máte 
možnost, nabíjejte i přes noc.

·  Baterie ve vašem smartphonu má 
mnohem delší životnost, pokud ji 
nabíjíte častěji, než když čekáte s 
nabíjením do jejího úplného vybití.

Ikona baterie



23

·  Pokud trávíte více času používáním 
fotoaparátu, her nebo multimediálního 
přehrávače (včetně poslouchání 
hudby s bezdrátovými sluchátky se 
zabudovanou Bluetooth® bezdrá-
tovou technologií) nebo dalších 
aplikací, sledujte ikonu baterie a 
pokud je třeba dobíjejte. 

·  Bezdrátové funkce (telefon, email,
zprávy, instant messaging a internet) na 
vašem smartphone obecně spotřebují 
více energie z baterie než funkce orga-
nizéru. Pokud neplánujete nějaký čas 
používat bezdrátové funkce, můžete je 
vypnout (kapitola vyp. a zap. bezdráto-
vých služeb). Můžete přesměrovat volání 
na jiné číslo nebo si necháte hovory 
nahrát do hlasové schránky (viz kapitola 
přesměrování hovorů). Zda jste připojeni 
k bezdrátovým funkcím zjistíte tak, že 
stisknete tlačítko POWER   a vy-
berete bezdrátový manažer (Wireless 
Manager).

·  Jestliže synchronizujete email a další
informace přímo s vaším zprostřed-
kovatelským serverem pomocí Micro-
soft Exchance ActiveSync®, nastavte 
interval synchronizace na maximum 

15 minut během špičky a každou 
hodinu (nebo vypněte úplně) mimo 
špičku (podívejte se na Nastavení 
synchronizace).

·  Vypněte Bluetooth pokud jej nepouží-
váte (viz.Bluetooth nastavení).

·  Jako u jiných mobilních telefonů, 
v době kdy se nacházíte v oblasti, 
kde není bezdrátové pokrytí, smart-
phone stále vyhledává signál.
Přičemž spotřebovává velké množství
energie z baterie. Jestliže se nemůžete
přesunout do oblasti lepšího po-
krytí, dočasně telefon vypněte (viz. 
vypínání a zapínaní telefonu)

·  Zeslabte podsvětlení obrazovky
(viz.regulace jasu).

·  Nastavte obrazovku tak, aby se vypnula
automaticky po kratším období 
nečinnost (viz optimalizace nastavení)

·  Vypněte volbu přijímání Bluetooth 
(viz zapínání možnosti přijímání 
Bluetooth) 

TIP Když je váš telefon zapnut, stisněte 
Power pro zobrazení voleb rychlého 
vypnutí telefonu( viz. vypínání mobilu), 
nebo vypnout zvonění( viz výběr profilu 
zvonění) a další. 
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·  Jestli užíváte k připojení na internet  
internetovou přípojku (Internet 
Connection Sparing), použijte k 
připojení raději USB synchronizační 
kabel namísto používání bezdráto-
vého Bluetooth  (viz použití zařízení 
jako bezdrátového modemu).

·  Chraňte baterii před přímým 
slunečním světlem a jinými zdroji 
tepla. Teploty přes 50 stupňů Celsia 
mohou permanentně redukovat ka-
pacitu a životnost  lithiové baterie. 

·  Nabíjejte baterii při pokojové teplo-
tě. Nabíjení v chladných teplotách 
má za následek nižší použitelnou 
nabíjecí kapacitu baterie.

První volání
1.  Stiskněte HOME  pro zobra-

zení domácí obrazovky.

2.  K vytáčení telefonních čísel
používejte číselnou klávesnici 
(můžete také použít tlačítka 
+,*,#  obejdete tím použití
tlačítka možnost volby .

TIP Pokud netelefonujete, můžete pro 
zobrazení domácí obrazovky použít 
tlačítka End. Při volání je váš hovor 
tlačítkem End ukončen.
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3.  Stiskněte tlačítko Telefonovat/
Odeslat , tím vytočíte číslo

4.  Po ukončení hovoru stiskněte 
tlačítko Konec  .

Nastavení hlasitosti hovoru
V průběhu hovoru, stiskněte 
tlačítko Hlasitosti na levé straně 
telefonu a nastavte hlasitost.

Jaké je mé číslo?

NEŽ ZAČNETE 
Ujistěte se, že je váš telefon zapnu-
tý (podívejte se na otočeni vašeho 
telefonu

1.  Stiskněte tlačítko HOME 
potom stiskněte START  

(levé měkké tlačítko).
2.  Stiskněte tlačítko MORE  

(levé měkké tlačítko) a vyberte 
Nastavení .

3.  Vybrat Phone a dále vybrat  
možnosti volání Call options.

4.  stiskněte DONE   
(levé měkké tlačítko).

Volume Hlasitost

Zde 
naleznete 
své 
telefonní 
číslo .
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TIP Jestliže se vaše telefonní číslo ne-
zobrazilo na obrazovce call options (mož-
nosti volání) systém ještě  neposlala číslo 
k SIM kartě (což nijak neovlivňuje funkci 
SIM). Vypněte telefon, počkejte několik 
hodin, a potom zapněte telefon znovu 
a opakujte postup. Jestliže se i poté 
neobjeví vaše telefonní číslo, kontaktujte 
a požádejte o pomoc vašeho operátora.

Nastavení 
synchronizace
Potom co jste dokončili nastavení 
vašeho smartphonu, vám doporu-
čujeme, abyste nastavili metodu 
synchronizace. Tak aby byl co 
nejlépe využit váš telefon.
Synchronizace znamená, že infor-
mace které byly uloženy a aktua-
lizovány na jednom místě v tele-
fonu, v počítači nebo na vašem 
firemním serveru jsou automaticky 
aktualizovány i jinde (viz na syn-
chronizace informací).
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Orientace ve vašem 
Palm® Treo™ 500 smartphonu

Byl jste někdy v novém městě a cítil jste se trochu ztracený do té doby, 
než jste rozeznal a pojmenoval ulice? Poznávání jak se pohybovat ve va-
šem Palm® Treo™ 500 smartphone je podobné. Většina aplikací na Palm® 
Treo™ 500  užívá stejnou sadu ovládacích prvků. 
Takže jakmile se naučíte, jak použít tyto ovládací prvky,  pojedete všude 
po městě a dokonce  nebudete potřebovat mapu.

VÝHODY: 

·  Rychlý pohyb a práce s aplikacemi po-
mocí 5-ti polohové kurzorové klávesnice

·  Zpřístupnění nabídek menu

·  Rychlé nalezení a otevření aplikací

KAPITOLA

3
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Pohyb po displeji
Pro pohyb po obrazovce smart-
phonu, používejte 5-ti polohovou 
klávesu. Jakmile se lépe seznámíte 
s vaším smartphonem, najdete si 
vlastní oblíbené způsoby jak přetá-
čet, zvýrazňovat a vybírat položky. 

Používáním 5-ti polohové klávesy 
zmáčknutím Vpravo ,Vlevo , 
Nahoru  nebo Dolů   se mů-
žete pohybovat po celé obrazovce.
Pro výběr položky stisknete Střed 
klávesy .

TIP Ikona s šipkou, která naznačuje směr 
pohybu 5-ti polohové klávesy, jsou jiné 
než šipky na obrazovce, které znamenají, 
co je k dispozici v seznamu.

Up 

Down 

Left Right 

Center nahoru
5-ti polohová 
kurzorová klávesa

dolů

dopravadoleva
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Rolování po obrazovce 
Tak jako na počítači i na vašem 
smartphonu můžete rolovat po 
obrazovce z položky na položku 
stránky. V některých případech 
můžete označit položku nebo volbu 
ze seznamu. Je několik metod 
rolování:
·  Použití 5-ti polohové klávesy 

. Stisknutím Pravé , Levé 
, Horní  nebo Dolní  části, se 
můžete přesunout na další pole, 
další tlačítko nebo na jinou činnost .

·  Uvnitř textového pole, stiskněte 
Pravé  nebo Levé  tlačítko, tak se 
přesunete k dalšímu znaku, stisknutím 
tlačítka Nahoru  nebo Dolů   se 
pohybujete mezi jednotlivými řádky. 

·  Stisknutím a přidržením tlačítka 
nahoru a dolů se můžete rychle 
pohybovat po seznamu. 

Zavření obrazovky
·  Pro přijetí informací, které jste 

napsali na obrazovku a navrácení k 
původní obrazovce  nebo pro návrat 
k původní obrazovce bez vytvoření 
změn - stiskněte tlačítko ZPĚT 

Zvýraznění a výběr položky
Na většině obrazovek je jedna položka 
- ikona, vstup do seznamu nebo 
zaškrtávací rámeček - zvýrazněný 
standartně. Zvýraznění označuje 
položku, kterou můžete použít 
pro další činnost. Použitím 5ti-
polohové klávesy můžete pohybovat 
zvýrazněním z jedné položky na 
druhou.

TIP Jestliže se na pravé straně obrazovky 
objeví posuvník, signalizuje to, že je 
nabídka dostupných voleb větší než, 
ta která je znázorněná na obrazovce.
Opětovné stisknutí 5ti-polohového tlačítka 
nahoru nebo dolů displejem odhalí další 
možnosti.

Scroll bar
Posuvník
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TIP Nejlepší způsob jak se naučit použí-
vat 5-ti polohovou klávesu, je experimen-
tovat. Stiskněte 5-ti polohovou klávesu 
a při tom následujte pohyb ohraničení po 
obrazovce. Chování 5-ti polohové klávesy 
se v různých aplikacích mírně liší. 

Zvýraznění může mít dvě formy, 
záleží na tom, co je zvýrazněno:

Hranice: 
Tato pravoúhlá hranice zvýrazní po-
ložky např. textu - pole, ovládacího 
rámečku, volby nebo web odkazu.

Světlý text 
na tmavém pozadí: 
Zvýraznění položky jako např. 
telefonního čísla, emailové adresy, 
položky v menu nebo seznamu. Po 
zvýraznění položky 5-ti polohovou 
klávesou, vyberte nebo aktivujte 
položku stisknutím Středu .



32

Používání softkeys

Levý softkey akti-
vuje tento příkaz

Pravý softkey akti-
vuje tento příkaz

Pravé a levé měkké tlačítko - dále 
softkey vám umožní rychlý přístup 
k úkolům-činnostem na aktuální 
obrazovce, položky softkey se různí 
od aplikace k aplikaci a od obra-
zovky k obrazovce. Podívejte se na 
obrazovku přímo nad softkey, kde 
uvidíte aktuální činnost související 
s tlačítkem. Občas se nad softkey 
činnost nezobrazí. Ve většině přípa-
dů pravý softkey   otevírá menu 
a levý aktivuje specifický příkaz, 
jako například NEW - nový nebo 
DONE - dokončeno. Pamatujte si, 
že funkce softkey   se různí od 
obrazovky k obrazovce, tak se ujis-

těte, že jste zkontrolovali štítek-funk-
ci softkey před jeho stisknutím.

Výběr položek z menu
V mnoha aplikacích poskytuje 
menu přístup k přidaným funkcím. 
Menu zůstává skryto dokud ne-
stlačíte tlačítko Menu   (pravý 
softkey). Pro co nejširší využití 
vašeho smartphonu, je dobré, aby 
jste se co nejvíce obeznámili 
s přidanými funkcemi dostupnými 
v menu různých aplikací.
1.  Stiskněte Menu   (pravý 

softkey) pro zobrazení menu 
aplikací.
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2.  Stisknutím tlačítka Nahoru 
a Dolů   zvýrazníte položku
v menu.

3.  Pokud se objeví šipka nahoře 
nebo ve spodní části zobraze-
ných položek menu, stisknutím 
tlačítek Nahoru  a Dolů  

se dostanete do dodatečných 
položek.

4.  Pokud se šípky objeví na pravé 
straně položky v menu, stisknu-
tím Centru  nebo Pravého 

 tlačítka se zobrazí podnabídka 
dodatečných položek. Po stisk-
nutí tlačítka Nahoru  nebo 
Dolů   zvýrazníte položku 
v menu. Pro návrat k původnímu 
menu bez dalšího výběru, stisk-
něte tlačítko Vlevo .

5. Stisknutím Centru  vyberete 
položku v menu, stisknutím Vlevo 

 nebo Menu   (pravý softkey) 
zavřít menu a zrušíte výběr.

Výběr možností ze seznamu
Pokud se objeví čtvercové ohrani-
čení kolem pole a pole obsahuje 
obě - pravou i levou šipku seznam 
je k dispozici. Na obrazovce se 
zpravidla ohraničení neobjeví do té 
doby, než se do pole přesunete 5-ti 
polohovou klávesou.

VĚDĚLI JSTE, ŽE?
Můžete vybrat většinu položek v menu
stisknutím tlačítka na klávesnici. Pro rych-
lé zpřístupnění položek v menu, stiskněte 
Menu (pravý softkey)zároveň s ním stisk-
něte podtržené písmeno v položce menu.
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TIP Pole na kterých se zobrazuje pouze 
pravá šípka neobsahuje seznamové polož-
ky. Jsou to buď pole pro vepsání textu,
 (viz použití textových polí vstupu) nebo
pole výběru (v kalendáři v kontaktech nebo 
úkolech). V poli výběru, stisknete Center 
nebo Right pro zobrazení další volby.

POZNÁMKA 
Seznam v kalendáři a úkolech je k dispo-
zici i přesto, že se u něj neobjeví symbol 
šipky. Seznamy jsou jiné než ty, které 
jsme popisovali v předešlé části.
Pro výběr ze seznamu proveďte násle-
dující: Použijte 5-ti polohové tlačítko pro 
zvýraznění pole a poté stiskněte Center 
pro zobrazení položky v seznamu. Stisknu-
tím tlačítka Up a Down zvýrazníte položku 
kterou chcete a stisknutím tlačítka Center 
provedete výběr.

Šipky signali-
zují seznam, 

stisknete 
Center pro 
zobrazení 
seznamu.
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Po zvýraznění pole, stiskněte
Vpravo  nebo Vlevo , tak se 
můžete pohybovat v možnostech 
volby, dokud se neobjeví ta, kterou 
chcete. Toto funguje ve všech 
seznamových polích s výjimkou 
předmětových polí v kalendáři 
a úkolech.  V polích kalendáře 
a úkolů se tisknutím Center 
zobrazí seznamové položky.

Používání 
klávesnice

Levý softkey 

Telefon/pošli

Home (výchozí)

Option - volba

Shift

Mezerník Alt

Pravý softkey

Konec
Zpět

Klávesa zpět

Vrátit se
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Používejte klávesnici pro psaní textu 
a symbolů v mnoha aplikacích na 
vašem smartphonu, stejně tak pro 
vytáčení telefonních čísel  (viz. použití 
domovské obrazovky).

POZNÁMKA 
V závislosti na vašem regionu může být 
uložení tlačítek klávesnicve odlišné od 
uložení na předchozí stránce. 

Význam klávesového 
podsvícení 
Váš smartphone má klávesové 
podsvícení pro použití ve špatných 
světelných podmínkách.Podsvícení 
se aktivuje při zapnutí obrazovky.
Podsvícení klávesnice se vypíná au-
tomaticky při vypnutí obrazovky, také 
pokud telefonujete nebo posloucháte 
hudbu po dobu delší než je nastave-
no automatické vypínání podsvícení 
v nastavení telefonu. Můžete nastavit 
různý časový interval v závislosti na 
tom, jestli smartphone právě používá 
jako zdroj baterii nebo externí zdroj. 
Podsvícení také vypínají z úsporných 
důvodu některé aplikace.

TIP Interval vypínání podsvícení můžete 
nastavit takto. Stiskněte Home (tlač. ná-
vrat), stiskněte Start(začít levý softkey), 
stisknete More (více levý softkey) 
a potom vyberte Settings (nastavení).
Vyberte More (více ) a vyberte Power 
Managment. Použijte Backlight time 
on a nastavte dobu podsvícení.

Používáni textových 
polí vstupu
V aplikacích jako jsou kontakty, ka-
lendář nebo úkoly, jsou textová pole 
označena obdelníkovým rámečkem. 
Většinou se na obrazovce toto označe-
ní neobjeví dokud nevstoupíte do pole 
pomocí 5-ti polohového tlačítka.

Pro vložení textu do pole, zvýrazněte 
pole a pomocí klávesnice zadejte text. 
Některá textová pole jako např. pole 
pro vložení názvu ulice v kontaktech, 
poznámkové pole v kontaktech a kalen-
dáři - zobrazí šipku doprava. V těchto 
polích se po stisknutí Center  nebo 
Vpravo  otevře obrazovka textového 
pole pro vložení více řádků. 

Adresa a předmět emailu, text nebo 
multimediální zpráva, kterou tvoříte, 
stejně tak jako zpráva sama jsou také 
textovými poli vstupu.
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Psaní velkých a malých 
písmen
Standardně je první písmeno začátku 
věty velké a zbývající malá.
V některých případech se objeví 
velké písmeno na začátku věty 
až po dopsání slova, stisknutí 
Mezerníku  nebo stisknutím 
tlačítka Return .

TIP Pokud se objeví v poli šipky vpravo 
i vlevo zároveň, není to textové pole, ale 
pole které obsahuje seznam (viz výběr-
možností ze seznamu).

Pro psaní velkých písmen pro-
veďte následující:
·  Stisknete Shift   a napište 

písmeno, není třeba shift držet 
v průběhu psaní. 

·  Stisknete dvakrát Shift   pro za-
pnutí Caps Lock (zámek písmen), 
to vám umožní napsat více velkých 
písmen za sebou.Když je Caps 
lock zapnutý objeví se dole na 
obrazovce tento symbol . Chce-
te-li vypnout Caps lock, stiskněte 
znovu Shift  .

.

Psaní číslic, interpunkce
a symbolů
Čísla, interpunkce a symboly se 
objevují nad písmeny na tlačítcích 
klávesnice. Pro psaní znaků proveďte 
následující:
·  Stisknete tlačítko Volby  a po-

tom stiskněte tlačítko požadované-
ho znaku.Není třeba držet tlačítko 
Option v průběhu psaní symbolu.

•·  Stisknete dvakrát tlačítko Volby 
 pro zapnutí Zámek volby. To 

vám umožní vložit sérii znaků. Když 
je Zámek volby zapnutý, objeví 
se dole na obrazovce tento sym-
bol: .Chcete-li vypnout  Zámek 
volby, stiskněte znovu Volby .

Psaní dalších symbolů
a diakritiky
Symboly a diakritika, které se neobje-
vují na tlačítcích klávesnice,
můžete vkládat pomocí alternativního 
seznamu znaků.
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1.  Stiskněte  Alt  pro zobrazení 
alternativního seznamu znaků.

2.  Stiskněte Prev  (levý 
softkey) nebo Next  (pravý 
softkey)pro pohyb po seznamu 
obrazovky.

3.  Když se objeví požadovaný 
znak, použijte 5-ti polohové 
tlačítko  pro zvýraznění

4. Stiskněte Center  a vložte 
znak

TIP Pro rychle zobrazení nejčastěji 
používaných znaků, stiskněte Alt a poté 
stisknete Prev (levý softkey).

Zadávání hesel
Heslo, které píšete se z důvodů 
bezpečnosti na obrazovce nezobrazí. 
Proto buďte opatrní při jeho zadávání. 

Ujistěte se, že není zapnutý Caps 
Lock ani Option lock, pokud je 
nepotřebujete. Informace o psaní 
velkých a malých písmen, čísel, 
interpunkce a symbolů naleznete 
na předchozí stránce.

Otevírání
a zavírání aplikací
Můžete použít nabídku Start pro 
zpřístupnění všech aplikací na 
vašem smartphonu.

Jsou dostupné také zkratky, 
které vám umožní rychlý přístup 
k aplikacím. Na vašem smart-
phonu může být spuštěno více 
aplikacínajednou, takže pokud již 
nechcete aplikaci používat stačí 
otevřít jinou. 
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Používání nabídky START
1.  Stisknete Home  a další 

tlačítko Start  (levý softkey)

2.  Pohybujte se směrem k aplikaci, 
kterou chcete otevřít:

    ·  Když se objeví aplikace 
v seznamu, stisknutím tlačítek 
nahoru a dolu ji zvýrazněte

    ·  Stisknete tlačítko More  
(levý softkey)pro zobrazení 
přídavných aplikací.

    ·  Stisknutím tlačítka Zpět  se 
vrátíte k předchozímu seznamu 
aplikací.

·  Pokud se aplikace, kterou 
hledáte neobjeví v žádném se-
znamu, může to znamenat, že 
je uložena například ve složce 
Office Mobile nebo Accesso-
ries(příslušenství). 

Pro zobrazení aplikace ve 
složce, zvýrazněte složku a 
stiskněte Center . Pokud 
chcete složku opustit stiskněte 
tlačítko Zpět  pro návrat do 
seznamu aplikací.

3.  Stiskněte Center  a otevřete 
zvýrazněnou aplikaci 

Použití zkratek
Otevření kontaktů: Stiskněte 
Home  a poté stiskněte Kon-
takty  (pravý softkey).

Otevření Internet Explorer 
Mobile: Stiskněte a přidržte tlačít-
ko na straně telefonu.

Naposledy spuštěné aplikace:
Stiskněte Home , poté Pra-
vou  nebo Levou  šipku. pro 
zvýraznění ikony aplikace v horní 
části obrazovky a  stiskněte Cen-
ter .
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TIP V seznamu aplikací, se na levé straně 
objeví písmeno. Pro rychlý vstup do apli-
kace stisknete Home, stisknete Start(le-
vý softkey)a potom písmeno odpovídající 
dané aplikaci na klávesnici.

VĚDĚLI JSTE, ŽE? Pokud nainstalujete 
na váš smartphone další aplikace (viz in-
stalování aplikací) Položky v nabídce Start 
se posunou níže ze své původní pozice. 

Zavírání aplikací
Můžete mít několik aplikací otevřeno 
najednou, proto nepotřebujete zavírat 
aplikace, když chcete otevřít další. Ve 
většině případů se aplikace uzavřou 
automaticky, když je využitelná paměť 
nízká, ale vy můžete také zavřít aplika-
ce manuálně.

POZNÁMKA 
Jestliže opustíte aplikaci stisknutím tlačít-
ka Zpět , aplikace zůstává spuštěna 
na pozadí. Manuální ukončení aplikace 
zvyšuje kapacitu volné paměti.

1.  Stiskněte Home  a potom 
tlačítko Start  (levý softkey)

2.  Stiskněte More  (levý 
softkey) a vyberte Doplňky .

3.  Vyberte Task Manager (Úko-
lový manažer).

4.  A vyberte si jeden z následují-
cích kroků:

Uzavření jedné aplikace:
Zvýrazněte aplikaci, kterou chcete
a stiskněte Close  (zavřít levý 
softkey).
Uzavření všech otevřených 
aplikací:
Stiskněte Menu (pravý softkey)
a vyberte Close all (zavřít vše)

Použití domovské 
(home) obrazovky
Na vaší domácí obrazovce můžete 
okamžitě zjistit stav volání a spojení 
a vstoupit do všech aplikací.
Pro zpřístupnění vaší domácí obra-
zovky - stiskněte Home .
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Podívejte se na „ikony a jejich 
význam“, kde se dozvíte vše o 
ikonách na vašem smartphonu.

Stisknutím tlačítka Start 
 (levý softkey) se zpřístupní 

nabídka Start a otevře aplikace (viz 
použití nabídky Start).

Stisknutím tlačítka 
Contacts  (pravý softkey) 
se otevře aplikace kontakty.

TIP Domácí obrazovku můžete také ote-
vřít stisknutím tlačítka End (konec), pokud 
v té chvíli telefonujete váš hovor bude
ukončen.

TIP Pro domácí obrazovku si můžete 
vybrat vlastní pozadí a položky.
(viz nastavení domácí obrazovky)

Title bar- Navigační lišta 
a stavové ikony
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Váš telefon
Telefon je vaší základnou pro volání a přijímání hovorů.

Můžete kreativně zvládnout vícečetná volání, přesun mezi hovory 
a vytváření konferenčních hovorů.  
Můžete si zpřístupnit hlasovou poštu a používat k volání klasická nebo 
bezdrátová sluchátka.

VÝHODY:
·   Zůstanete v kontaktu - vy si vyberete  jak
·   Ve chvíli, kdy voláte můžete pracovat v jiných aplikacích 
·   Můžete uskutečňovat konferenční hovory až s pěti dalšími volajícími najednou

KAPITOLA

4
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Vypínání a zapínání 
smartphonu Palm® 

Treo™ 500
Termín smartphone poukazuje na 
zařízení s určitými fyzickými vlast-
nostmi. Termín telefon poukazuje na 
bezdrátovou vlastnost Palm®

Treo™ 500 smartphonu, která vám 
umožní se připojit k mobilní síti, volat 
a přijímat hovory a posílat a přijímat 
data. Telefon a smartphone mohou 
být vypínány nezávisle na sobě. To 
znamená, že můžete zapnout smart-
phone a používat pouze jako organi-
zér, bez nutnosti zapínání telefonu. 

Zapínání smartphonu
• Stiskněte a přidržte POWER  
dokud se neobjeví logo Palm®. 

Vypínání smartphonu
• Stiskněte a přidržte POWER 
dokud se obrazovka nevypne.

Když je váš smartphone vypnutý, 
nemůžete volat ani přijímat telefonní 

hovory nebo používat jakoukoli z apli-
kací Microsoftu Office nebo organizé-
ru. Všechna příchozí volání spadnou 
do hlasové pošty - schránky.

Zapínání telefonu 
Když zapnete telefon jste automatic-
ky připojeni k bezdrátové síti, takže 
můžete volat i přijímat telefonní 
hovory a využívat bezdrátové služby.

NEŽ  ZAČNETE Proto, abyste mohli 
používat telefon, musíte mít ve vašem 
telefonu vloženou aktivovanou SIM kartu 
(od zřizovatele sítě mobilního operátora) 
(viz vkládání SIM karty a baterie).

POZNÁMKA Když úplně poprvé 
zapnete smartphone, telefon se zapne 
automaticky(viz zapínání smartphonu).

TIP Pokud je baterie vybitá, obrazovka 
se nezapne, i když stisknete a přidržíte 
Power. Pokud se tak stane, musíte bate-
rii nejprve nabít.

TIP Smartphone můžete také vypnou 
stisknutím Power a výběrem Power off. 
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1. Stiskněte POWER  a vyber-
te Wireless Manager (bezdrá-
tový manažer)

2. Vyberte Phone (telefon)

3. Stiskněte Done  (levý 
softkey)

Když smartphone lokalizuje signál,
jméno vašeho mobilního operátora 
se objeví vlevo nahoře na obrazov-
ce. Ikona intenzity signálu 
se objeví v horní části obrazovky.
Když jste v oblasti pokrytí, ikona 

intenzity signálu  obsahuje 
čárky. 
Pokud jste mimo oblast pokrytí, 
začne světelný indikátor blikat 
a neobjeví se žádné čárky v ikoně 
intenzity signálu.
V této situaci zvažte zda není lepší 
telefon vypnout a šetřit tak baterii.

Vypínání telefonu
1. Stisknete POWER  a vyber-
te Wireless Manager(bezdrátový
manažer)
2. Vyberte Phone (telefon).
3. Stiskněte Done  (levý 
softkey).
Když je váš telefon vypnutý, objeví 
se v horní části obrazovky ikona 
vypnutého telefonu  a  vpravo 
nahoře nápis Phone off.
Váš telefon není připojený k žádné 
mobilní síti. Ačkoli nemůžete 
telefonovat nebo používat email 
a internet, můžete použít Micro-
soft Office aplikace a organizér na 
smartphonu.
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TIP Když cestujete letadlem je třeba vy-
pnout všechna rádiová zařízení na smart-
phonu, což zahrnuje telefon a Bluetooth® 
bezdrátovou technologii. Toto je uvedeno 
v letovém režimu. 

Pro vypnutí 
stisknete Power vyberte Wireless 
Manager(bezdrátový manažer)
a vyberte vše all.

TIP Můžete také stisknout Power 
a vybrat tichý režim rychle vypnout 
zvonění na vašem telefonu.

Probuzení 
(oživení obrazovky)
Po určitém období nečinnost - stan-
dard je jedna minuta, obrazovka 
smartphonu ztmavne, aby se šetřila 
baterie.
Samotný smartphone není vypnut,  
vy jen potřebujete vzbudit - oživit 
obrazovku, aby jste ji mohli znovu 
používat.

Stiskněte proto kteroukoli klávesu.

Stisknete End  a objeví se do-
movská obrazovka.

Stiskněte jakoukoli kláve-
su: objeví se naposledy užívaná 
obrazovka.
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TIP Symbol (+)můžete vložit stisknutím 
a přidržením 0 (nula) nebo stisknutím 
a přidržením Volby + W. Pokud použijete 
metodu stisknutí Volby +W, musíte 
stisknout znovu Volby před dopsáním 
zbytku tel. čísla. Bez ohledu na metodu, 
kterou využíváte, můžete vepsat jen jeden 
symbol (+) do telefonního čísla.

TIP Stiskněte P (pauza) v průběhu vytá-
čení tel. čísla. Usnadní vám to následování 
dalších instrukcí.

Stiskněte  Phone/ Send  
a telefonujte.

POZNÁMKA Pro zpřístupnění čísel na 
klávesnici nemusíte stisknout Volby  
Nicméně vytáčení krátkých tel. čísel, si 
může odporovat se jmény v kontaktech. 
Pokud se toto stane, stisknutím Volby  
se vyhnete vyhledávání v kontaktech. 
V případě nouze můžete vytáčet čísla tís-
ňové linky bez použití tlačítka Volby . 

Vytáčení čísel ze seznamu 
kontaktů. 
Rychle můžete vyhledat kontakty 
po vepsání počátečních písmen
jména kontaktu přímo z vaší do-
movské obrazovky.

NEŽ ZAČNETE
• Předtím, než můžete vytočit číslo kon-

taktním jménem, musíte vytvořit nějaké 
kontakty (podívejte se na přidávání kon-
taktu) nebo je importujte synchronizací 
(podívejte se na informace o synnchro-
nizaci).

TIP I když uzamknete smartphone, 
můžete do pole pro PIN (i přes uzamknutí) 
vepsat tísňová čísla, místo hesla, a stisk-
nutím Phone/ Send(Telefon/poslat).
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1. Stiskněte Home .
2. Pomocí klávesnice začněte vklá-

dat jakoukoli kombinaci písmen 
jména nebo příjmení kontaktu. 
Pokud použijete příjmení i jmé-
na, vložte mezeru. 

Můžete psát písmena příjmení 
jako první například: Vložením 
SM vyhledáte Smilu Anderson 
i Johna Smitha. Vložením SM 
mezera AN vyhledáte Smilu 
Anderson i Ann Smithovou. 
Pro opravení písmen, která 
jste omylem napsali - stiskněte 
Zpět .

3. Každý odpovídající kontakt 
se zobrazí s kódem (zkratkou) 
druhu čísla w-work, m-mobil, 
h-home atd.

VĚDĚLI JSTE ŽE? Vyhledávací funkce 
nabízejí řadu způsobů, které vám usnadní 
nalezení kontaktů, když si nejste úplně 
jisti jménem.

1. Výsledky vyhledávání zahrnují i různé 
varianty jmen jako např. David - Dave...
2. Vyhledávací funkce vkládá mezeru 
před poslední písmeno, pokud nemůžete 
kontakt najít. Takže vložíte-li Davidm a 
nenaleznete daný kontakt, vyhledávací 
funkce zkusí automaticky vyhledat David 
mezera m.
3. Výsledky vyhledávání obsahují i podob-
ně znějící jména např. Dwayne a Duane.

c

Zkratky 
u jednotlivých 
čísel kontaktu
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VĚDĚLI JSTE ŽE? Pokud zmáčknete 
E,R nebo jiné tlačítko pod kterým se na-
chází i číslo, na obrazovce se objeví nejen 
odpovídající jméno, ale i telefonní číslo. 
Čísla neovlivňují proces vyhledávání jmen 
kontaktů.

Pokud se jméno,které chcete zobrazí 
se správným telefonním kódem, 
označte jej a stiskněte Phone/Send 

 pro vytáčení. Pokud chcete vytočit 
jiné číslo v zobrazeném kontaktu, zvý-
razněte jméno kontaktu a stiskněte 
Center , zobrazí se vám všechna 
čísla u daného kontaktu, vyberte číslo 
a stiskněte Phone/Send  .

TIP Pokud chcete vytočit jiné číslo v 
kontaktu, zvýrazněte kontakt a stiskněte 
vpravo a vlevo na 5-ti polohovém tlačítku, 
dokud se neobjeví správný kód pro telefonní 

číslo vpravo. Poté stiskněte Phone/Send.

Použití rychlého vytáčení - 
Speed dial
NEŽ ZAČNETE 
• Vytvořte si speed dial (rychlé 
vytáčení ), (viz vytvoření rychlého 
vytáčení)
• Ujistěte se, že máte zapnutý tele-

fon a jste v oblasti mobilního pokrytí 
(viz zapínání telefonu). Můžete telefo-
novat pomocí rychlého vytáčení, kte-
ré jste přiřadili k tel. číslu kontaktu.

1. Stikněte Home  
2. Stiskněte a přidržte tlačítko 

nebo tlačítka, která jste přiřadili 
ke kontaktům rychlé volby vytá-
čení. Pokud jste přiřadili dvou-
tlačítkovou volbu ke kontaktu, 
stiskněte nejprve první tlačítko 
a potom stiskněte a přidržte 
druhé.

Opětovné vytáčení 
nedávno volaných čísel 

Pro vytočení posledního volaného čísla:

Stiskněte Home  a potom stisk-
něte Phone/Send  2x.
Pro výběr z nedávno volaných čísel:
Stiskněte Home , stiskněte 
Phone/Send , zvýrazněte telefon-
ní číslo nebo jméno kontaktu,
kterému chcete volat a opět stiskně-
te Phone/Send  pro vytáčení.
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TIP Informace o nedávno volaných čís-
lech můžete ovládat několika způsoby:
(viz Práce s volanými čísly)

Další způsoby 
telefonování
Váš smartphone nabízí i jiné způ-
soby telefonování než z domovské 
obrazovky, vyzkoušejte je všechny 
a poté si vyberte ten, který vám 
nejvíce vyhovuje. 

Volání za použití jména 
společnosti

NEŽ ZAČNETE 

Ujistěte se, že máte zapnutý 
telefon a jste v oblasti mobilního 
pokrytí (viz zapínání telefonu)

1. Stiskněte Home , potom 
stiskněte Kontakt .

2. Stiskněte Menu  (pravý 
softkey) a vyberte View By 
> Company (zobrazit podle 
jména společnosti)

3. Stiskněte Phone/Send  pro 
návrat do domovské obrazovky

4. Za použití klávesnice začněte 
psát první písmena jména spo-
lečnosti

5. Vyberte číslo, které chcete volat
6. Stiskněte Phone/Send  

Vytáčení tel. čísel 
z textu zpráv

Váš smartphone rozezná většinu 
telefonních čísel, která se objeví 
v textu, emailu nebo MMS.

1. Použijte 5-ti polohovou klávesu 
pro zvýraznění telefonního čísla 
v textu

2. Stiskněte Phone/Send  pro 
vytáčení. 
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TIP
Pokud zpráva obsahuje jméno kontaktu 
můžete jej zvýraznit a po stisknutí Phone/
Send vytočit přiřazené číslo.

TIP
Zvýrazněte jméno nebo telefonní číslo 
ve zprávě, stiskněte Center pro vytvoření 
nového kontaktu nebo vložte zvýrazněnou 
část do již existujícího kontaktu.

Přijímání hovorů
Pokud chcete přijímat hovory, 
musíte mít zapnutý telefon, toto je 
jiné, než když máte zapnutý pouze 
smartphone (viz zapínání telefonu). 
Pokud je telefon vypnutý vaše ho-
vory jdou do hlasové schránky.

TIP Aby jste mohli vidět na obrazovce ob-
rázek volající osoby, naučte se jak přiřadit 
foto volajícího( viz. přidávání kontaktů).

Pokud je zapnutá hudba, když přichá-
zí hovor, váš smartphone zvoní tišeji. 
Hovor můžete přijmout jako obvykle. 
Hudba je po dobu volání zastavena.

Pro přijetí hovoru:
• Stiskněte Phone/Send 
• Stiskněte  Answer  (levý 

softkey)
• Pokud máte připojená sluchátka, 

stiskněte tlačítko na sluchátkách.

Pokud chcete hovor ignorovat 
a poslat jej do hlasové schránky,
vyberte Ignore  (pravý softkey) 
a nebo stiskněte End (konec). 
 

Používání 
hlasové schránky
 
Nastavení hlasové schránky
 
1. Stiskněte Home 
2. Stiskněte a přidržte 1 na kláves-

nici pro vytočení hlasové schrán-
ky v systému poskytovatele 
mobilních služeb

3. Následujte pokyny pro nastavení 
hlasové schránky



53

Vyzvednutí hlasové pošty 
z domovské obrazovky

Pokud máte nevyzvednutou zprávu 
v hlasové schránce, ikona hlasové 
pošty  se objeví v horní části 
domovské obrazovky.

1. Stiskněte Home .
2. Stiskněte a přidržte 1 na klá-

vesnici pro vytočení čísla hlas. 
schránky.

3. Za použití klávesnice vložte 
heslo do hlasové schránky.

4. Následujte hlasové pokyny pro 
vyzvednutí vzkazů.

Co mohu udělat 
v průběhu volání?
Váš smartphone nabízí mnoho pokro-
čilých funkcí včetně přidržení hovoru, 
konferenčního volání a přesměrování 
hovorů. Použití těchto funkcí závisí na 
vašem tarifu. Pro více informací kontak-
tujte poskytovatele mobilních služeb.

Když telefonujete nebo přijímáte 
hovor, informace o volání se objevují 
na přidružené obrazovce.

V průběhu volání můžete dělat 
následující:
Pohybovat se po domovské 
obrazovce.
Stiskněte Home  pro návrat do 
domovské obrazovky a stisknutím ši-
pek Nahoru  a Dolů  se můžete 
pohybovat po zvýrazněných položkách.

Ikona hlasové pošty

 

Ikona 
hlasové 
pošty
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Přidržení hovoru: Stiskněte Menu 
 (pravý softkey) a vyberte Hold. Pro 

vypnutí přidržení stiskněte Unhold   
(levý softkey).

Ztišení mikrofonu tak, aby jste 
nebyli slyšeni: Stiskněte Mute  
(ztišení) (levý softkey). pro opětovné 
zapnutí mikrofonu stiskněte Unmute 

 (levý softkey).

Použití hlasitého odposlechu:
Stiskněte Menu  (pravý softkey) 
a vyberte Speakerphone On (zapnutí 
hlasitého  odposlechu). Pro vypnutí, 
stiskněte Menu  (pravý softkey) 
a vyberte Speakerphone Off (vypnutí 
hlasitého odposlechu).

VĚDĚLI JSTE, ŽE? Connected screen 
(související okno) musí být zobrazeno, 
pokud chcete přidržet hovor nebo použít 
hlasitý odposlech. Pokud není zobrazeno 
toto okno, stiskněte Back (zpět) dokud se 
znovu neobjeví. Z domovské obrazovky se 
také můžete vrátit do souvisejícího okna vy-
bráním aktuálního volání nebo stavu volání 
Call Status (pravý softkey). 

Přechod do jiné aplikace: Stisk-
něte Home , stiskněte Start 
(levý softkey) a vyberte aplikaci.
Toto je nejsnadnější pokud používáte 
sluchátka nebo hlasitý odposlech.

VĚDĚLI JSTE, ŽE? Když telefonujete, 
ztlumí se osvětlení obrazovky a spoří se 
tak baterie. Stisknutím kteréhokoli tlačítka 
kromě End se opět rozsvítí.

VĚDĚLI JSTE, ŽE? Můžete během 
hovoru odesílat a přijímat textové zprávy.
Toto je způsob jak zůstat v kontaktu 
s ostatními během dlouhého hovoru.

Ukončení hovoru
Proveďte jeden z následujících kroků:

• Stiskněte End (konec) .
• Stiskněte tlačítko na sluchát-

kách (některá sluchátka tlačítko 
nemají).

Zapínání aplikací 
v průběhu volání

V průběhu hovoru, můžete na 
smartphonu používat řadu aplikací 
včetně organizéru textových zpráv.
Nemůžete však používat některá 
datová spojení např. přes GPRS, 
surfovat po internetu, Posílat a 
přijímat emailové zprávy a MMS. 
Pokud jste připojeni přes UMT-
S(3G), můžete používat současně 
hlasové i datové služby.
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Jak zjistíte přes který systém jste 
připojeni? (viz význam ikon). Pro 
otevírání aplikací (viz otevírání 
a zavírání aplikací).

Z kterékoli aplikace stiskněte 
Home  pro návrat na domov-
skou obrazovku.

Ukládání telefonních čísel
Po ukončení hovoru, můžete přidat 
telefonní číslo osoby se kterou jste
hovořili do seznamu kontaktů.
Pokud volající používá skrytou 
identitu jeho číslo uložit nemůžete.

1. Po ukončení hovoru stiskněte 
Save  (uložit, levý softkey).

2. Proveďte jeden z následujících 
kroků:
Vytvořit nový kontakt: 
vyberte <Nový kontakt>.

Přidání čísla k již existující-
mu kontaktu: vyberte jméno 
kontaktu.

Odmítnutí přidání čísla 
stiskněte Cancel   (zrušit 
pravý softkey).

TIP Uložit informace o kontaktu můžete 
také z emailové zprávy.

Pokud neuložíte telefonní číslo 
hned, proveďte následující kroky:
1. Stiskněte Home, stiskněte 

Phone/Send .
2. Zvýrazněte číslo, které chcete 

uložit.
3. Stiskněte Save  (uložit levý 

softkey).
4. Proveďte jeden z následujících 

kroků: 
Vytvořit nový kontakt: 
vyberte <nový kontakt>

Přidání čísla k již existu-
jícímu kontaktu: vyberte 
jméno kontaktu 

Odmítnutí přidání čísla: 
stiskněte Cancel   (zrušit 
pravý softkey)
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Uskutečňování 
druhého volání
V době aktivního volání můžete 
vytvořit druhý hovor.
1. Přidržte první hovor stisknutím 

Menu  (pravý softkey) a vyber-
te Hold.

2. Vytočte číslo druhého hovoru za 
použití (viz. telefonování z domov-
ské obrazovky).

Když jsou aktivní dva hovory najed-
nou, na obrazovce se objeví dvě sta-
vové sekce, každá pro jeden hovor.

Přijetí druhého hovoru
Když telefonujete a máte druhý pří-
chozí hovor, budete na čekající hovor 
upozorněni (viz nastavení upozornění 
na čekající hovor).
Proveďte jeden z následujících kroků:

Odešlete nový hovor do hlaso-
vé schránky: stisknutím Igore  
(pravý softkey)
Přidržte aktuální hovor a při-
jměte nový: stiskněte Answer 
(levý softkey) nebo Phone/Send 

po přijetí hovoru:

• Stiskněte Swap  (levý softkey) 
pro přesun mezi volajícími a to při-
držením aktivního hovoru a hovoru 
na druhé lince.

• Vytvořte konferenční hovor (viz.
vytvoření konferenčního hovoru)

Vytvoření konferenčního hovoru

NEŽ  ZAČNETE Ne všechny tarify 
podporují konferenční volání. I přes-
tože vaše domácí sít konferenční 
volání podporuje, nemusí to platit při 
Roamingu.
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Pokud budete mít problémy, ověřte 
si u vašeho poskytovatele mobil-
ních služeb, zda váš tarif podporuje 
konferenční volání.
Pokud používáte roaming proveď-
te zkušební hovor, tak vyzkoušíte 
zda je v místě, kde se nacházíte 
podporován.

DŮLEŽITÉ
Můžete spojit až pět hovorů do šesti-
členné konference. Počet hovorů, které 
můžete spojit závisí na vašem tarifu.
Hovory mohou být zatíženy zvýšenými 
poplatky a volání naúčtována jednotlivě.
Prosím kontaktujte vašeho poskytovatele 
mobilních služeb, pro více informací.

1. Přijměte druhý hovor (viz. přijí-
mání druhého hovoru, přidržení 
hovoru) nebo přidržte druhý 
hovor a uskutečněte první (viz 
uskutečňování druhého hovoru)

2. Stiskněte Menu  (pravý 
softkey) a vyberte konference. 
Toto sloučí vás a oba hovory do 
konference.

3.  (volitelné) proveďte následující:

• Volejte nebo přijměte více ho-
vorů a slučte je do konferenční 
skupiny. Počet hovorů slouče-
ných do konference závisí na 
vašem tarifu.

• Uvolněte volajícího z konference 
pro soukromý hovor, stiskněte 
Menu   (pravý softkey), 
vyberte Private (Soukromně) a 
vyberte číslo. Hovor uvolněný z 
konference se stává aktivním ho-
vorem, pro vrácení do konferen-
ce, stiskněte Menu   (pravý 
softkey) a vyberte Konference. 

• Přesunujte se mezi konferenčním 
voláním a soukromým voláním 
stisknutím Swap  (levý 
softkey)
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4. Když skončíte, proveďte jeden 
z následujících kroků:

• Pokud jste uvolnili některý z 
hovorů z konference, stiskněte 
2x End  pro ukončení všech 
hovorů nebo stiskněte 1x End  
pro ukončení aktivního hovoru.

• Pokud jste žádný hovor z konferen-
ce neuvolnili, stiskněte 1x End .

 
Přesměrování hovorů
Vaše hovory můžete přesměrovat 
na jiné telefonní číslo. Ověřte si u 
poskytovatele mobilních služeb do-
stupnost a cenu přesměrovaných 
hovorů.
Když jsou přesměrovány všechny 
hovory, objeví se v horní části obra-
zovky ikona přesměrování .

NEŽ ZAČNETE Ujistěte se, že je 
váš telefon zapnutý a že se nachá-
zíte v oblasti mobilního pokrytí (viz 
zapínání telefonu)

1. Stiskněte Home  a potom 
Start  (levý softkey).

2. Stiskněte More  (levý 
softkey) a vyberte (nastavení) 
Settings 

3. Vyberte Volat a potom Call for-
warding (přesměrování hovorů).

4. Pokud chcete přesměrovat ho-
vory, vyberte Unconditional 
pro přesměrování všech hovorů. 
Přesměrování hovorů může být 
nastaveno od provozovatele 
mobilních služeb.

5. Stiskněte Done  (hotovo, 
levý softkey).
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TIP Pro vypnutí přesměrování stiskněte 
Menu (pravý softkey) a vyberte Disable 
All (vypnout vše).

Práce s volanými čísly
Můžete vytáčet naposledy volané 
číslo (viz vytáčení naposledy vola-
ného čísla). Můžete se také podívat 
na podrobnosti jednotlivých hovo-
rů, poslat textovou zprávu tel.číslu 
nebo uložit tel. číslo do seznamu 
kontaktů atd.

Práce s naposledy volanými čísly
1. Stiskněte Home  a poté 

stiskněte Phone/Send 

VĚDĚLI JSTE, ŽE? Na seznamu naposle-
dy volaných čísel, jsou označeny odchozí 
hovory zelenou šipkou vpravo. A příchozí 
hovory žlutou šipkou vlevo.Zmeškané ho-
vory jsou označeny červeným vykřičníkem.

TIP Pro filtrování hovorů zobrazených na 
seznamu naposledy volaných čísel,
stiskněte Menu (pravý softkey), vyberte 
View a vyberte z možností.

2. Zvýrazněte číslo a proveďte 
následující:

Uložte číslo do seznamu kon-
taktů (viz ukládání tel. čísel).

Pošlete tel. číslu textovou zprávu:
Stiskněte Menu  (pravý softkey) 
a vyberte Send text message 
(odeslání text. zpávy). Napište zprávu 
a stiskněte Send  (levý softkey).

Podívejte se na podrobnosti 
o telefonním čísle: Stiskněte 
Menu  ( pravý softkey) a vyberte 
Open call. První záznam hovoří 
o délce posledního hovoru s daným 
číslem.Použijte další položky pro 
volání čísla nebo odeslání textové 
zprávy.
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3.  V otevřeném okně podrobností 
o volaném čísle vyberte jednu z 
následujících možností:
Zobrazit všechna volání s 
tel. číslem: Stiskněte Menu 

 (pravý softkey) a vyberte 
View All Calls (zobrazit všech-
na volání). Zobrazí se všechna 
volání tohoto čísla včetně délky 
hovoru. 
Odstranění hovoru ze 
seznamu naposledy vola-
ných čísel: Stiskněte Menu 

 (pravý softkey) a vyberte 
Delete call (smazat hovor), 
stiskněte Yes  (levý softkey) 
pro potvrzení.

Zobrazení všech hovorů
Seznam historie volání obsahuje 
všechna čísla ochozích i příchozích 
hovorů. 

1. Stiskněte Home  a stiskněte 
Start  (levý softkey).

2. Stiskněte 2x More  (levý 
softkey) a vyberte Call history.

VĚDĚLI JSTE, ŽE? V seznamu historie 
volání jsou odchozí hovory označeny 
zelenou šipkou vpravo, příchozí hovory 
žlutou šipkou vlevo a zmeškané hovory 
červeným vykřičníkem.

3. Zvýrazněte číslo a proveďte 
následující:
• Uložte číslo a proveďte 

následující: stiskněte Save 
 (levý softkey) (viz ukládání 

telefonních čísel)
• Otevřete kontakt související s 
číslem: Stiskněte Menu  
(pravý softkey) a vyberte Find 
contact (najít kontakt)



61

Poslat  číslu textovou zprávu: 
stiskněte Menu  (pravý softkey)  
a vyberte Send text message
Napište text zprávy a stiskněte 
Send  (levý softkey).

Poslat email kontaktu souvise-
jícímu s telefonním číslem:
Stiskněte menu (pravý softkey) a 
vyberte E-mail napište zprávu a ode-
šlete stisknutím Send (levý softkey)

Zobrazit měřiče posledního 
volaného čísla, všechna volá-
ní a další u tohoto tel. čísla: 
Stiskněte Menu  (pravý softkey) 
a vyberte View timers.

TIP Pro resetování měřičů hovorů na nulu 
stiskněte Menu (pravý softkey), vyberte 
Reset timers. Potvrďte tlačítkem Yes (levý 
softkey) resetování všech měřičů.

Vymazat číslo ze seznamu: 
stiskněte Menu  (pravý softkey) 
a vyberte Delete. Pro potvrzení 
stiskněte Yes .

Vymazat celý seznam historie 
volání: Stiskněte Menu  (pravý 
softkey), vyberte Delete list a 
stiskněte Yes  pro potvrzení.

Vytváření volby 
rychlého vytáčení
Ke každému číslu kontaktu můžete 
přiřadit volbu rychlého vytáčení.
Můžete vytvořit až 99 kontaktů s 
volbou rychlého vytáčení.

NEŽ  ZAČNETE Než budete moci přiřa-
dit volbu rychlého vytáčení ke kontaktu, 
musíte nejprve kontakt vytvořit (viz. přidá-
ní kontaktu) nebo importovat synchroniza-
cí (viz. synchronizace informací).

 
1. Stiskněte Home  a poté 

stiskněte Contacts  (pravý 
softkey)

2. Vyberte kontakt, ke kterému 
chcete přiřadit rychlou volbu 
vytáčení.

3. Zvýrazněte telefonní číslo ke 
kterému chcete přiřadit volbu 
rychlého vytáčení.
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4. Stiskněte Menu  (pravý softkey) 
a vyberte Add to speed dial 
(přidat k volbě rychlého vytáčení).

5. Pokud chcete změnit jméno této 
volby rychlého vytáčení, vyberte 
Name (jmenný seznam) a vlož-
te nové jméno.

6. Zvolte Seznam přiřazova-
cích tlačítek na klávesnici a 
poté tlačítko rychlé volby pro 
dané číslo.

VĚDĚLI JSTE, ŽE? Pokud vyberete 
telefonní číslo, ke kterému je již přiřazeno 
tlačítko rychlé volby, obdržíte upozornění 
zda chcete nahradit stávající přiřazení 
novým.

VĚDĚLI JSTE, ŽE? Číslo 0 je 
rezervováno pro vkládání znaménka + v 
telefonním čísle a číslo 1 je rezervováno 
pro vytáčení hlasové schránky, ani jedno 
z těchto čísel nemůžete tedy přiřadit k 
rychlé volbě. 

TIP Můžete také vytvořit tlačítko rychlé 
volby pro rychlé otevírání aplikací (viz. 
vytvoření klávesových zkratek).
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Používání náhlavní 
soupravy (headset)
Náhlavní soupravu můžete připojit 
pro hands-free operace. Můžete 
používat náhlavní soupravu, kterou 
jste obdrželi v sadě se smartpho-
nem nebo kompatibilní od jiného 
výrobce.

DŮLEŽITÉ Pokud řídíte a použí-
vání smartphonu je v těch místech 
povoleno a potřebujete telefonovat, 
doporučujeme vám použít headset 
nebo hands-free sadu (prodává se 
odděleně). Pokud používáte kabelo-
vý headset, vložte sluchátko jen do 
jednoho ucha. Druhé ucho nechte 
volné, abyste slyšeli okolní zvuky. 
Takový hovor uskutečněte pouze 
pokud je to legální a bezpečné.

Microphone

Speakers

Headset button

Sluchátka

Mikrofon Tlačítko
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Tlačítko na náhlavní soupravě (dále 
headset) je kontextové a vykonává 
řadu funkcí dle situace. Použitím 
tlačítka můžete provést následující:

• Přijmout příchozí hovor
• Reagovat na čekající hovor
• Ukončit hovor nebo konferenč-

ní volání (pokud jste neuvolnili 
některý z hovorů)

• Přesunovat se mezi aktivním a 
přidrženým hovorem

POZNÁMKA Váš smartphone funguje s 
náhlavní soupravou, která má 2,5 mm a 3- 
piny (tři tmavé proužky na kolíku). Pokud 
si nejste jistí zeptejte se prodejce zda 
je produkt kompatibilní s vaším smart-
phonem. Pokud uslyšíte bzučení nebo 
nekvalitní zvuk z reproduktoru náhlavní 
soupravy, je pravděpodobné, že není kom-
patibilní s vaším smartphonem.

Připojení  zařízení Bluetooth® 
hands-free
Váš smartphone je kompatibilní s 
řadou náhlavních souprav a auto 
vybavení (prodává se samostatně) 
používajících Bluetooth® bezdrátovou 
technologii verze 2.0 nebo dřívější.

Pro seznam kompatibilních hands-
free zařízení s Bluetooth® bezdráto-
vou tech. navštivte: 
go.palm.com/treo500/.

Poté co jste nastavili spojení s 
Bluetooth® náhlavní soupravou nebo 
hands-free auto sadou, můžete ko-
munikovat s tímto zařízením kdykoli 
je v dosahu a pokud je Bluetooth® na 
vašem smartphonu zapnutý. Dosah 
Bluetooth® se mění v závislosti na 
faktorech okolního prostředí. Maxi-
mální dosah je cca 10m. 

VĚDĚLI JSTE, ŽE? Pokud máte kom-
patibilní náhlavní soupravu i auto sadu, tak 
ta která byla připojena jako poslední se 
stává aktivním zařízením.

1. Bude-li to nezbytné, připravte další 
zařízení, například náhlavní soupravu 
pro přijetí nového spojení. Zkont-
rolujte podrobnosti v dokumentaci 
zařízení. Ujistěte se a zjistěte, jestli 
má zařízení předdefinované heslo, 
které je třeba napsat do vašeho 
smartphonu.

2. Stiskněte Home  a potom stisk-
něte Start  (levý softkey).
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3. Stiskněte More  (levýsoftkey) a 
vyberte Settings (nastavení).

4. Vyberte Connections ( spojení) a 
potom Bluetooth®.

5. Vyberte Add new device (přidat 
nové zařízení).

 

6. Počkejte až smartphone vyhledá 
zařízení a zobrazí jejich seznam.

7. Vyberte zařízení, které chcete 
připojit a stiskněte Next  (levý 
softkey).

8. Vložte heslo (1-16 číselných znaků) 
a stiskněte Next  (levý softkey). 
Před vložením hesla nemusíte 

mačkat Option  (volba).

DŮLEŽITÉ Některá hands-free zařízení 
mají přednastavený passkey (heslo). Infor-
mace najdete v dokumentaci zařízení.
Jiná zařízení umožňují vepsání vlastního 
hesla. V obou případech musíte používat 
stejné heslo pro smartphone i hands-free 
zařízení. Doporučujeme používat pokud 
možno heslo o šestnácti číselných znacích 
pro zvýšení zabezpečení smartphonu. 
Čím delší je heslo tím složitější je jeho 
dešifrování.

VĚDĚLI JSTE, ŽE? Ikona Bluetooth® 
signalizuje stav Blouetooth® zařízení.(viz. 
stavové ikony Bluetooth®)

9. Pokud není předdefinováno heslo, 
vložte stejné heslo i do druhého 
zařízení.

10. Stiskněte OK  (pravý softkey).
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Nyní můžete komunikovat s tímto 
zařízením, kdykoli je v dosahu
a Bluetooth® na vašem smartphonu je 
zapnutý. Dosah se velmi mění 
v závislosti na faktorech okolního pro-
středí. Maximum dosahu je okolo 10m.

Použití Bluetooth Hands-free 
zařízení
Jak připojit a nastavit Bluetooth® za-
řízení (vit. přípojení Bluetooth® Hands-
free zařízení)

Zde jsou tipy jak pracovat s Bluetooth 
Hands-free zařízením:
• Přesunutí hovoru z náhlavní soupravy 

do Bluetooth Hands-free zařízení. V 
průběhu volání stiskněte Menu 
(pravý softkey) a vyberte Connect 
Bleutooth®. Pro přesunutí hovoru 
zpět na náhlavní soupravu stiskněte 
Menu  (pravý softkey) a vyberte 
Cancel   Bluetooth®.

• Přesunutí hovoru z kabelové náhlavní 
soupravy na Bluetooth® náhlavní 
soupravu nebo autosadu, která je v 
dosahu. Odpojte kabelovou náhlavní 
soupravu a stiskněte tlačítko na Blu-
etooth® náhlavní soupravě nebo auto 
sadě.

VĚDĚLI JSTE, ŽE? Pokud používáte 
Bluetooth Hands-free zařízení a to je v 
dosahu, váš smartphone odkloní všechny 
hovory do Hands-free zařízení místo do 
reproduktoru na smartphonu. Dosah Blu-
etooth je až 10m v závislosti na okolním 
prostředí.

TIP Jak přesunout kontakty ze smartpho-
nu na autosadu go.palm.com/treo500/.

Přizpůsobení 
nastavení telefonu
Nastavení vyzváněcích tónů 
a upozornění

Můžete nastavit vyzvánění u přícho-
zích hovorů, upozornění a hlasové 
zprávy. Můžete stahovat MP3, MIDI, 
AMR, WAV a WMA zvonění přímo
na váš smartphone (viz stahování 
souborů a obrázků z internetových
stránek). Můžete také stahovat 
vyzváněcí tóny na počítač a poté je 
posílat na smartphone).
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NEŽ  ZAČNETE Pokud chcete použít 
stažené zvonění ujistěte se, že jste je 
uložili nebo zkopírovali do složky My Ring-
tones na vašem smartphonu.

 
1. Stiskněte Home  a vyberte 

Start  (levý softkey).
2. Stiskněte More  (levý softkey) 

a vyberte Settings .
3. Vyberte Sounds.

4. Vyberte jeden nebo oba z následu-
jících seznamů a stiskněte Vpra-
vo  nebo Vlevo  pro výběr.

Ring tone: Nastavte zvuk zvonění 
pro příchozí hovory.

TIP Vyberte Vibrate, nastavením vibrace 
budete upozorněni na příchozí hovor 
(viz. výběr zvukových profilů).

New voice message: Nasta-
vuje zvuk upozornění na novou 
hlasovou zprávu.

5. (volitelné) Pro přehrání vybraných 
zvuků stiskněte Menu  (pravý 
softkey) a vyberte Play.

6. Stiskněte Done  (levý softkey).

TIP Můžete také nastavit zvuk upozorně-
ní na zprávu, upomínku v kalendáři a další 
(viz. výběr zvuků a oznámení).

Ovládání hlasitosti hovoru 
a vyzvánění

Volume Hlasitost
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Když vyzvání telefon stiskněte Volu-
me (tlačítko na straně smartphonu),
nastavíte tak hlasitost vyzvánění. 
V průběhu hovoru stiskněte Volu-
me, nastavíte tak hlasitost hovoru.

Přiřazení vyzvánění pro identi-
fikaci volajícího

1. Stiskněte Home  a potom 
stiskněte Kontakty  (levý 
softkey).

2. Zvýrazněte jméno kontaktu, ke kte-
rému chcete přiřadit ID vyzvánění.

3. Stiskněte Menu  (pravý 
softkey) a vyberte Edit.

4. Vyberte Customize Ring Tone 
seznam (přizpůsobení vyzvánění)

    a vyberte vyzvánění.
5. Stiskněte Done  (levý 

softkey).

Automatické přijímání hovorů
Když používáte Hands-free můžete 
nastavit váš smartphone, aby auto-
maticky přijímal hovory.

POZNÁMKA Automatické přijímání ho-
vorů není možné, když je zvukový profil 
nastaven na potichu.

1. Stiskněte Home  a potom 
Start  (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings .

3. Vyberte Phone a poté vyberte 
Auto Answer.

4. Vyberte volbu jak rychle budou 
automaticky přijaty hovory při 
použití Hands-free zařízení.

5. Stiskněte Done  (levý softkey).

Blokování hovorů
Můžete blokovat příchozí i odchozí 
hovory.

NEŽ  ZAČNETE Proveďte následující:
• Ujistěte se, že blokování hovorů je 

podporováno vaším tarifem. 
    Pro více informací kontaktujte 

provozovatele mobilních služeb.  
• Získejte kód pro blokování hovorů 

od provozovatele mobilních služeb
• Ujistěte se, že je váš telefon 

zapnutý, a že se nacházíte v oblasti 
mobilního 

    pokrytí ( viz. zapínaní telefonu).



69

1. Stiskněte Home  a poté Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) a 
vyberte Settings  .

3. Vyberte Phone a vyberte Call 
Barring.

4. Vyberte Block Incoming Calls 
seznam (blok. příchozích hovorů) a 
vyberte jednu z možností:
Off: Žádné příchozí hovory nejsou 
blokované.
When Roaming: Při roamingu jsou 
všechny příchozí hovory blokované.
All Calls: Všechny příchozí hovory 
jsou blokované.

5. Vyberte Block Outgoing Calls 
seznam (blok. odchozích hovorů) a 
vyberte jednu z možností:
Off: Žádné odchozí hovory nejsou 
blokované.
Int‘l except to home: Všechny 

odchozí mezinárodní hovory kromě 
země původu telefonu jsou blokovány.
Int‘l Calls: Všechny odchozí mezi-
národní hovory jsou blokované.
All Calls: Všechny odchozí hovory 
jsou blokované.

6. Stiskněte Done  (levý softkey).
7. Vložte heslo blokování volání a stisk-

něte Done  (levý softkey).

Nastavení upozornění na čekají-
cí hovor
Můžete si vybrat zda chcete být v 
průběhu volání upozorněni na čekající 
hovor (viz přijetí druhého hovoru).

NEŽ ZAČNETE Ujistěte se, že je váš 
telefon zapnutý, a že se nacházíte v 
oblasti mobilního pokrytí ( viz. zapínaní 
telefonu).
 
1. Stiskněte Home  a poté Start 

 (levý softkey).
2. Stiskněte More  (levý softkey) a 

vyberte Settings  .
3. Vyberte Phone a vyberte Call 

Waiting.
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4. Zaškrtněte rámeček pokud chcete 
přijímat upozornění na příchozí 
hovory.

5. Stiskněte Done  (levý softkey).

Nastavení ID volajícího
Můžete si nastavit volbu zda chcete, 
aby se tomu komu voláte zobrazilo 
vaše číslo.

NEŽ ZAČNETE 
1. Stiskněte Home  a poté Start 

 (levý softkey).
2. Stiskněte More  (levý softkey) 

a vyberte Settings .
3. Vyberte Phone a poté vyberte 

Caller ID.
4. Zaškrtněte rámeček pokud chcete 

přijímat upozornění na čekající 
hovor.

5. Stiskněte Done  (levý softkey).

Pevné vytáčení
Pevné vytáčení vám umožňuje 
omezit odchozí hovory a zprávy na 
telefonní čísla zahrnuta v seznamu 
pevného vytáčení. Po aktivaci služby 
můžete volat a posílat zprávy pouze 
telefonním číslům ze seznamu.

Seznam je chráněn PIN 2 kódem. 
Pokud ho vložíte vícekrát nesprávně, 
než je povoleno poskytovatelem 
mobilní sítě, SIM karta se zablokuje. 
Po zablokování SIM karty, potřebu-
jete PUK 2 pro odblokování. Pro více 
informací kontaktujte poskytovatele 
mobilní sítě.
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NEŽ ZAČNETE 
• Ujistěte se zda je váš telefon 

zapnutý a že se nacházíte v oblasti 
mobilního pokrytí (Viz. Zapínání 
telefonu)

• Opatřete si PIN 2 kód od vašeho 
poskytovatele mobilní sítě.

1. Stiskněte Home  potom Start 
 (pravý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings .

3. Vyberte  Phone.
4. Vyberte More potom Fixed 

Dialing.

5. Zaškrtněte rámeček  Enable Fixed 
Dialing a stiskněte Done  (levý 
softkey).

6. Vložte vaše PIN2 a stiskněte 
Done  (levý softkey).

7. Stiskněte Menu  (pravý 

softkey) pro přidání telefonních 
čísel do seznamu. Nabídka přidání 
nebo odebrání telefonních čísel ze 
seznamu se objeví pouze pokud 
bylo aktivováno pevné vytáčení.

TIP Přidávat a upravovat telefonní čísla 
můžete pouze v seznamu pevného vytáče-
ní. Nemůžete upravovat zobrazená jména.

8. Stiskněte Done  (levý softkey).

TIP Když vám provozovatel mobilních 
služeb poskytne nový PIN 2 můžete je 
lehce změnit ve vašem telefonu. Stiskněte 
Home následuje Start, More a vyberte 
Settings. Vyberte More potom Securi-
ty. Vyberte Change PIN 2 a vložte váš 
nový PIN 2.

Manuální vyhledávání bezdrá-
tového spojení.

DŮLEŽITÉ Nastavení bezdrátového spo-
jení je přednastaveno na optimální výkon. 
Toto nastavení měňte pouze bude-li vám 
dán pokyn, aby jste tak učinili od poskyto-
vatele mobilních služeb.
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NEŽ ZAČNETE Ujistěte se zda je váš 
telefon zapnutý a že se nacházíte v 
oblasti mobilního pokrytí (Viz. Zapíná-
ní telefonu)

1. Stiskněte Home  a poté stisk-
něte Start   (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings  .

3. Vyberte Phone.

4. Vyberte More a poté vyberte 
GSM/3G Networks.

5. Vyberte seznam Network a po-
tom vybere jednu z následujících 
možností:
Automatic: Automatický výběr 
sítě. 
GSM: Spojuje se pouze k síti 
GSM.

6. Stiskněte Done (levý softkey).
7. Pokud budete vyzvání vypněte 

smartphone (viz. vypínání smart-
phonu).

Manuální nastavení vyhledává-
ní sítě 

DŮLEŽITÉ Nastavení bezdrátového 
spojení je přednastaveno na optimál-
ní výkon. Toto nastavení měňte pou-
ze bude-li vám dán pokyn, aby jste 
tak učinili od poskytovatele mobilních 
služeb. Možnosti nastavení sítě se 
různí dle poskytovatele bezdrátových 
mobilních služeb.

NEŽ ZAČNETE Ujistěte se zda je váš 
telefon zapnutý a že se nacházíte v 
oblasti mobilního pokrytí (Viz. Zapíná-
ní telefonu).

1. Stiskněte Home  potom Start 
 (pravý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings .

3. Vyberte  Phone.
4. Vyberte More potom Network.
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5. Pro vyhledávání dalších dostup-
ných mobilních sítí, stiskněte 
Menu  (pravý softkey), vyberte 
Find a New Network a vyberte 
dostupnou síť.

6. Pro přechod do jiné sítě, stiskněte 
Menu  (pravá softkey) vyber-
te Select Network a vyberte 
dostupnou síť.

7. Pro změnu pořadí vašich oblí-
bených sítí stiskněte Menu  
(pravý sotkey) a vyberte Prefered 
Networks. Zaškrtněte rámeček u 
sítě, kterou chcete dát výše nebo 
níže v preferencích. Stiskněte 
Menu  (pravý softkey) a vyber-
te zda chcete posunout síť nahoru 
nebo dolů v seznamu preferencí.

TIP Můžete také stisknout Menu (pravý 
softkey) a vybrat zda chcete existující síť
nebo uživatelskou síť do seznamu prefero-
vaných sítí.

VĚDĚLI JSTE, ŽE? Váš smartphone 
automaticky usiluje o připojení k sítím 
na preferovaném seznamu sítí v pořadí, 
ve kterém se objevují dokud se úspěšně 
nepřipojí?

8. Vyberte Network Selection 
seznam a vyberte:
Automatic: Připojení k síti probí-
há automaticky.
Manual: Připojení probíhá manu-
álně. Pokud manuálně vybíráte síť, 
vyberte tu, která je na seznamu 
dostupných sítí.

9. Stiskněte Done (levý softkey).

Nastavení dalších možností 
volání
Můžete změnit hlasové schránky, 
vložit předčíslí státu nebo města a 
další.

1. Stiskněte Home  a poté Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings .
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3. Vyberte Phone a poté Call 
Option.

4. Vyberte jednu z následujících 
možností:

 Any key answers: Zaškrtněte 
rámeček pokud chcete přijmout ho-
vor stisknutím kteréhokoli tlačítka. 
Show SIM Contacts: Zaškrtně-
te rámeček pokud chcete, aby se 
při vyhledávání kontaktů zobrazili i 
kontakty ze SIM karty.
Voice mail number: Číslo hla-
sové schránky je standardně na-
staveno poskytovatelem mobilních 
služeb. Nové číslo vložte pouze 
pokud jej změní sám poskytovatel 
mobilních služeb. 
Text message service center: 
Číslo centra servisních zpráv je 
standardně nastaveno poskytova-
telem mobilních služeb. Nové číslo 

vložte pouze pokud jej změní sám 
poskytovatel mobilních služeb.
Country code: (tel. předčíslí 
státu) vložte předčíslí státu, které 
chcete vytáčet na začátku každého 
telefonního čísla.
Dialing code: (tel. předčíslí měs-
ta) vložte jakékoli číslo kromě „1“, 
které chcete vytáčet automaticky, 
když vložíte telefonní číslo všech-
na telefonní čísla budou uvedena s 
tímto předčíslím.

5. Stiskněte Done  (levý softkey).

Používání SIM 
toolkit
SIM toolkit je sada malých aplikací, 
které jsou uložené na vaší SIM kartě
a umožňují plnit určité úkoly.  
Například použitím SIM toolkit, jste 
schopni kontrolovat předplacený zů-
statek nebo volat zákaznický servis.
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DŮLEŽITÉ Ne všichni bezdrátový 
poskytovatelé služeb nabízejí SIM toolkit 
na svých SIM kartách. U poskytovatelů 
služeb, kteří podporují SIM toolkit se 
funkce SIM toolkit různí. Pokud váš 
poskytovatel mobilních služeb SIM toolkit 
neposkytuje není možné ji na vašem 
smartphonu otevřít.

NEŽ ZAČNETE Název SIM toolkit 
aplikace se liší v závislosti na 
poskytovateli bezdrátové sítě. 
Kontaktujte poskytovatele mobil. 
služeb kvůli jménu SIM toolkit 
aplikace.

1. Stiskněte Home  a potom 
stiskněte Start  (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Accesories (příslu-
šenství).

3. Vyberte Task Manager  (úko-
lový manager).

4. Vyberte SIM toolkit aplikaci.
 

Význam ikon
Pomocí ikon na domovské obrazovce 
můžete sledovat stav položek:

Zmeškaný hovor

Máte hlasovou zprávu

Máte novou MMS nebo email

Máte novou textovou zprávu

Máte instant message

SIM karta není vložena

Problém se čtením SIM karty

Zvonění  je vypnuto

Telefon je zapnutý, počet čárek 
udává sílu signálu.
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Telefon je zapnutý, ale nemá 
signál

Telefon je zapnutý, ale je v ob-
lasti bez mobilního pokrytí nebo 
je vaše SIM karta zablokovaná 
a vy jste vyčerpali povolené 
množství pokusů pro odbloko-
vání     (viz.blokování SIM karty)

Telefon je vypnutý

SIM karta je zablokovaná. Je 
třeba vložit PIN nebo PUK pro 
odblokování SIM karty (viz.
blokování SIM)

Probíhá hovor

Hovor přidržen

Všechny hovory jsou přesmě-
rovány

Probíhá datový přenos

Hlasitý odposlech je zapnut

Jste v roamingové zóně, kde jsou 
vyšší sazby za volání a přenos dat

Telefon je připojen k 3G UMTS 
síti, ale nedochází k přenosu 
dat. Můžete telefonovat i přijí-
mat hovory.

Telefon je zapnutý a 3G UMTS 
datové spojení je aktivní. Mů-
žete uskutečňovat současně 
přenos dat i odchozí a příchozí 
hovory.

Jste v roamingové zóně a váš 
telefon je připojen k síti 3G 
UMTS, ale nedochází k aktiv-
nímu přenosu dat. Sazby za 
přenos dat a volání jsou vyšší.

Telefon je připojen k síti GPRS, 
ale nedochází k přenosu dat. 
Můžete telefonovat i přijímat 
příchozí hovory.

Telefon je zapnuty a GPRS da-
tové spojení je aktivní. Datový 
přenos bude při telefonování a 
přijímání hovorů automaticky 
přerušen.
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Jste v roamingové zóně a váš 
telefon je připojen k síti GPRS, 
ale nedochází k přenosu dat.

Baterie není vložená

Baterie je vybitá

Baterie se nabíjí

Baterie je plně nabitá

Zobrazí se máte-li zapnutý 
telefon, pokud telefon 
vypnete zobrazí se ve stej-
ném místě Phone off

Chyba při synchronizaci

Vibrace zapnuta

Bluetooth zapnut

Probíhá aktivní hovor a váš 
smartphone je připojen k Blue-
tooth náhlavní soupravě nebo 
auto sadě.

Probíhá přehrávání hudebních 
souborů z vašeho smartpho-
nu, přes Bluetooth náhlavní 
soupravu.

Psaní malými písmeny povo-
leno

Tlačítko Shift aktivní 

Caps Lock aktivní

Tlačítko Option aktivní

Option Lock aktivní

Máte upozornění z Microsoftu.

Jméno pro-
vozovatele 
mobilních 
služeb. 
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Synchronizace informací
Termín synchronizace znamená, že informace vložené nebo aktualizované 
na jednom místě na vašem Palm® Treo™ 500 smartphonu, počítači nebo 
korporačním serveru jsou automaticky aktualizovány na jiném místě. Není 
třeba zadávat informaci dvakrát. Některé druhy synchronizací mohou probí-
hat dle automaticky nastaveného plánu takže na to nemusíte myslet.

Potom co si zvyknete na pravidelnou synchronizaci, uvědomíte si jak 
úžasnou pomocí je synchronizace pro přenos, aktualizování a zálohování 
velkého množství informací na smartphonu.

VÝHODY:

•  Rychlá aktualizace informací na vašem počítači, firemním serveru 
a smartphonu.

•  Ochrana informací.
• Vysílání fotek a videí z vašeho smartphonu na počítač.

KAPITOLA

5
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Přehled 
synchronizací
Když synchronizujete informace na 
smartphonu, počítači nebo korpo-
račním serveru jsou automaticky 
aktualizovány na jiném místě. Není 
třeba vkládat informace dvakrát. 
Toto je ideální jestliže synchronizu-
jete počítač použitím počítačového 
synchronizačního softwaru (viz.další 
způsoby synchronizace) nebo bezdrá-
tového firemního Exchange serveru 
používajícího Microsoft Exchange 
ActiveSync® (viz. nastavení bezdráto-
vé synchronizace).

Jak 
synchronizovat?
Existuje mnoho způsobů jak uskuteč-
nit synchronizaci. Můžete instalovat
počítačový synchronizační software 
na svůj počítač a synchronizovat ně-
kolika způsoby nebo synchronizovat 
bezdrátově přes Exchange server. 
Maximalizovat synchronizaci můžete 
tím, že provedete synchronizaci přes 
počítačový synchronizační software i 
Exchange server.

Synchronizace pomocí syn-
chronizačního softwaru na 
vašem počítači.

NEŽ ZAČNETE Instalujte software 
z Windows Mobile Getting Started 
CD, které jste obdrželi k smartphonu. 
Instalujte software i přestože máte 
instalovanou předchozí verzi (viz. instalace 
ActiveSync® počítačového softwaru:  
Windows XP nebo instalace Windows 
Mobile Device Center: Windows Vista).
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Po instalaci počítačového synchroni-
začního softwaru, můžete synchroni-
zovat několika způsoby.
•  Připojením k počítači pomocí syn-

chronizačního kabelu (Viz. Synchro-
nizace)

•  Připojením k počítači pomocí Blue-
tooth® bezdrátové technologie.

Pokud máte nainstalované 
Windows XP
Synchronizační software se nazývá 
ActiveSync desktop software.

Pokud máte nainstalované 
Windows Vista
Synchronizační software se nazývá 
Windows Mobile Device Center.

Synchronizační aplikace na smartpho-
ne se nazývá ActiveSync bez ohledu 
na operační systém vašeho počítače.

Bezdrátová synchronizace se 
serverem 
Můžete nastavit na vašem smartpho-
ne synchronizaci e-mailů 
a dalších informací bezdrátově pomo-
cí Microsoft Exchange Server 2003 
nebo Exchange Server 2007 za 

pomoci Microsoft ActiveSync (viz. 
Nastavení bezdrátové synchronizace).
Pokud si vyberete tuto metodu 
synchronizace probíhá automaticky 
po nastavení. Není třeba instalovat 
software s Windows Mobile Geting 
Started CD.

POZNÁMKA Doporučujeme, aby jste 
nainstalovali synchronizační software z 
CD i přestože synchronizujete bezdrátově 
na server. Pro synchronizaci obrázků, 
videí, hudebních souborů a dalších 
informací přímo z počítače, potřebujete 
synchronizační software.

Co mohu 
synchronizovat?
Pokud máte Microsoft Office Outlook 
2003 nebo novější verzi instalovanou 
na vašem počítači. Je standardní, 
že následující informace je syn-
chronizována buď synchronizačním 
softwarem na PC nebo Microsoft 
Exchange ActiveSync.

Kontakty

E-mail Úkoly

Kalendář 
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Můžete, ale přizpůsobit nastavení 
synchronizace, aby vyhovovalo vašim 
potřebám a synchronizovat jen některé 
aplikace.

TIP Pokud ještě nemáte Outlook 2003 
nebo novější verzi nainstalovaný na 
vašem počítači, můžete si nainstalovat 
zkušební verzi Outlook 2007 z Windows 
Mobile Getting Started CD. Vložte CD 
do mechaniky, vyberte Add Programs 
(Windows XP) nebo Bonus Software 
(Windows Vista), a vyberte link ke stažení 
zkušební verze Outlooku 2007.

Pokud nastavíte synchronizaci s va-
ším počítačem za použití počítačové 
synchronizace softwaru, informace
v Favorites Application bude standart-
ně synchronizována také.Synchroni-
zace vám umožní jednoduchý přístup 
k oblíbeným webovým stránkám 
z internetového prohlížeče vašeho 
počítače na smartphon. Pouze je 
přidejte do složky Mobile oblíbené 

složky se objeví na vašem interne-
tovém prohlížeči na vašem smart-
phone. Zálohované kopie oblíbených 
složek, které jste vybrali jsou také v 
Mobile Favorites složce.

Můžete také změnit nastavení 
synchronizace s Wordem, Excelem, 
Powerpointem, PDF souborů, obráz-
ků, hudby, videí a dalších souborů 
(viz Výběr aplikace k synchronizaci)

TIP Pokud chcete synchronizovat (PIM) 
správce osobních informací jinak než 
přes Outlook Microsoft Office musíte 
nainstalovat program od jiného výrobce. 
Kontaktujte prodejce PIM a zjistěte zda je 
pro váš smartphone dostupný software.

Následující tabulka popisuje druhy 
informací, které můžete synchronizo-
vat a použité metody.

                                                                                                

Druh informace   Metoda Kde zjistit více

Outlook kontakty, Kalendář, 
Úkoly

Počítačový synchronizační soft-
ware (synchronizace s  počítačem) 
nebo Exchange ActiveSync (přímá 
synchronizace se serverem)

Další způsoby synchronizace 
nebo nastavení bezdrátové 
synchronizace.
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Druh informace   Metoda Kde zjistit více

Outlook kontakty, Kalendář, 
Úkoly

Počítačový synchronizační soft-
ware (synchronizace s  počítačem) 
nebo Exchange ActiveSync (přímá 
synchronizace se serverem)

Další způsoby synchronizace 
nebo nastavení bezdrátové 
synchronizace.

Word, Excel, PowerPoint, 
PDF soubory

Počítačový synchronizační 
software

Výběr aplikace k synchronizaci.
Další způsoby synchronizace. 
Synchronizace Microsoft Office 
souborů

Hudební a video soubory             Počítačový synchronizační soft-
ware a Windows Media Player.                                        

Další způsoby synchronizace
Výběr aplikace k synchronizaci
Přenos mediálních  souborů 
do vašeho smartphonu                                                                                                                                       
                                           

Obrázky                                           Windows XP: Počítačový synchro-
nizační software
Windows Vista: Počítačový syn-
chronizační software a Windows 
Media Player

Další způsoby synchronizace
Výběr aplikace k synchronizaci
Přenos mediálních souborů do 
vašeho smartphone (Windows 
Vista)

Outlook Notes Počítačový synchronizační 
software.

Další způsoby synchronizace. 
Výběr aplikace k synchronizaci.

Soubory přenesené do 
rozšiřující karty.

Počítačový synchronizační 
software

Další způsoby synchronizace. 
Výběr aplikace k synchronizaci.
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TIP Pokud chcete synchronizovat hudbu 
a videa, musíte mít nainstalován 
Windows Media Player 10 nebo novější 
verzi. Pokud nemáte nainstalován na 
vašem počítači Windows Media Player, 
můžete si jej stahnout z www.microsoft.com.

Nastavení 
vašeho počítače 
pro synchronizaci

Než budete moci synchronizovat s 
počítačem, musíte nainstalovat syn-
chronizační software a připojit USB 
synchronizační kabel k počítači.
I přestože již máte synchronizační 
software na svém počítači, je třeba 
instalovat software z Windows 
Mobile Getting Started CD, které jste 
obdrželi se smartphonem.

Systémové požadavky
Váš počítač musí vyhovovat následu-
jícímu minimu systémových poža-
davků:
•  Windows XP Service Pack 2 nebo 

Windows Vista (i novější verze 
mohou být podporovány)

•  32MB využitelné paměti (RAM)
•  170MB volného místa na disku
•  CD mechanika
•  Dostupný USB port
•  USB synchronizační kabel (obsaže-

ný v balíčku smartphonu)
•  Adobe Flash Player (nutný pro chod 

instalačního programu)

TIP Pokud nemáte na počítači Adobe 
Flash Player, můžete si jej zdarma 
stáhnout na www.adobe.com

Instalace ActiveSync® 
softwaru: Windows XP

Máte-li počítač Windows XP, počí-
tačový synchronizační software pro 
něj se nazývá ActiveSync® desktop 
software.
Windows Mobile Getting Started CD 
rozezná, a automaticky vás nasměru-
je na instalaci ActiveSync desktop 
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software. Synchronizační aplikace na 
vašem smartphonu se rovněž
nazývá ActiveSync.

NEŽ ZAČNETE Pokud instalujete 
software v zaměstnání, ujistěte se, 
že vám společnost povolí instalaci 
nového softwaru – např. můžete být 
požádán, mít povolení od správce. 
Kontaktujte oddělení informačních 
technologií.

1. Zavřete aplikace, které jsou právě 
spuštěny na vašem počítači, včet-
ně těch na pozadí.
Počítač musí mít všechny kapacity 
volné k instalaci softwaru.

2. Vložte Windows Mobile Get-
ting Started CD do mechaniky 
počítače.

3. Následujte instrukce, které se 
objeví jak na počítači tak i na 
smartphonu. V průběhu instalace, 
připojte smartphone k počítači a 
poprvé synchronizujte. Sledujte 
co se děje jak na počítači tak na 
smartphonu. Pro více informací 
(viz připojení smartphonu k počíta-
či a synchronizace přehledu.

TIP Během instalace softwaru, můžete 
vybrat možnost synchronizovat email, 
kalendář a úkoly přímo v Microsoft 
Exchange Server 2003 nebo 2007. Pokud 
si vyberete tuto možnost, budete vyzváni 
k vložení adresy emailového serveru 
a jména domény a vaší registrace na 
Exchange Serveru - uživatelského jména 
a hesla.

Instalace Windows Mobile De-
vice Center: Windows Vista  

Pokud máte počítač Windows Vista, 
počítačový synchronizační software 
se pro něj nazývá Windows Mobile 
Device Center. Windows Mobile 
Getting Started CD rozezná, že máte 
Windows Vista a automaticky vás 
nasměruje na instalaci Windows 
Mobile Device Center. Synchronizač-
ní aplikace na vašem smartphonu se 
rovněž nazývá ActiveSync.

NEŽ ZAČNETE Pokud instalujete 
software v zaměstnání, ujistěte se, že 
vám společnost povolí instalaci nového 
softwaru – např. můžete být požádán, 
mít povolení od správce. Kontaktujte 
oddělení informačních technologií.



87

•  Ujistěte se, že je váš počítač při-
pojený k Internetu, abyste mohli 
stáhnout software.

•  Vypněte jakékoli firewally nasta-
vení na vašem počítači, které by 
mohlo zasahovat do procesu syn-
chronizace.Pro pomoc kontaktujte 
vaše firemní oddělení informač-
ních technologií.

1. Zavřete aplikace, které jsou právě 
spuštěny na vašem počítači, 
včetně těch na pozadí. Počítač 
musí mít všechny kapacity volné   
k instalaci softwaru.

2. Vložte Windows Mobile Get-
ting Started CD do mechaniky 
počítače.

3. Budete-li vyzváni, klikněte na 
RunStart.exe

4. Klikněte na Continue
5. Vyberte jazyk a klikněte na Next
6.  Vyberte Setup and Instalation.
7. Ujistěte se, že je zaškrtnutý ráme-

ček Windows Mobile Device 
Center klikněte na Install.

8. Následujte instrukce, které se 
objeví jak na počítači tak i na 

smartphonu. V průběhu instalace, 
připojte smartphone k počítači a 
poprvé synchronizujte. Sledujte 
co se děje jak na počítači tak na 
smartphonu. Pro více informací 
(viz připojení smartphonu k počíta-
či a synchronizace přehledu).

Používání synchronizačního 
softwaru 
Po instalaci synchronizačního softwa-
ru, proběhne synchronizace pokaždé, 
když připojíte smartphone k počítači, 
jak je popsáno v další části. Můžete 
také otevřít okno synchronizačního 
softwaru na vašem počítači a provést 
následující úkoly:
 
•  Instalovat aplikace z vašeho počí-

tače do smartphonu (viz instalace 
aplikací z vašeho počítače) nebo 
na rozšiřující kartu vloženou do ot-
voru pro rozšiřující karty ve vašem 
smartphonu (viz. Instalace aplikací 
na rozšiřující karty)

• Měnit (vybrat), které aplikace 
budou synchronizovány.
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• V ActiveSync softwaru na Win-
dows XP počítači, vložte nastvení 
pro bezdrátovou synchronizaci s 
Microsoft Exchange Server 2003 
nebo 2007.

VĚDĚLI JSTE, ŽE? Můžete také měnit 
to, která aplikace bude synchronizována 
(viz. výběr aplikací k synchronizaci) a 
nastavit bezdrátovou synchronizaci (viz. 
nastavení bezdrátové synchronizace) v 
ActiveSync na vašem smartphonu. Ať 
už vložíte nastavení na počítači nebo 
smartphonu, změny budou přeneseny při 
synchronizaci.

Pro otevření synchronizačního soft-
waru, proveďte následující:

Windows XP: Pro otevření Ac-
tiveSync softwaru, klikněte 2x na 
ikonu ActiveSync  na úkolové 
liště v levém dolním rohu obrazovky 
počítače.

TIP Pokud se ikona ActiveSync neobjeví, 
přejděte na Start, dále Programs
a vyberte Microsoft ActiveSync pro 
otevření okna ActiveSync.

TIP Můžete nastavit automatické ote-
vírání okna ActiveSync kdykoli připojíte 
smartphone k počítači. V okně ActiveSync 
vyberte File>Connection Settings a 
zaškrtněte okénko Open ActiveSync 
when my device connects. 

Widows Vista: Pro otevření Win-
dows Mobile Device Center klikněte 
na Start> All programs >Win-
dows Mobile Device Center.
 
Instalace softwaru na počítači 
vytvoří také složku pro váš smart-
phone. Když se smartphone připojí 
k počítači, otevřením My computer, 
nebo Windows Explorer (Windows 
XP) nebo Computer (Windows 
Vista) zobrazí se ikona znázorňující 
smartphone.
Dvojím kliknutím na tuto ikonu zob-
razí složky obsahující synchronizo-
vané položky např. hudbu, obrázky 
nebo videa.
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Připojení smartphonu k počítači

1. Zapojte USB synchronizační kabel 
do volného USB portu nebo USB 
rozbočovače na vašem počítači.

TIP Pro lepší výkon, zapojte 
synchronizační kabel přímo do USB portu 
na vašem počítači. Pokud má váš počítač 
USB porty vpředu i vzadu, doporučujeme 
použít zadní. Pokud použijete USB 
rozbočovač, ujistěte se že je napájen.

2. Připojte synchronizační kabel k 
smartphonu vložením do mini USB 
konektoru na spodní části vašeho 
smartphonu.

TIP Pro napájení smartphonu, zapojte 
nabíječku do konektoru na spodní části. 
Váš smartphone se také nabíjí, když 
je připojen k počítači synchronizačním 
kabelem.

VĚDĚLI JSTE, ŽE? Když je smartphone 
připojen k počítači používá internetovou 
přípojku (pokud je aktivní) pro přístup na 
internet.

POZNÁMKA Pokud přenášíte 
informace z dřívějšího Windows 
Mobile® zařízení nebo z Palm OS® 
zařízení od ACCESS, můžete se 
dozvědět více o přesunu 
obsahu např. obrázků, hudby a složek 
na váš smartphone na stránkách
go.palm.com/treo500/.
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USB sync cable

Synchronizace 
použitím 
synchronizačního 
kabelu

Pokaždé, když připojíte váš smart-
phone k počítači, synchronizační 
software automaticky zapne a zkon-
troluje zda je třeba změny, které jste 
udělali na počítači nebo na smart-
phonu synchronizovat.

• Připojte váš smartphone k počítači 
(viz.připojování smartphonu 
k počítači).
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Pokud máte nějaké problémy se 
synchronizací, podívej se na (synchro-
nizace: celkový přehled) návrhy řešení 
problémů.

TIP Pro ověření zda byla synchronizace 
úspěšná, stiskněte Home, stiskněte 
Start (levý softkey), stiskněte 2x More 
(levý softkey) a potom vyberte Active-
Sync. Stiskněte  Menu (pravý softkey) a 
vyberte Status. Zkontrolujte datum a čas 
poslední úspěšné synchronizace.

Nastavení bezdrátové 
synchronizace
Používá vaše společnost Microsoft 
Outlook jako emailové řešení? 
Používá také Microsoft Exchange 
Server 2003 nebo 2007 jako svůj 
emailový server? Je-li tomu tak, 
můžete být schopni bezdrátově syn-
chronizovat současně e-mail a další 
Outlookové informace na vašem 
smartphonu a stejné informace uklá-
dat na Exchange serveru používajícím 
Microsoft Exchange ActiveSync.

Pokud používáte Exchange Server 
2007 nebo Exchange Server 2003, 
který byl aktualizován do Service 
Pack 2, můžete být schopni využít 
dalších vlastností Microsoft Direct 
Push. Microsoft Direct Push je obou-
směrný bezdrátový způsob doručo-
vání informací, který vždy udržuje 
váš Outlook aktuální a poskytuje 
účinnější komunikaci mezi serverem 
a vaším smartphonem. Toto zahr-
nuje vlastnosti jako Global Address 
List, Task Over The Air (OTA) a IP 
aktualizaci Kalendáře, zpráv a Inboxu 
(na emailu).
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VĚDĚLI JSTE, ŽE? Protože se váš 
Outlook také synchronizuje se serverem, 
cokoliv je synchronizováno na serveru 
z vašeho smartphonu se také objeví v 
Outlooku na vašem počítači. A cokoliv vlo-
žíte nebo změníte v Outlooku na vašem 
počítači se synchronizuje se serverem a 
objeví se na vašem smartphonu.

VĚDĚLI JSTE, ŽE? Nemůžete bezdráto-
vě synchronizovat skupinově rozesílané 
emaily s Exchange serverem. Ať tak nebo 
onak, můžete pátrat po Global Addresse 
v kontaktech (viz. nalezení kontaktu v 
online adresáři) a přidejte je jednotlivě 
do seznamu kontaktů. Tento záznam 
kontaktu potom můžete synchronizovat 
se serverem.

TIP Pokud používáte Microsoft Exchange 
ActiveSync a ztratíte váš smartphone, 
kontaktuje vaše oddělení informačních 
technologií a co nejdříve zrušte přístup k 
Exchange serveru z vašeho smartphonu.

POZNÁMKA I když synchronizujete 
přes Exchange server, doporučujeme 
vám,  abyste instalovali také desktop 
synchronizační software (viz.nastavení 
vašeho počítače k synchronizaci), aby jste 
plně využili všech schopností smartphonu.

NEŽ ZAČNETE 
Pro bezdrátovou synchronizaci si potřebu-
jete založit Exchange Server účet. Spolu-
pracujte s vaším správcem systému
na tom, aby jste shromáždil následující 
informace:

• Adresu emailového serveru a jmé-
no domény.

VĚDĚLI JSTE, ŽE? Pokud používáte 
Outlook Web Access(OWA) služby, adre-
sa emailového serveru je obvykle stejná 
jako vaše OWA adresa.

TIP Pokud používáte vzdálený server Ex-
change services, kontaktujte hostitelskou 
společnost pro jméno domény.

• Uživatelské jméno a heslo, které 
užíváte pro zpřístupnění firemního   
emailového serveru.

• Bezpečnostní spojení: používá váš 
server zašifrované (SSL) spojení?

• Zda můžete mít uložené firemní 
emailové heslo na vašem smart-
phonu. Pro zachování bezpečnosti 
vám může správce systému požá-
dat o to, aby jste neukládali heslo 
na váš smartphone.
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TIP Pokud jste instalovali ActiveSync 
desktop software na Windows XP počí-
tač, možná jste již nastavili smartphone na 
bezdrátovou synchronizaci  se serverem. 
Pro kontrolu, stiskněte Home, stiskněte 
Start (levý softkey), stiskněte 2x More 
(levý softkey) a potom vyberte Active-
Sync.  Stiskněte Menu (pravý softkey). 
Pokud se objeví místo Add Server Source, 
Configure Server bezdrátová synchroniza-
ce je již nastavena a vy můžete přeskočit
následující postup.

1. Stiskněte Home  ( levý softkey) 
a potom stiskněte Start  ( levý 
softkey).

2. Stiskněte 2x More  (levý softkey) 
a vyberte ActiveSync .

3. Stiskněte Menu  (pravý softkey) 
a vyberte Add Server Source.

4. Napište adresu serveru.

5. Zaškrtněte This server re-
quires an encrypted(SSL) 
connection. (Tento server vyža-
duje šifrované (SSL) spojení). Ve 
většině případů musí být okénko 
zaškrtnuto.

6. Stiskněte Next  (pravý softkey).
7. Vložte uživatelské jméno a heslo, 

které používáte ke zpřístupnění 
vašeho firemního emailového 
serveru a vstupte do domény  
Exchange serveru.

POZNÁMKA Vaše heslo nemůžete při 
zadávání vidět, tak buďte opatrní. Ujistěte 
se, že Caps Lock i Option Lock jsou 
vypnuté, pokud je nebudete potřebovat. 
Pro informaci jak vkládat znaky (viz. psaní 
velkých a malých písmen, psaní číslic, 
interpunkce a symbolů).
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TIP Nastavení Exchange serveru je case-
sensitive (citlivé na to zda vložíte text 
psaný velkými nebo malými písmeny).
Ujistěte se, že vkládáte správně velká i 
malá písmena.
 
8. Zaškrtněte okénko Save password.

TIP Pokud váš správce systému nechce, 
aby jste měli uložené heslo na smartpho-
nu, nezaškrtávejte Save password. Musíte 
synchronizovat manuálně. (viz. manuální 
spuštění bezdrátové synchronizace).

TIP Pokud zaškrtnete toto okénko a později 
změníte Exchange heslo, budete muset 
znovu zopakovat celý postup a vložit nové 
heslo. Nemůžete bezdrátově synchronizo-
vat dokud neaktualizujete heslo.

9. Stiskněte Next  (pravý softkey) 
a zaškrtněte okénka u položek, 
které chcete synchronizovat s 
Exchange serverem.

10. (volitelné) Zvýrazněte položku, 
stiskněte Menu  (pravý 
softkey) potom vyberte Set-
tings pro změnu nastavení 
synchronizace těchto informací. 
Nastavení není dostupné pro 
všechny položky.

TIP Pro automatické stažení většího 
množství příchozí pošty, než je automa-
ticky nastaveno zvýrazněte Email (postup 
č .10), stiskněte Menu, vyberte Settings 
a vyberte vyšší číslo pro Download 
size limits (limity pro stahování). Pokud 
nezvýšíte nastavení, můžete manuálně 
stáhnout zbytek zpráv dle potřeby.

11. Stiskněte Finish  (levý 
softkey). Synchronizace s Ex-
change serverem začne auto-
maticky. Na obrazovce se objeví 
na stavovém řádku indikátor 
průběhu synchronizace.

Plán synchronizace můžete nastavit 
tak, aby probíhala vždy, když budou 
aktualizovány informace na smart-
phonu nebo serveru a to v určených 
intervalech. (viz nastavení plánu 
synchronizace). Nebo můžete povolit 
synchronizaci pouze manuálně (viz 
spuštění manuální synchronizace).
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Nastavení plánu synchronizace
Můžete nastavit plán synchronizace v 
následujících situacích:

Pokud používáte Microsoft 
Exchange Server 2007 nebo 
Microsoft Exchange Server 
2003 Service Pack 2:
Standardně začne synchronizace kdy-
koli jsou aktualizovány informace  
na smartphonu nebo serveru použí-
vajícím Microsoft Direct Push. Aby 
jste šetřili baterii, můžete nastavit 
intervaly synchronizace.

Pokud používáte Microsoft Ex-
change Server 2003, který není 
aktualizován do Service Pack 2: 
Standardně, nezačne synchronizace 
automaticky. Nastavte plán synchro-
nizace tak, aby probíhala při každé 
aktualizaci informací na smartphonu 
nebo serveru, nebo v určených 
intervalech.

1. Stiskněte  Home  potom stisk-
něte Start  (levý softkey).

2. Stiskněte 2x More  (levý softkey) 
a vyberte ActiveSync .

3. Stiskněte Menu (levý softkey) a 
vyberte Schedule (plán).

4. Nastavte některou z následujících 
možností:
Peak times (ve špičce): nastav-
te četnosti, pro období zvýšené 
aktivity např. když jste v zaměst-
nání nebo v době kdy přijímáte 
zvýšené množství emailů.
Off peak times (mimo špičku): 
nastavte četnosti, pro období 
snížené aktivity např. v pozdních 
nočních hodinách. 

Používejte nastavení výše, 
když jste v roamingové 
oblasti: 
Nastavte četnosti pro období, kdy 
jste mimo dosah vašeho provo-
zovatele bezdrátové sítě, tedy v 
roamingové oblasti. Rámeček by 
měl být vždy zaškrtnut, aby jste si 
mohli být jisti, že synchronizace 
probíhá řádně. 
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 Přijímání/odesílání po kliknutí 
na Send:
Specifikuje zda položky jsou posla-
né hned jakmile vyberete Send v 
e-mailové aplikaci nebo zda budou 
čekat do příští synchronizace.

5. Stiskněte Done  (levý softkey)

Manuální spuštění bezdrátové 
synchronizace
Pokud chcete mít pod kontrolou, kdy 
přesně dojde k synchronizaci
nebo pokud nemůžete mít uložené 
firemní emailové heslo ve
smartphonu, můžete zahájit synchro-
nizaci manuálně.

1. Pro nastavení manuální synchroni-
zace následujte předchozí postup 
(viz.nastavení plánu synchroniza-
ce). Ze seznamu Off peak times a 
peak times (viz. předchozí stránka) 
vyberte Manual.

2. Pro spuštění manuální synchroni-
zace stiskněte Home  a poté 
stiskněte Start  (levý softkey).

3. Stiskněte 2x More  (levý 
softkey) a vyberte ActiveSync .

4. Stiskněte Sync  (levý softkey).

Další způsoby 
synchronizace
Synchronizace přes Bluetooth® 
připojení
Váš smartphone a počítač můžete 
synchronizovat za použití Bluetooth®

bezdrátové technologie.

NEŽ ZAČNETE Ujistěte se, že je váš 
počítač vybavený Bluetooth® bezdrá-
tovou technologií.

1. Proveďte jednu z následujících 
možností:
Windows XP: Na vašem po-
čítači klikněte pravým tlačítkem 
na ikonu ActiveSync  na 
nástrojové liště v pravém dolním 
rohu obrazovky a vyberte Con-
nection Settings.

Windows Vista: Klikněte na 
Start> All Programs> Win-
dows Mobile Device Center.  
Vyberte Connect without 
setting your device a potom 
vyberte Connection settings.

2. Zaškrtněte rámeček Allow con-
nection for one of the fol-
lowing a vyberte Bluetooth®.
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3. Na vašem smartphonu stiskněte 
Home a poté stiskněte Start  
(levý softkey).

4. Stiskněte More  (levý 
softkey) a vyberte Settings .

5. Vyberte Connections a poté 
vyberte Bluetooth.

6. Stiskně Menu  (pravý softkey) 
a vyberte Turn On Bluetooth.

7. Stiskněte Home  a poté stisk-
něte Start  (levý softkey).

8. Stiskněte 2x More  (levý 
softkey) a vyberte ActiveSync .

9. Stiskněte Menu  (pravý 
softkey) a vyberte Connect via 
Bluetooth.

10. Pokud je to poprvé, kdy se připo-
jujete přes Bluetooth® na tento 
počítač, následujte nápovědu na 
obrazovce pro nastavení spolu-
práce počítače s Bluetooth®. (viz. 
připojení k zařízením s Bluetoo-
th® bezdrátovou technologií).

11. Vyberte Sync.

12. Po ukončení synchronizace 
stiskněte Menu  (pravý 
softkey) a vyberte Disconnect                       
Bluetooth. (odpojit Bluetooth).

Synchronizace s více počítači
Můžete nastavit smartphone tak, aby 
byl schopný synchronizovat infor-
mace až se dvěma počítači a také s 
Exchange Serverem 2003 a 2007. 
Když synchronizujete s více počítači 
položky, které synchronizujete objeví 
se na všech počítačích. 

Například, když nastavíte synchroni-
zaci smartphonu se dvěma počítači 
pojmenovanými C1 a C2. Když 
synchronizujete kontakty a kalendář 
na smartphonu s oběma počítači, 
dosáhnete následujících výsledků:

• Kontakty a schůzky v kalendáři 
počítače C1 jsou nyní také na C2.

• Kontakty a schůzky v kalendáři 
počítače C2 jsou nyní také na C1.

• Kontakty a schůzky v kalendáři z 
obou počítačů jsou nyní také na 
vašem smartphonu.

POZNÁMKA Microsoft Office 
Outlook E-mail může synchronizovat 
pouze s jedním počítačem.
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Nastavení možností 
synchronizace

Výběr aplikace k synchronizaci 
Pokud chcete synchronizovat poznám-
ky, obrázky a další soubory, musíte 
vybrat možnosti synchronizace.

1. Stiskněte Home  a poté Start 
 (levý softkey).

2. Stiskněte 2x More  (levý softkey) 
a vyberte ActiveSync .

3. Stiskněte Menu  (pravý 
softkey) a vyberte Options.

4. Proveďte jednu z následujících 
možností:

• Zaškrtněte rámeček u každé 
položky, které chcete synchronizo-
vat. Pokud vám nejde zaškrtnout 
rámeček u položky, je pravděpo-
dobně zaškrtnuta jinde v seznamu 
a je třeba vymazat zaškrtnutí.

• Vymažte zaškrtnutí v rámečku u 
položky u které chcete ukončit 
synchronizaci.

TIP Pro ukončení synchronizace mezi 
smartphonem a počítačem nebo Exchan-
ge serverem pokud již nechcete, aby byli 
informace s nimi v budoucnu  synchroni-
zovány. Zvýrazněte jméno počítače nebo 
serveru v nabídce obrazovky,stiskněte 
Menu (pravý softkey) a vyberte Delete.

• Zvýrazněte položku a potom 
vyberte Settings pro přizpůso-
bení položky. Nastavení nejsou 
dostupná pro všechny položky.
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TIP Pro detailní informace o synchroni-
zaci Word dokumentů, tabulek v Excelu a 
prezentací v PowerPointu (viz.synchroni-
zace Microsoft Office souborů). Pro detail-
ní informace o synchronizování obrázků, 
videí a hudebních souborů (viz synchroni-
zace multimediálních souborů).
Pro informace o změně možností synchro-
nizace emailových zpráv (viz. změna na-
stavení pro stahování emailových zpráv): 
(viz. e-mailové účty na Outlook).

Zastavení synchronizace
Pokud potřebujete manuálně zastavit 
synchronizaci, proveďte následující 
kroky:

1. Stiskněte Home  a poté stisk-
něte Start  (levý softkey).

2. Stiskněte 2x More  (levý softkey) 
a vyberte ActiveSync .

3. Stiskněte Stop  (levý softkey).
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Váš email

Již jistě víte, jak efektivní je e-mail pro to, aby jste byli stále v kontaktu.
Nyní váš smartphone Palm Treo 500 přináší novou úroveň pohodlí - e-mail 
v pohybu. Vychutnejte si pohodu a rychlost komunikace s přáteli, rodinou 
a kolegy, kdekoli máte přístup k bezdrátové službě poskytovatele datové 
sítě.

Můžete posílat fotografie vašim přátelům a rodině nebo vytvořit  Micro-
soft® Word nebo Excel® soubory a odeslat je kolegům. Můžete také 
přijímat přílohy a podle potřeby si je prohlížet.

VÝHODY:

·  Přijímání fotografií, hudebních souborů, Word a Excel souborů atd.
·  Připojení a odesílání příloh téměř jakéhokoli typu.
·  Ukládat zprávy z vašeho počítače a v příhodném čase si je prohlížet.

KAPITOLA

6
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Nastavení e-mailu

NEŽ ZAČNETE 
• Než použijete váš smartphone k 

odesílání nebo přijímání e-mailů, 
konzultujte s vaším provozova-
telem bezdrátových služeb cenu 
a dostupnost emailové služby a 
datových tarifů.

• Než pošlete nebo přijmete zprávy 
ujistěte se, že máte aktivní SIM 
kartu vloženou ve vašem telefonu. 
(viz vložení SIM karty a baterie), že 
je váš telefon zapnutý (viz.zapínání 
telefonu) a že jste v oblasti mobil-
ního pokrytí.

Nastavení emailového účtu

Na vašem smartphonu můžete 
používat Messaging aplikace různých 
emailů, které používáte - korporač-
ní, ISP a internetových (jako např. 
Yahoo, Mail a Gmail).

Před tím než budete moci odesílat 
a přijímat emaily na váš smartpho-
ne, se musíte rozhodnout, který typ 
e-mailových účtů chcete zpřístup-
nit. Postup nastavení se u každého 
emailového účtu liší, takže je velmi 
důležité, aby jste vybrali ten správný.

Typ e-mailového účtu
Typ e-mailu, který 
můžete zpřístupnit 

Jak jej nastavit

POP/IMAP Můžete získávat emaily z ISP, in-
ternetového e-mailového účtu jako 
je EarthLink, z malého obchodního 
nebo firemního internetového 
e-mailového účtu.

(viz nastavení  POP/IMAP účtu: 
běžní e-mailový dodavatelé) nebo 
(viz nastavení POP/IMAP účtu: 
ostatní e-mailový dodavatelé).
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TIP Někteří poskytovatelé internetových 
emailových služeb jako např.Yahoo! a Gmail 
umožňují konfigurovat váš emailový účet, 
aby mohl být přístupný z emailové aplikace 
na va šem smartphonu namísto z interne-
tového prohlížeče. Pro informace navštivte 
internetové stránky poskytovatele služeb.

Nastavení POP/IMAP účtu:
Běžní emailoví dodavatelé

Následujte tento postup pokud máte 
běžného emailového dodavatele 
jako AOL, EarthLink nebo Yahoo! 

Pokud nastavujete Inbox aplikaci, aby 
spolupracovala s vaším korporačním 
emailovým účtem nebo máte méně 
běžného emailového dodavatele (viz.
nastavení POP/IMAP účtu: Ostatní 
emailoví dodavatelé).

NEŽ ZAČNETE Informujte se u 
vašeho emailového dodavatele nebo 
správce systému na vaše uživatelské 
jméno a heslo, pokud je neznáte.

1. Stiskněte Home  a poté stisk-
něte Start  (levý softkey)

Typ e-mailového účtu
Typ e-mailu, který 
můžete zpřístupnit 

Jak jej nastavit

Microsoft Exchange server Můžete získat korporační email 
za použití Microsoft Exchange 
serveru. Můžete zpřístupnit email 
bezdrátově pokud vaše společnost 
používá Microsoft Exchange 
ActiveSync®.

(viz nastavení bezdrátové syn-
chronizace) Možná bude třeba 
kontaktovat oddělení informač-
ních technologií, abyste se ujistili, 
že Exchange ActiveSync® je pod-
porována a získali konfigurační 
nastavení.

Hotmail Pro zpřístupnění pošty z účtu 
Hotmail můžete použít Windows 
Live.

(viz používání Windows Live)

Bezplatný internetový email Můžete zpřístupnit mail přes 
Yahoo nebo jiný bezplatný interne-
tový systém

Vstupte přímo na emailovou 
internetovou stránku za použití 
internetového prohlížeče na 
vašem smartphonu.
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2. Vyberte Messaging .

3. Vyberte New E-mail Account.

4. Vložte emailovou adresu, kterou 
chcete nastavit. Zaškrtněte 
rámeček, aby proces nastavení 
získal nastavení účtu z internetu.

5. Stiskněte Next  (pravý softkey)

6. Pokud nastavení nalezne nasta-
vení účtu, stiskněte Next  
pravý softkey). Pokud se tak 
nestane (viz. nastavení POP/
IMAP účtu: ostatní emailoví 
dodavatelé, uživatelská příručka) 
a pokračujte krokem č. 6

7. Vložte své jméno a pokud chcete 
změňte jméno zobrazení účtu na 
smysluplnější. Například, pokud 
je to váš pracovní emailový účet, 
můžete jej pojmenovat Pracovní 
nebo jménem vaší společnosti.

8. Stiskněte Next  (pravý 
softkey).

9. Vložte své uživatelské jméno a 
heslo.

10. Pokud chcete, aby bylo vaše hes-
lo vloženo automaticky, zaškrtně-
te rámeček Save Password. 
Nezaškrtávejte pokud chcete 
heslo pokaždé vkládat.

VĚDĚLI JSTE, ŽE? Zaškrtnutím rámeč-
ku Save Password je přístup k vašemu 
emailu rychlejší, protože nemusíte pokaž-
dé vkládat heslo. Ponecháním nezaškrtnu-
tého rámečku je váš email bezpečnější, 
protože by někdo mohl stáhnout vaše 
emaily bez vložení hesla.

 

11. Stiskněte Next  (pravý softkey).
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12. (volitelný) vyberte z následujících 
možností:

Automatic Send/Receive (auto-
mat.přijímání a odesílání): Změňte ča-
sový interval automatického přijímání 
a odesílání emailů z intervalu po pěti 
minutách na jednou denně. Pokud 
nechcete automaticky stahovat emai-
ly stiskněte Manually.

TIP Pro maximalizaci životnosti baterie 
a minimalizaci poplatků za data,nastavte 
méně častý interval pro posílání a přijímá-
ní emailů.

Review all download settings 
(Přehled všech stažených nastavení):
Vyberte tuto volbu pro změnu nasta-
vení stahování další informace (viz 
změna nastavení stahování emailů: 
ostatní emailové účty).

13. Stiskněte Finish  (pravý 

softkey). Pokud budete vybídnuti, 
stiskněte OK  (levý softkey) 
pro okamžité stažení zpráv z 
tohoto účtu. 

Nastavení POP/IMAP účtu: 
ostatní emailoví dodavatelé
Můžete nastavit účet pro odesílání a 
přijímání emailových zpráv použitím 
účtu, který máte u poskytovatele 
internetového připojení (ISP), účet do 
kterého můžete vstoupit přes VPN 
serverové spojení. (viz. připojení k 
VPN), nebo jiný IMAP/POP emailový 
účet.

NEŽ ZAČNETE Spolupracujte s vaším 
emailový dodavatelem nebo správcem 
systému na tom, aby jste shromáždili 
následující informace:

• typ účtu (POP3 nebo IMAP)
• jméno pro poštovního serveru pro 

příjem pošty
• vaše uživatelské jméno a heslo
• zvláštní bezpečnostní požadavky

1. Stiskněte Home   a poté Start 
 (levý softkey).

2. Vyberte Messaging  .

3. Vyberte New E-mail Account.
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4. Vložte emailovou adresu, kterou 
chcete nastavit. Zaškrtněte ráme-
ček, aby proces nastavení získal 
nastavení účtu z internetu.

5. Stiskněte Next  (pravý softkey).

6. Pokud jste zaškrtli rámeček u kro-
ku č. 4  a proces nastavení účtu 
nalezl nastavení účtu (viz. nastave-
ní POP/IMAP účtu: běžní emailoví 
dodavatelé) a pokračujte krokem 6 
tohoto postupu.

7. Pokud budete vyzváni, vyberte 
některého z následujících emailo-
vých dodavatelů:

 

Internet e-mail: Vyberte tuto 
možnost jestliže vstupujete na 
email z některého typu emailo-
vého účtu, kromě účtu korporač-
ního (společného), který používá 
Exchange poštovní server.

Exchange server: Vyberte tuto 
možnost jestliže vstupujete na 
email z korporačního emailové-
ho účtu, který požívá Exchange 
server.

8. Stiskněte Next  (pravý softkey).

9. Vložte své jméno a pokud chcete 
změňte jméno zobrazení účtu na 
smysluplnější. Například, pokud 
je to váš pracovní emailový účet, 
můžete jej pojmenovat „Pracovní“ 
nebo jménem vaší společnosti.
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10. Stiskněte Next  (pravý softkey).

11. Vložte jméno poštovního serveru 
příchozí pošty.

12. Vyberte Account type seznam a 
poté vyberte POP3 nebo IMAP4.

13. Stiskněte Next  (pravý softkey).

14. Vložte uživatelské jméno účtu a 
heslo.

15. Pokud chcete, aby bylo vloženo 
heslo automaticky, zaškrtněte rá-
meček Save password, pokud 
chcete heslo pokaždé zadávat 
nezaškrtávejte rámeček. 

VĚDĚLI JSTE, ŽE? Zaškrtnutím rámeč-
ku Save Passwor je přístup k vašemu 
emailu rychlejší, protože nemusíte pokaž-
dé vkládat heslo. Ponecháním nezaškrt-
nutého rámečku je váš email bezpečnější, 
protože by někdo mohl stáhnout vaše 
emaily bez vložení hesla.

TIP U korporačního (společného) emailo-
vého účtu se ptejte vašeho správce systé-
mu, jestli můžete mít uložené korporační 
emailové heslo na vašem smartphonu 
(pro zvýšení bezpečnosti je třeba pokaždé 
zadávat heslo, pro zpřístupnění emailu). 
Pokud nemůžete mít uložené heslo na va-
šem smartphonu rámeček nezaškrtávejte.

16. Stiskněte Next  (pravý softkey).

17. Pokud obdržíte upozornění 
dávající na srozuměnou, že váš 
bezdrátový poskytovatel služeb 
již přizpůsobil nastavení odchozí-
ho poštovního serveru, stiskněte 
OK  (levý softkey) pro zavření 
upozornění a poté stiskněte 
Next  (pravý softkey) na obra-
zovce nastavení serveru odchozí 
pošty. Neměňte nebo nevpisujte 
nic na obrazovku.



109

 Pokud neobdržíte upozornění 
(viz  Zadávání nastavení serveru 
odchozí pošty)

TIP Pokud neobdržíte upozornění a pokud 
vaše příchozí pošta vyžaduje SSL, 
nastavte volbu i v serveru odchozí poš-
ty.(viz. vkládání nastavení serveru odchozí 
pošty) a zaškrtněte rámeček Require 
SSL for Incoming e-mail na předsunuté 
obrazovce nastavení serveru.

18. (volitelný) vyberte z následujících 
možností:

 Automatic Send/ Receive 
(automat.přijímání a odesílání): 
Změňte časový interval auto-
matického přijímání a odesílání 
emailů z intervalu po pěti minu-
tách na jednou denně. Pokud 
nechcete automaticky stahovat 
emaily stiskněte Manually.

TIP Pro maximalizaci životnost baterie a 
minimalizaci poplatků za data, nastavte 
méně častý interval pro posílání a přijímá-
ní emailů.

 Review all download settings: 
(Přehled všech stažených nastave-
ní). Vyberte tuto volbu pro změnu 
nastavení stahování, další informa-
ce (viz změna nastavení stahování 
emailů: ostatní emailové účty).

19. Stiskněte Finish  (pravý 
softkey). Pokud budete vybíd-
nuti, stiskněte OK  (levý 
softkey) pro okamžité stažení 
zpráv z tohoto účtu.

TIP Pro vymazání emailového účtu nebo 
úpravu nastavení například: Pokud po-
třebujete změnit jméno serveru odchozí 
pošty: Stiskněte Home, stiskněre Start 
(levý softkey) a vyberte Messaging. Pro 
vymazání účtu: Zvýrazněte účet, stiskněte 
Menu (pravý softkey) a vyberte Delete. 
(Pro vymazání účtu v Outlooku použijte 
aplikaci ActiveSync. Pokud chcete upravit 
účet: Zvýrazněte daný účet, stiskněte 
Menu (pravý softkey) a vyberte Settings. 
Pohybujte se po obrazovce po položkách, 
které chcete změnit. 
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Vkládání nastavení serveru 
odchozí pošty
Pokud jste v průběhu nastavování 
účtu neobdrželi upozornění, že váš 
provozovatel bezdrátových služeb 
nastavil volbu odchozí pošty, je třeba 
je vložit manuálně.

NEŽ ZAČNETE Spolupracujte s 
vaším emailový dodavatelem nebo 
správcem systému na tom, aby jste 
shromáždili následující informace.

• jméno poštovního serveru pro 
odesílání pošty

• zvláštní bezpečnostní požadavky

1. Na obrazovce pro vkládání na-
stavení odchozí pošty, vyberte 
správně následující nastavení:

 Outgoing (SMTP) mail server 
- server odchozí pošty

 Outgoing server requires 
authentication - server od-

chozí pošty vyžaduje oprávnění.
Zaškrtněte rámeček pokud je 
třeba oprávnění.

 Use the same name and 
password for sending e-mail 
- použijte stejné jméno a heslo 
pro posílání pošty: Zaškrtněte 
rámeček pokud server požaduje, 
aby jste použili uživatelské jméno 
a heslo účtu při odesílání pošty.

2. Vyberte Advanced Server Setting 
a vyberte správně následující 
nastavení:

 Require SSL for Incoming 
e-mail:
Zaškrtněte rámeček pokud účet 
vyžaduje SSL pro příchozí poštu.

 Require SSL for Outgoing 
e-mail: 
Zaškrtněte rámeček pokud účet 
vyžaduje SSL pro odchozí poštu.
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 Network connection (síťové 
spojení): Vyberte druh spojení 
pro odesílání a přijímání pošty.

3. Vyberte Done  (levý softkey). 
Na obrazovce serveru odchozi 
pošty, stiskněte Next  (pravý 
softkey)

4. (Volitelné) vyberte z následujících 
možností:

 Automatic Send/ Receive 
(automat.přijímání a odesílání): 
Změňte časový interval auto-
matického přijímání a odesílání 
emailů z intervalu po pěti minu-
tách na jednou denně. Pokud 
nechcete automaticky stahovat 
emaily stiskněte Manually. 

TIP Pro maximalizaci životnosti baterie 
a minimalizaci poplatků za data,nastavte 
méně častý interval pro posílání a přijímá-
ní emailů.

 Review all download set-
tings: (Přehled všech stažených 
nastavení). Vyberte tuto volbu 
pro změnu nastavení stahování, 
další informace (viz změna na-
stavení stahování emailů: ostatní 
emailové účty),

5.  Stiskněte Finish  (pravý 
softkey). Pokud budete vybíd-
nuti, stiskněte OK  (levý 
softkey) pro okamžité stažení 
zpráv z tohoto účtu.

Odesílání 
a přijímání emailů
Výběr emailového účtu, který 
chcete použít
Jestliže nastavíte víc než jeden 
emailový účet na vašem smartpho-
ne (viz nastavení emailu), můžete si 
vybrat účet, který chcete použít pro 
prohlížení nebo posílání zpráv vyberte 
z následujících způsobů:

• Standardně, kdy stisknete Home 
  stiskněte Start  (levý 

softkey), a vyberte Messaging  
, objeví se seznam všech vašich 

emailových účtů. Vyberte účet, 
který chcete použít.
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• Pokud vypnete volbu zobrazení 
seznamu účtů (viz.přizpůsobení 
nastavení emailu) když otevřete 
aplikaci zpráv, zobrazí se poslední 
účet, který jste používali. Stiskněte 
Vpravo  nebo Vlevo  pro 
pohyb po účtech dokud se neobjeví 
jméno účtu, který chcete v liště.

TIP Také stisknutím Vpravo nebo Vlevo 
můžete přejít na jiný účet potom co jste 
skončili práci na prvním, který jste vybrali.

Vytvoření a odeslání emailové zprávy
1. Stiskněte Home  a poté stisk-

něte Start  (levý softkey)

2. Vyberte Messaging  
3. Zvýrazněte emailový účet

4. Stiskněte New  (levý softkey)

5. Vložte adresu příjemce. Zde je 
několik zkratek:

• Pokud je jméno příjemce a emai-
lová adresa ve vašem seznamu 
kontaktů, stiskněte Menu  
(pravý softkey), vyberte Select 
Recipient (přidat příjemce), a po-
tom vybere příjemce ze seznamu.

• Pokud je jméno příjemce v online 
adresáři, můžete najít jméno a při-
dat jej (viz použití online adresáře).

VĚDĚLI JSTE, ŽE? Při adresování zprávy 
kontaktu, můžete zadat jedno nebo více pís-
men z křestního jména a příjmení kontaktu, 
oddělit je mezerou a potom vybrat jméno.

TIP Pro adresování zprávy více příjem-
cům, oddělte adresy stisknutím Return 
nebo vložením středníku (;).

6. Vybrat Subject a vložte předmět 
zprávy.

7. Stiskněte Dolů  pro přesun 
do textu zprávy. Zadejte zprávu 
nebo stiskněte Menu  (pravý 
softkey) a vyberte My Text. Vy-
berte výraz, který chcete a stisk-
něte Insert  (levý softkey).
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8. (volitelné) Pro připojení položky 
ke zprávě, stiskněte Menu (pravý 
softkey) a vyberte Insert. Vyberte 
typ položky, kterou chcete připojit 
a poté vyberte soubor nebo nahra-
ný hlasový záznam.

TIP Můžete poslat emailovou zprávu se 
souborem přímo z aplikace na vašem 
smartphonu (viz posílání emailových zpráv 
z jiné aplikace.

9. (volitelný) stiskněte Menu (pravý 
softkey) a vyberte Message Op-
tions. Vyberte seznam Priority, 
vyberte nastavení priority pro zprávu 
a stiskněte Done  (levý softkey).

TIP Můžete použít Message Options 
obrazovku k tomu, aby jste vybrali jazyk 
pro zprávu. Pro určité druhy emailových 
účtů můžete nastavit stupeň bezpečnosti 
a úroveň oprávnění.

10. Stiskněte Send  (levý softkey). 

TIP Pro snížení nároků na paměť vašeho 
smartphonu, vyberte nabídku ukládání 
odeslaných zpráv do složky odeslané v 
Inboxu. Stiskněte Menu (levý softkey) a 
vyberte Tools> Options. Vyberte Sending 
a odstraňte zaškrtnutí rámečku Save 
copies of sent items.

Přijímání emailových zpráv 
Jak přijímáte emailové zprávy závisí 
na typu účtu, který používáte
a synchronizaci:

• Pokud synchronizujete bezdrá-
tově přes Exchange server a 
používáte Microsoft Exchange 
ActiveSync, nové emailové zprá-
vy jsou vám poslány hned jak se 
objeví na serveru. V závislosti 
na plánu četností synchronizace 
(viz nastavení plánu synchroni-
zace). Nebo když zahájíte manu-
álně synchronizaci (viz manuální 
zahájení synchronizace).
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TIP Pokud synchronizujete email s 
Microsoft Exchange Server 2003 nebo 
2007 můžete synchronizovat zprávy v 
podsouborech,které vytvoříte. V inboxu 
účtu stiskněte MENU (pravý softkey) 
a vyberte Tools > Manage Folders. 
Soubory obsahující podsoubory se zobrazí 
s +. Vyberte + pro zobrazení podsouborů. 
Zaškrtněte rámeček vlevo od podsouboru, 
který chcete synchronizovat.

TIP Pokud synchronizujete email 
s Microsoft Exchange Server 2007 
a přijmete zprávu obsahující link do 
dokumentu na Sharepointu nebo vnitřním 
poli serveru, můžete si prohlédnout 
dokument výběrem tohoto linku.

• Pokud používáte synchronizační 
software k synchronizaci smart-
phone a PC, zprávy z Microsoft 
Office Outlooku na vašem PC, se 
přesunou do smatphone při připo-
jení k PC. (viz. připojeni smartpho-
ne k počítači). 

• Pro další druhy účtů vč. ISP účtů 
a účtů které jsou přístupné při 
spojení s VPN serveru (nejčastěji 
pracovní účty viz. připojení k VPN).
Získávání zpráv závisí na volbě, 
kterou vyberete ze seznamu 

automatického přijímání/odesílání 
zpráv. V průběhu nastavení účtu.
( Viz Nastavení POP/IMAP účtu: 
běžný nebo ostatní emailový 
poskytovatelé: 

 Pokud použijete časový 
interval: Váš smatphone auto-
maticky kontroluje a stahuje nové 
zprávy dle nastaveného časového 
intervalu.

 Pokud použijete manuální 
synchronizaci: Následujte tyto 
kroky pro odesílání a přijímání zpráv.

1. Stiskněte Home  a následně 
Start  (levý softkey)

2. Vyberte Messaging  .

3. Vyberte emailový účet obsahující 
zprávu, kterou chcete zobrazit.

4. Stiskněte MENU  (pravý 
softkey) a vyberte Send/Receive 
pro synchronizaci smartphone s 
emailovým serverem.
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TIP Částečně stažené zprávy se objeví v 
seznamu zpráv s ikonou neúplné obálky 
vlevo od jména odesílatele. Pro zobrazení 
celé zprávy buď stiskněte MENU (pravý 
softkey)a vyberte DOWNLOAD MES-
AGE nebo otevřete zprávu. Posuňte se 
nakonec textu a vyberte Get the rest of 
this message. Celá zpráva bude stažena 
při příští manuální nebo automatické 
synchronizaci.

VĚDĚLI JSTE, ŽE? Můžete prohlížet i 
odeslané zprávy v HTML formátu.

Přijímání příloh

1. Scolujte a vyberte jméno přílohy 
(pod předmětem). Tímto jí označí-
te pro stažení.

2. Znovu získejte zprávy buď automa-
ticky nebo manuálně z účtu, který 
obsahuje zprávu (viz přijímání 
emailových zpráv).

3. Scrolujte a vyberte opět jméno 
přílohy.

4. Stiskněte Open  (levý softkey).

VĚDĚLI JSTE, ŽE? Můžete přijímat a 
otevírat přílohy v mnoha různých formá-
tech vč. PDF. Přílohy PDF složek otevřete 
v PDF prohlížeči na smartphone (viz PDF 
prohlížeč).

TIP Přílohy můžete ukládat na rozšiřovací 
paměťovou kartu (prodává se samostat-
ně). Na obrazovce voleb příloh, stiskněte 
MENU (pravý softkey) a vyberte SAVE 
AS. Vyberte LOCATION seznam a dále 
STORAGE CARD.

Práce s emailovými 
zprávami.
Přidání kontaktu z emailové 
zprávy.

Můžete přidat jméno kontaktu nebo 
emailovou adresu do seznamu kon-
taktů. Přímo z pole příjemce, kopie 
nebo skryté kopie emailové zprávy.
Můžete vybrat jméno nebo adresu 
z odeslaných nebo přijatých zpráv.
Kontakt můžete vytvořit nebo přidat 
informace již z existujícího kontaktu.
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1. V otevřené zprávě zvýrazněte jmé-
no nebo adresu kontaktu, který 
chcete přidat.

2. Stiskněte CENTER .

3. Stiskněte SAVE (levý softkey).

4. Vyberte < New Contakt > pro 
vytvoření nového kontaktu pro 
toto jméno nebo adresu.   Nebo 
vyberte již existující kontakt a 
přidejte jméno nebo adresu.

5. Vložte nebo editujte informace o 
kontaktu.

6. Stiskněte SAVE  (levý softkey).

Používání online adresáře

Můžete zpřístupnit informaci o kon-
taktu jako je emailová adresa nebo 
telefonní číslo, z Vašeho organizač-
ního online adresáře nebo Global 

Address List (GAL). Pro zpřístupnění 
GAL si ověřte zda máte zpřístup-
něný Exchange server 2007 nebo 
Exchange server 2003. Servis Pack 
2. tato vlastnost je užitečná pokud 
znáte přesné jméno,  které se objeví 
v adresáři.

VĚDĚLI JSTE, ŽE? Můžete použít 
Glogal Address List (GAL), aby našel 
kontakt.V kontaktech stiskněte Menu 
(pravý softkey) a vyberte Company 
Directory. Při zaslání setkávací žádosti 
vyberte Attendees stiskněte Menu 
(pravý softkey) a vyberte Company 
Directory.

1. V nové zprávě vyberte To.

2. Vyberte Menu  (pravý softkey) 
a vyberte Add recipient.

3. Vyberte NEW < Company Di-
rectory >.

4. Vyberte jméno kontaktu, tak jak se 
objeví v adresáři a stiskněte Find 

 (levý softkey).
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TIP V době, kdy nemůžete bezdrátově 
synchronizovat distribuční list z aplikace 
kontaktů, můžete přidat distribuční list 
jako kontakt, když ho přidáte z online 
adresáře. Kontakt obsahuje všechny 
členy z distribučního seznamu i přes to, 
že nevidíte jednotlivá jména. Ujistěte se, 
že pojmenujete kontakt podobně, ale ne 
úplně stejně, jako v originálním distribuč-
ním listě.Takže se kontakty nezamění ve 
vašem počítači.

Vyhledání zpráv

Můžete vyhledat zprávy obsahující 
specifické slovo nebo frázi. Aplikace 
vyhledává jména, emailové adresy a 
předměty.

1. Stiskněte Home  potom stisk-
něte Start  (levý softkey).

2. Vyberte Messaging  .

3. Vyberte účet obsahující zprávu, 
kterou chcete najít.

4. Začněte psát slovo nebo frázi, 
kterou chcete najít. Toto se může 
objevit z kterékoli adresy nebo 
předmětu. Seznam zobrazuje 
změny a objeví obsahující písme-
na, která vpisujete.

5. Pokračujte vkládáním písmen pro 
zúžení zobrazení dokud se neobje-
ví zpráva, kterou hledáte.

VĚDĚLI JSTE, ŽE? Když synchronizu-
jete s Microsoft Outlook 2007, můžete 
vyhledat zprávy uložené na poštovním 
serveru.

Odpovědět na zprávu
1. Otevřete zprávu na kterou chcete 

odpovědět.

2. Stiskněte Reply  (levý 
softkey).

3. Vyberte účet obsahující zprávu, 
kterou hledáte.

4. (Volitelné) Vyberte Edit Sen-
der´s Message pro editaci origi-
nálu textové zprávy  odesílatele, 
kterou vložit do odpovědi.

5. Stiskněte Send  (levý softkey).

VĚDĚLI JSTE, ŽE? Když odpovídáte na 
zprávu poslanou v HTML formátu, bude 
odpověď odeslána také ve formátu HTML.

TIP Pro odeslání jak odesílatem tak dal-
ším příjemcům zprávy, zvýrazněte nebo 
vyberte zprávu, stiskněte Menu (pravý 
softkey) a vyberte Reply >Reply All.
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Přeposílání zpráv

1. Zvýrazněte nebo otevřete zprávu, 
kterou chcete přepískat.

2. Stiskněte Menu  (pravý softkey) 
a vyberte Reply> Forward

3. Adresujte zprávu a vložte text.

4. (Volitelné) Vyberte Edit Sender’s 
message pro editaci originálního 
textu odesílatele, který je obsažen v 
přeposílané zprávě.

5. Stiskněte Send  (levý softkey).

Vymazání zpráv
Vymazat můžete zprávy, které právě 
čtete nebo zprávy ze seznamu.

Pro vymazání zprávy, kterou právě 
čtete:

• Stiskněte Menu  (pravý 
softkey) a vyberte Delete.

Pro vymazání zpráv ze seznamu:

1. Zvýrazněte zprávu, kterou chcete 
vymazat.

2. Stiskněte Delete  (levý softkey).

3. Vyberte Yes pro potvrzení výmazu.

Použití emailových zkratek

Běžné emailové úkony můžete prová-
dět stisknutím a přidržením určitého 
tlačítka klávesnice. Zvýrazněte nebo 
otevřete zprávu a potom stiskněte 
jednu z následujících kláves. Není 
třeba nejdříve stisknout Option .

Stiskněte 
a přidržte:

Můžete zpřístupnit...

0 Zobrazit emailové zkratky

1
Odepsat všem odesílatelům 
i příjemcům zprávy

2 Odepsat pouze odesílateli

3
Označit zprávu jako přečtenou/
nepřečtenou

4
Označit zprávu s vysokou 
prioritou

5 Přesunovat zprávu mezi soubory

6 Přeposlat zprávu

7 Vymazat zprávu

8
Plně stáhnout částečně staženou 
zprávu

9
Manuálně odeslat/přijmout 
zprávu
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Přidávání podpisu ke zprávám
Ke každému emailovému účtu může-
te použít jiný podpis.

1. Stiskněte Home  a následně 
Start  (levý softkey).

2. Vyberte Messaging  .

3. Vyberte kterýkoli emailový účet.

4. Stiskněte Menu  (pravý softkey) 
a vyberte Tools> Options.

5. Vyberte Signatures.

6. Vyberte účet ke kterému chcete 
přiřadit podpis.

7. Zaškrtněte rámeček Use signa-
ture with this account, aby 
jste mohli přidat podpis k novým 
zprávám, které na tomto účtu 
vytvoříte.

8. (Volitelné) Zaškrtněte rámeček 
Include when replying and 
forwarding, aby jste mohli přidat 
podpis ke zprávám na které odpo-
vídáte nebo přeposíláte.

9. Vyberte pole pro podpis a vložte 
text, který chcete používat.

10. Stiskněte Done  (levý softkey).

Přizpůsobení nastavení emailu
Pokud přizpůsobujete nastavení pro 
emailový účet volby, které vyberete 
budou se týkat pouze tohoto účtu.

1. Stiskněte Home a potom Start  
(levý softkey).

2. Vyberte Messaging  .

3. Vyberte emailový účet.

4. Stiskněte Menu  (pravý softkey) 
a vyberte Tools> Options.
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5. Vyberte Display a nastavte 
některou z následujících možností. 
Stiskněte Done  (levý softkey), 
když skončíte.

 
Show date and time in the 
message list: Nastavte zda se 
zobrazí datum a čas přijaté zprávy 
v seznamu zpráv.

 Uspořádat zprávy: První 
seznam specifikuje kritéria podle 
kterých jsou tříděny zprávy v 
seznamu. Druhý seznam nastavte 
zda postup třídění je vzestupný 
(A - Z  nebo od nových po starší) 
nebo vzestupně (Z - A od starších 
po nové).

 Po smazání nebo přesunutí 
zprávy: Specifikuje co chcete 
vidět po smazání nebo přesunutí 
emailové zprávy kterou čtete: 

seznam zpráv, další zprávu nebo 
příchozí zprávu.

6. Vyberte Sending a nastavte 
jednu z následujících voleb. Stisk-
něte Done  (levý softkey) pro 
ukončení.

 Include copy of original 
message when replying to 
e-mail: Indikuje zda se obsah 
zprávy kterou jste obdrželi objeví 
v odpovědi na tuto zprávu. 

 Save copies of sent items: 
Indikuje zda se odeslaná zpráva 
vloží v Sent folder.

7. Vyberte Security Setting a 
zaškrtněte rámeček - Warn 
before navigation to a URL 
or file link that is not on my 
device - pokud chcete obdržet 
upozornění na zprávu předtím než 
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otevřete URL nebo uložíte link, 
který není na vášem smartphonu. 
Stiskněte Done  (levý softkey) 
pro dokončení.

8.  Stiskněte Done  (levý softkey) 
pro dokončení.  

 Display account picker 
when opening Messaging: 
Specifikuje zda se seznam vašich 
emailových účtů objeví po otevře-
ní Messaging aplikace a vyberete 
jeden, který chcete použít. Pokud 
nezaškrtnete rámeček po otevření 

aplikace se zobrazí poslední účet, 
který jste používali.

TIP Pokud nezaškrtnete rámeček u 
display account picked when opening 
Messaging, můžete se pomocí tlačítek 
Left a Right pohybovat po seznamu.

Warn when deleting messages 
in th message list: Specifikuje 
zda se objeví ověřovací zpráva, když 
vymažete jednu nebo více zpráv ze 
seznamu zpráv.

9. Stiskněte Done  (levý softkey).

Změna stažených emailových 
nastavení

Můžete si přizpůsobit nastavení 
stažených voleb pro emailový účet 
Outlooku, který synchronizujete s 
počítačem nebo Exchange serverem.

POZNÁMKA Pro změnu voleb dalších 
emailových účtů (viz. změna nastavení 
stahování emailů: Ostatní emailové účty).
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1. Stiskněte Home , potom 
Start  (levý sowtkey).

2. Stiskněte More  (levý softkey) 
dvakrát a vyberte ActiveSync 

3. Stiskněte Menu  (pravý 
softkey) a vyberte Options.

4. U synchronizačních metod (Micro-
soft Exchange nebo Windows 
PS) zvýrazněte E-mail a vyberte 
Settings.

5. Vyberte jednu s následujících 
možností:

 Download the past: Specifi-
kuje počet dnů, po kterých dojde 
ke stažení emailů při automatické 
nebo manuální synchronizaci.

 Massage format: Specifikujte 
formát pro zasílání a přijímání 
zpráv.Pokud vyberete HTML, 

zaslané zprávy v tomto formátu 
přijmete v nezměněném formá-
tu. Pokud vyberete prostý text, 
všechny přijatá zprávy budou v 
prostém textu.

 Download size limit: Speci-
fikuje velikost příchozích zpráv, 
které jsou automaticky staženy. 
Zprávy nad nastavenou velikost, 
musíte stáhnout manuálně. Výbě-
rem vyššího limitu bude staženo 
více vašich zpráv, jejich získávání 
může trvat déle. Můžete vybrat 
jen stažení předmětu zprávy, 
nezávisle na velikosti.

6. (Volitelné) Stiskněte Menu  
(pravý softkey) a vyberte Advan-
ced a potom vyberte některou z 
následujících možností:

 Encrypt Messages: Specifikuje 
zda mají být stahované zprávy 
šifrovány pro větší bezpečnost.
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 Sing messages: Specifikujte 
zda má být ke zprávám přiřazen 
číselný podpis (digitální podpis) 
jako mimořádné bezpečnostní 
opatření.

TIP Stiskněte Menu (pravý softkey) a 
vyberte Choose signature pro výběr certi-
fikátu,který použijete jako digitální podpis.

 My email address: Označuje 
adresy na které by mělo být pou-
žito bezpečnostní opatření.

7. Stiskněte Done (levý softkey).

Changing email download 
settings: Ostatní emailové účty. 
Přizpůsobit můžete všechny stažené 
volby v každém emailovém účtu, 
který máte u zřizovatele internetové 
služby (ISP) nebo přístup přes VPN 
server. (Typický pracovní účet)

POZNÁMKA Pro změnu voleb pro 
Microsoft Office Outlook účet. Viz. Změna 
nastavení stahování emailů: Emailové účty 
na Outlooku.

1. Stiskněte Home  a potom 
stiskněte Start  (levý softkey).

2. Stiskněte Messaging  

3. Stiskněte účet, který chcete.

4. Stiskněte Menu  (pravý 
softkey) následně stiskněte Tool 
> Option.

5. Stiskněte Account Settings.

6. Stiskněte Next  (pravý softkey) 
dokud se nezobrazí následující 
obrazovka.

7. Vyberte některou z následujících 
možností.

 Automatic send/Receive: Spe-
cifikujte interval pro stažení emailů 
od 5-ti minutového po 1 x denní. 
Pokud nechcete stahovat emaily 
automaticky vyberte Manually.

 Download Messages: Specifi-
kujte počet dnů ve kterých dochází 
ke stažení emailů. Manuálně nebo 
automaticky.
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TIP Pro úsporu paměti omezte počet 
stažených emailů do smartphonu, výbě-
rem kratších časových intervalů stahování 
zpráv.

8. Vyberte Advanced Settings a 
potom vyberte následující mož-
nosti:

 Send / receive when I click 
Send: Odeslání a přijímání zpráv 
manuálně. 

 Use automatic send / receive 
schedule when roaming.

 Specifikujte jestli dochází k auto-
matickému stahování pokud jste v 
roamingové zóně. Toto může vy-
ústit ke zvýšení poplatků za spojení 
než na jaké jste zvyklí v domácí síti.

 When deleting messages: 
Specifikujte zda zprávy smazanéve 
smartphonu budou smazány i na 
serveru.

9. Stiskněte Done  (levý softkey).

10. Stiskněte Next  (pravý softkey).

11. Vyberte jednu z následujících mož-
ností:

 Message formát: Vyberte 
formát přijímaných a odeslaných 
zpráv. Pokud vyberete HTML, vámi 
poslané zprávy zůstanou ve formátu 
HTML. Pokud vyberete jednoduchý 
text, všechny zprávy budou přijaty v 
jednoduchém textu.
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VĚDĚLI JSTE, ŽE? Zprávy poslané v 
jednoduchém textu se zobrazí napsané v 
jednoduchém textu i když vyberete HTML.

 Message download limit: 
Vyberte velikost příchozích zpráv, 
které jsou automaticky stahovány. 
Část zprávy která tuto velikost 
přesahuje musí být stahována 
manuálně. Zvýšení limitu stahování 
budou zprávy staženy celé, ale jejich 
přijímání zabere více času. Můžete 
také vybrat pouze stažení hlavičky 
zprávy bez ohledu na velikost.

12. Stiskněte Finish  (pravý 
softkey).

Práce s pozvánkami 
na schůzku
Pozvánky na schůzku můžete přijímat 
stejně tak jako když přijímáte email.

POZNÁMKA Pozvánky na schůzku mů-
žete vytvořit na vašem smartphonu. (viz.
Posílání pozvánek na schůzku)

Zde jsou klíčové vlastnosti pozvánek na 
schůzky:

• Poznámky na schůzky se zobrazí 
na vašem smartphonu v aplikaci 
Messaging, ne v kalendáři.

• V messaging aplikaci můžete 
přijmout, odmítnout nebo dočasně 
přijmout pozvánky na schůzky.

• Pokud přijmete pozvánku objeví se 
ve schůzkách aplikace kalendáře.

• Můžete odpovědět nebo přeposlat 
pozvánku na schůzku stejně jako 
emailovou zprávu.

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte Messaging  .

3. Vyberte účet, který chcete.

4. Vyberte pozvánku na schůzku, k 
otevření pozvánky na schůzky se 
zobrazí tato ikona: 
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5. Pro přijetí pozvání, stiskněte 
Accept  (levý softkey), vyberte 
zda chcete editovat (přidat komen-
tář) odpověď, a vyberte OK  
(pravý softkey). Pro odmítnutí nebo 
dočasné přijetí pozvánky stiskněte 
Menu  (pravý softkey) a vy-
berte Decline (Odmítnuté) nebo 
Tentative (Dočasně přijaté).

TIP Pokud obdržíte zrušení schůzky 
nemusíte provádět nic.

Posílání emailů 
s přílohami:
Soubory jako například obrázky, 
videa a vyzvánění. Můžete posílat 
jako přílohy emailů. (viz. Vytvoření a 
odesílání emailů).

Můžete poslat soubor z aplikace 
ve které je vytvářen nebo vložen. 
Například pokud uděláte fotografii 
na fotoaparátu smartphonu, můžete 
poslat foto jako přílohu emailové 
zprávy. Toto můžete použít i u videí a 
zvukových souborů. Pro více informa-
cí se podívejte do kapitol o daných 
aplikacích.
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Textové a multimediální 
zprávy

Pokud potřebujete poslat rychle krátkou zprávu svému příteli nebo kole-
govi, pošlete textovou zprávu z vašeho Palm® Treo™ 500 smartphonu na 
jejich mobilní telefon nebo emailovou adresu.

Pokud potřebujete více než text, použijte k sebevyjádření multimediální 
Messaging, který dodá vaší zprávě zvláštní význam přidáváním 
fotografií, videa nebo zvukového souborů.

Výhody:

·  Užijete si rychlou komunikaci 
·  Použijete textový Messaging chatování s přáteli.
·  Budete tak srozumitelní nebo kreativní jak budete chtít.

KAPITOLA

7
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V této kapitole
Odesílání a přijímání zpráv ..................................................................... 129
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Odesílání 
a přijímání zpráv
Svůj smartphone můžete použít k 
odesílání a přijímání SMS a MMS 
zpráv. Předtím než začnete ode-
sílat a přijímat zprávy, konzultujte 
s vaším provozovatelem mobilní 
sítě cenu a dostupnost textových a 
multimediálních služeb.

POZNÁMKA Síťové nastaveni MMS 
je přednastavenood provozovatele 
mobilní sítě, který poskytl SIM kartu 
společně se smartponem. Pokud se 
rozhodnete pro SIM kartu od jiného 
provozovatele je třeba, aby jste ma-
nuálně vložili nastavení pro multime-
diální služby.

Vytvoření a odeslání textové 
zprávy
Každá textová zpráva může obsa-
hovat až 160 znaků. Můžete poslat 
zprávu s více než 160-ti znaky, ale ta 
bude automaticky rozdělena do dvou 
nebo více zpráv. Pokud pošlete zprá-

vu na emailovou adresu, emailová 
adresa bude součástí 160-ti znaků.

VĚDĚLI JSTE, ŽE? Můžete přijímat i 
odesílat textové zprávy v době volání. 
Toto je snadnější při používání hands 
free náhlavní soupravy nebo hlasitého 
odposlechu.

NEŽ ZAČNETE 
Ujistěte se, že je váš telefon zapnutý 
a že se nacházíte v oblasti mobilní-
ho pokrytí (viz. zapínání mobilního 
telefonu).

1. Stiskněte Home  potom 
Start  (levý softkey).

2. Vyberte Messaging  a po-
tom vyberte Text Messages.

3. Stiskněte Menu  (pravý 
softkey) a vyberte New.
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4. Vložte jméno, mobilní číslo nebo 
emailovou adresu příjemce. Zde 
jsou zkratky:

• Pokud je jméno, mobilní číslo 
nebo emailová adresa příjemce 
v seznamu kontaktů stiskněte 
Menu  (pravý softkey), vy-
berte Add Recipient a vyberte 
příjemce ze seznamu.

TIP Zprávu můžete poslat i z aplikace 
kontaktů, kde vyberete jméno a vyberete 
Send Text Message.

VĚDĚLI JSTE, ŽE? Můžete vizitku 
kontaktu poslat jako textovou zprávu (viz. 
Posílání vizitek)

• Stiskněte Center  pro zobra-
zení seznamu naposledy užíva-
ných adres a vyberte příjemce ze 
seznamu.

• Pokud je jméno příjemce v on-line 
adresáři stiskněte Center , 
vložte jméno, stiskněte Menu  
(pravý softkey) a vyberte Com-
pany Directory. Vyberte jméno 
a vyberte buď telefonní číslo 
nebo emailovou adresu. Pro více 
informací (viz Používání On-line 
adresáře).  

• Pokud není jméno ani mobilní číslo 
v seznamu kontaktů vložte jej.

TIP Pro adresování zprávy více příjem-
cům oddělte adresy středníkem (;).  Zprá-
vu můžete odeslat až 20 příjemcům.

TIP Pro odeslání zprávy z jiného čísla u 
kontaktu, vyberte pole kontaktu a editujte 
číslo, které se objeví vedle jména.

5. Stiskněte Dolů   pro přesun 
do textu zprávy. Vložte zprávu 
nebo stiskněte Menu  (pravý 
softkey) a vyberte My Text. 
Vyberte frázi a stiskněte Insert 

 (levý softkey).

6. Stiskněte Send  (levý softkey).
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Nastavení voleb doručování 
textových zpráv. 

Můžete nastavit volby pro jednotlivé 
zprávy, které odesíláte.

VĚDĚLI JSTE, ŽE? Můžete nastavit 
všeobecné preference, které budou použi-
ty u všech příchozích i odchozích zpráv 
(viz. Přizpůsobení nastavení zpráv). Pokud 
nastavíte volby pro jednotlivou zprávu, 
tyto volby potlačí všeobecné preference 
jen pro tuto zprávu.

1. Na obrazovce vytvoření zpráv stisk-
něte Menu  (pravý softkey).

2. Vyberte Message Options.

3. Zaškrtněte rámeček  Request 
Message Delivery Notifi-
cation pro přijímání potvrzení o 
doručení zprávy.

4. Stiskněte Done  (levý softkey).

Vytvoření a odesílání multime-
diálních zpráv
Multimediální zprávy se skládají z 
obrázků, videí, textů a zvuků zobrazu-
jících se jako jeden nebo více slidů. 
Můžete vložit kteroukoliv z následují-
cích položek:

Ring tones (Vyzvánění)

• MIDI

Sound Clips (Zvukové klipy)

• AMR

• QCELP

Pictures (Obrázky)

• JPEG

• GIF

• WBMP

Videos (Videa)

• 3GPP

• 3GPP2

• MPEG4

Odchozí multimediální zprávy mohou 
mít 300KB standardně, ale váš pro-
vozovatel mobilních služeb může mít 
jiné maximum velikosti MMS.
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NEŽ ZAČNETE 

• Ujistěte se, zda je váš telefon 
zapnutý a že se nacházíte v oblasti 
mobilního pokrytí (viz Zapínání 
mobilního telefonu).

• Ujistěte se u vašeho provozovate-
le mobilních služeb o ceně a do-
stupnosti multimediálních služeb.

1. Stiskněte Home  a potom 
Start  (levý softkey).

2. Vyberte Messaging  potom 
vyberte MMS.

3. Stiskněte Menu  (pravý softkey) 
a vyberte New.

4. Vložte mobilní číslo nebo emailovou 
adresu příjemce. Zde jsou zkratky:

• Pokud je jméno, mobilní číslo 
nebo emailová adresa příjemce 
v seznamu kontaktů stiskněte 
Menu  ( pravý softkey ), vy-

berte Add Recipient a vyberte 
příjemce ze seznamu.

• Stiskněte Center  pro zob-
razení seznamu naposledy užíva-
ných adres a vyberte příjemce ze 
seznamu.

• Pokud je jméno příjemce v on-
line adresáři stiskněte Center 

 a vložte jméno, stiskněte 
Menu  (pravý softkey) a 
vyberte Company Directory. 

• Pokud není jméno ani mobilní 
číslo v seznamu kontaktů vlož-
te jej.

TIP Pro zobrazení polí kopie a skryté 
kopie, aby jste mohli vložit adresy do po-
ložky, dejte kurzor na To pole a stiskněte 
Up na 5-ti polohovém tlačítku.

5. Vyberte Subject a vložte předmět 
zprávy.

6. Vyberte jednu nebo obě následující:

 Insert Picture / Video: Umožní 
vám vložit obrázek nebo video.  
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 Insert audio: Umožní vám 
zaznamenat zprávu, například 
zvukový záznam pro obrázek nebo 
vložit existující např. vyzváněcí tón. 
Můžete přidat jeden zvuk ke slidu 
nebo pro vložení více zvuků přidat 
další slid ke zprávě.

VĚDĚLI JSTE, ŽE? Můžete přidat 
obrázek i zvukový klip do jednoho slidu ve 
zprávě.

7. (volitelné) Ze vsunutého Audio pole 
stiskněte Dolů    a vložte text 
nebo zprávu do slidu.

VĚDĚLI JSTE, ŽE? Pokud pohnete 
kurzorem ven z místa pro vkládání textu 
objeví se štítek Insert Text  (vložte text).

8. (volitelné) Stiskněte Menu  
(pravý softkey), vyberte Slides > 
Insert a opakujte krok 7 a 8 pro 
přidání dalšího slidu do zprávy.

VĚDĚLI JSTE, ŽE? Pokud vložíte více než 
jeden slid do zprávy, můžete nastavit délku 
zobrazení každého z nich. Stiskněte Menu 
(pravý softkey) a vyberte Slides > Duration.

9. (volitelné) Pro vložení kontaktu 
nebo souboru z kalendáře do 
zprávy stiskněte Menu  
(pravý softkey) a vyberte Insert > 
vCard nebo Insert > vCalen-
dar. Pro vložení jiného souboru 
stiskněte Menu  (pravý 
softkey) a vyberte Insert > File.

10. Stiskněte Send  (levý softkey).

TIP Jestli nebudete schopni odeslat 
multimediální zprávu, bude třeba manu-
álně vložit nastavení sítě (viz. Manuální 
nastavení síťového spojení).

Nastavení volby doručení multi-
mediální zprávy

Můžete nastavit volby pro jednotlivé 
multimediální zprávy, které posíláte.
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VĚDĚLI JSTE, ŽE? Můžete nastavit 
všeobecné preference, které budou použi-
ty u všech příchozích i odchozích zpráv 
(viz. Přizpůsobení nastavení zpráv). Pokud 
nastavíte volby pro jednotlivou zprávu, 
tyto volby potlačí všeobecné preference 
jen pro tuto zprávu.

1. Na obrazovce vytvoření zpráv 
stiskněte Menu  (pravý 
softkey).

2. Vyberte Options > Send Opti-
ons.

3. Vyberte jednu s následujících 
možností:

 Priority: Signalizuje úroveň 
priority pro tuto zprávu.

 Delivery/Read Report: Signali-
zuje zda chcete obdržet potvrzení 
o doručení nebo přečtení zprávy.

 Hide Sender: Specifikuje pokud 
nechcete, aby bylo vaše telefon-
ní číslo přiřazeno ke zprávě pro 
identifikaci vás jako odesílatele.

4. Stiskněte Done  (levý 
softkey).

TIP Pro změnu pozadí odchozích mul-
timediálních zpráv na obrazovce zprávy 
stiskněte Menu (pravý softkey) a vyberte 
Options > Background Color. Vyberte 
barvu, kterou chcete a stiskněte Select 
(levý softkey).

Přijímání a odesílání MMS
Pokud je váš telefon zapnutý a jste v 
oblasti bezdrátového pokrytí, objeví 
se v horní části obrazovky, po přijetí 
textové zprávy  nebo MMS .
Následujte tyto kroky pro otevření 
zprávy:

1. Stiskněte Home  a potom 
Start  (levý softkey).

2. Vyberte Messaging  a potom 
Text Messages nebo MMS.

3. Vyberte zprávu, kterou chcete 
zobrazit.
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4. Budete-li požádáni, stiskněte 
Download  (levý softkey) pro 
stažení celé zprávy.

5. Proveďte některý z následujících: 
Pause or resume playback 
(Přerušení nebo pokračo-
vání přehrávání pouze u 
MMS): Pro přerušení přehrá-
vání stiskněte Pause  (levý 
softkey). Pro pokračování pře-
hrávání stiskněte Play  (levý 
softkey).

 Save the item that is 
playing (Uložit přehrávanou 
položku, pouze u MMS): Stisk-
něte Menu  (pravý softkey) a 
vyberte Save.

 Reply to the message (Ode-
psat na zprávu): Stiskněte Menu

 (pravý softkey) a vyberte 
Reply > Reply nebo Reply > 
Reply All.

POZNÁMKA Pokud je zpráva textovou 
nebo multimediální a obsahuje jeden 
obrázek a ne zvuk, stiskněte Reply (levý 
softkey) pro odepsání.

VĚDĚLI JSTE, ŽE? Když odepíšete 
na MMS, vaše odpověď je odeslána jako 
MMS, i když neobsahuje žádná media. Pro 
omezení výdajů za MMS napište a odešle-
te novou textovou zprávu odesílateli.

Forward the messages (Přepo-
slat zprávu): Stiskněte Menu  
(pravý softkey) a vyberte Reply > 
Forward.

Přidání informací o odesílateli 
do kontaktů Vyberte telefonní čís-
lo nebo emailovou adresu odesílatele 
a stiskněte  Yes  (levý softkey) 
pokud budete požádáni o vytvoření 
nového kontaktu vyberte <New 
Contact>. Pro vytvoření nového 
kontaktu, nebo vyberte existující a 
vložte informaci poté stiskněte Save 

 (levý softkey).

VĚDĚLI JSTE, ŽE? Pro zobrazení MMS 
obsahujících více slidů, můžete stisknutím 
Right na 5-ti polohovém tlačítku přecházet 
z jednoho do druhého nebo se stisknutím 
Left na 5-ti polohovém tlačítku vracet na 
předchozí.

6. Stiskněte Done  (levý softkey). 
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TIP Mnoho klávesových zkratek, které 
jsou k dispozici pro emailové zprávy – 
např. pro odpovídání a přeposílání
zpráv, mohou být použity i v textových a 
multimediálních zprávách (viz. Seznam 
emailových zkratek).

Použití linků ve zprávách
Když přijmete textovou zprávu, která 
obsahuje telefonní číslo, emailovou 
adresu nebo URL, můžete vytočit 
číslo, poslat email nebo přejít na 
internetové stránky okamžitě. Váš 
smartphone automaticky otevře 
správnou aplikaci z linku.

1. Otevřete zprávu v Inboxu (přijaté) 
nebo v jiné složce.

2. Vyberte telefonní číslo, emailovou 
adresu nebo URL (objeví se jako 
modrý podtržený text).

Vymazání zprávy

1. Přejděte do Inboxu nebo jiného 
souboru obsahujícího zprávu, 
kterou chcete vymazat.

2. Zvýrazněte zprávu.

3. Stiskněte Delete  (levý 
softkey).

4. Vyberte Yes pro potvrzení vyma-
zání.

TIP Můžete vymazat otevřenou zprávu 

stisknutím Delete (left softkey).

Přizpůsobení 
nastavení zprávy
Mnoho nastavení použitých v 
emailových účtech se dají použít i u 
textových a multimediálních účtů. 
Pro instrukce o přizpůsobení těchto 
nastavení (viz Přizpůsobení emailo-
vých nastavení). 

Můžete přizpůsobit dodatečná na-
stavení pro textové a multimediální 
zprávy.

VĚDĚLI JSTE, ŽE? Volby, které vybe-
rete pro jednotlivou zprávu (viz. Nastavení 
voleb doručení textových zpráv a Nastave-
ní voleb doručení multimediálních zpráv). 
Tyto volby potlačí všeobecné preference 
pouze této zprávy. 
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Přizpůsobení nastavení texto-
vých zpráv

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Vyberte Messaging  potom 
stiskněte Text Messages.

3. Stiskněte Menu  (pravý softkey) 
a vyberte Tools > Options.

4. Vyberte Account Settings.

5. Vyberte jednu s následujících 
možností:

 Request delivery notificati-
ons: Specifikuje zda chcete obdr-
žet potvrzení o doručení zprávy.

 Use Unicode when neces-
sary: Automaticky kontroluje 
zprávy do Unicode jazyka pokud 
to přijímací zařízení kontroluje.

6. Stiskněte Done  (left softkey).

Přizpůsobení nastavení MMS

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Vyberte Messaging  potom 
vyberte MMS.

3. Stiskněte Menu  (pravý softkey) 
a vyberte MMS Settings.

4. Vyberte MMSC Settings a 
nastavte jednu z následujících 
možností. Stiskněte Done  
(levý softkey) pro dokončení.

 Profile Name: Signalizuje 
jméno vaší multimediální zprávy a 
servisního centra.

 MMSC: Signalizuje webovou 
adresu vaší multimediální zprávy 
a servisního centra.
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 Data Connections: Signalizuje 
typ datové sítě užívané pro multi-
mediální zprávu.

 Gateway: Signalizuje typ brány 
požívané pro multimediální zprávu.

5. Vyberte Send Options a nastav-
te některou z následujících voleb.     
Stiskněte Done  (levý softkey) 
pro ukončení.

 Priority: Signalizuje úroveň 
důležitosti odchozích zpráv.

 Validity Period: Signalizuje jak 
dlouhá zpráva zůstává k dispo-
zici pro odeslání pokud telefon 
příjemce nebo emailová zpráva 
nejsou dostupné v době kdy 
jste původně zprávu odesílali. 
Například pokud zprávy všeo-
becně obsahují informace, které 
nebudou odesílateli po hodině 
užitečné, můžete nastavit plat-
nost zprávy na 1 hodinu. Vyberte 

maximum pro umožnění zpráv 
zůstat dostupnými pro maximální 
časové období povolené vašim 
poskytovatelem bezdrátové sítě.

 Deffered Delivery: (Odložené 
doručení) Signalizuje zda chcete, 
aby bylo odesílání zprávy po urči-
tou dobu odložené.

 Massage Type: Specifikuje typ 
zprávy, kterou posíláte.

 Massage Size: Nastavuje maxi-
mální velikost zprávy, kterou mů-
žete odeslat. Neměňte velikost 
pokud nejste instruováni vaším 
poskytovatelem bezdrátové sítě.

 Delivery / Read report: 
Signalizuje, zda chcete obdržet 
potvrzení o doručení nebo přečte-
ní zprávy.

 Hide Sender: Specifikuje, zda 
chcete, aby zpráva obsahovala 
vaše telefonní číslo pro identifika-
ci vás jako odesílatele.

 Reply charging / Charging: 
Specifikuje zda chcete aplikovat 
účtování poplatku za odpověď na 
celou zprávu,  na textovou zprávu 
nebo vůbec.
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6. Vyberte Receive Options a 
nastavte některou z následují-
cích voleb. Stiskněte Done (levý 
softkey) pro dokončení.

 Home Reception: Signalizuje, 
zda jsou MMS stahovány automa-
ticky nebo po obdržení pobídky ke 
stažení MMS, když se nalézáte v 
domácí síti.

 Roaming Reception: Signa-
lizuje, zda multimediální zprávy 
jsou stažené automaticky nebo 
po obdržení pobídky ke stažení, 
když se nalézáte v roamingové 
zóně mimo domácí síť.

TIP Nastavení volby automatického 
stahování multimediální zprávy při roa-
mingu může vyústit ke zvýšení nákladů za 
roaming.

 Allowed Message Type: Speci-
fikuje, které druhy zpráv povolíte 
stahovat na váš smartphone.

 Reject Anonymous Messa-
ges: Specifikuje ty zprávy, jejichž 
odesílatel je skrytý a neměli by 
být stáhnuty na váš smartphone.

7. Vyberte General Options a 
potom vyberte kolikrát by se měl 
váš smartphone pokusit odeslat 
nebo přijmout zprávu než se obje-
ví error (chyba). Stisknete Done 

 (levý softkey) pro dokončení.
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TIP Vyberte About na obrazovce MMS 
nastavení pro podrobné zobrazení MMS 
softwaru.

TIP Můžete vložit standardní nastavení 
pro volby  v průběhu postupu stisknutím 
Menu (pravý softkey) a vybráním Resed 
To Default. Toto resetuje všechna 
nastavení právě zobrazené nabídky 
obrazovky.

8. Stiskněte Done  (pravý softkey).

Použití Windows Live
Windows Live je soubor služeb, který 
spojuje on-line vyhledávání, email a 
(instant messaging) bezprostředních 
zpráv:

Live Search: Umožňuje vyhledávat 
text na webu přímo z vašeho smart-
phonu.

Windows Live Mail: Příští genera-
ce Hotmailové internetové emailové 
aplikace. Windows Live Mail nabízí 
více místa větší zabezpečení zpráv a 
jednodušší evidenci zpráv.

Windows Live Messenger: 
Umožní vám vidět, kdo je on-line a 
vyměňovat si instantní messages 
(IM). Telefonovat s telefony, počítači 

(vč. videohovorů ) a vyměňovat si 
soubory a obrázky.

Použití Live Search
1. Stiskněte Home  a potom 

Start  (levý softkey).

2. Vyberte Windows Live  .

3. Do vyhledávací lišty v horní části 
obrazovky vložte text, který chce-
te vyhledat.

4. Stiskněte Center .

5. Z výsledků vyhledávání vyberte 
položku, kterou chcete. Pokud se 
položka kterou hledáte neobjeví, 
vyberte Refine pro změnu vlo-
ženého textu nebo vyberte More 
pro více vyhledávacích výsledků.

Nastavení Windows Live Mail
NEŽ ZAČNETE Pokud chcete 
používat Windows Live Mail musíte 
mít založený Hotmail účet. Pokud 
jej nemáte použijte webový prohlí-
žeč na vašem smartphonu, jděte na 
Hotmail.com a založte si dle instrukcí 
váš účet.

1. Stiskněte Home  a potom 
stiskněte Start  (levý softkey).
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 Pokud nezaškrtnete rámeček 
budou synchronizovány s vaším 
smartphonem pouze Windows 
Live emailové zprávy.

 Merge duplicate contacts: 
Zaškrtněte tento rámeček pokud 
chcete sloučit synchronizované 
Windows Live kontakty se zdvo-
jeným kontaktem, které jsou již v 
aplikaci kontaktů, takže se objeví 
pouze jeden záznam pro kontakt. 
Pokud tento rámeček nezaškrt-
nete objeví se záznam kontaktu v 
kontaktech dvakrát.

10. Stiskněte Next (levý softkey).
Začne synchronizace Windows 
Live emailů a kontaktů (pokud je 
vybráno). Po dokončení synchro-
nizace se messaging aplikace 
otevře ve Windows Live Inboxu. 

Používání Windows Live Mail

NEŽ ZAČNETE Ujistěte se, že je váš 
telefon zapnutý a že se nacházíte v 
oblasti mobilního pokrytí (viz, zapínání 
telefonu).

1. Stiskněte Home  a potom 
stiskněte Start  (levý softkey).

2. Vyberte Windows Live .

3. Pro synchronizaci emailů, kontaktů 
nebo Windows Live Messenger 
informací proveďte následující:• 

• Stiskněte Dolů   pro přesun 
zvýraznění přímo do pole pod Live 
Search lišty.

• Stiskněte Vpravo  nebo Vlevo 
 dokud se nezobrazí Sync.

• Stiskněte Center  informace 
je synchronizována se všemi 
aplikacemi, které jste vybrali v 
průběhu nastavení.

4. Pro čtení emailů proveďte následující:

• Ve stejném zvýrazněném poli 
stiskněte Vpravo  nebo Vlevo 

 dokud se neobjeví Mail.
• Stiskněte Center , Messaging 

aplikace se otevře na zobrazení 
Windows Live Inboxu. Můžete 
zobrazovat, posílat a pracovat se 
zprávami ve Windows Live účtu 
stejným způsobem jako se zprá-
vami z jiných účtů.
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TIP Zpřístupnit Windows Live Inbox mů-
žete také otevřením Messaging aplikace
a vybráním vašich Windows Live emailo-
vých účtu.

TIP Můžete si nastavit volbu, aby byly 
zprávy protlačeny na Windows Live Mail 
na vašem smartphonu, hned co přijdou na 
server. Otevřete Windows Live stiskněte 
Menu (pravý softkey), vyberte Options, 
vyberte Synch schedule, vyberte seznam 
Sync frequency a potom vyberte As items 
arrive.

Používání Windows Live 
Messengeru

NEŽ ZAČNETE 

• Pokud chcete používat Windows 
Live Mail musíte mít založený 
Hotmail účet. Pokud jej nemáte, 
použijte webový prohlížeč na 
vašem smartphonu, jděte na Hot-
mail.com a založte si dle instrukcí 
váš účet.

• Ujistěte se, že je váš telefon za-
pnutý a že se nacházíte v oblasti 
mobilního pokrytí (viz zapínání 
telefonu).

1. Stiskněte Home  a potom 
stiskněte Start  (levý softkey).

2. Vyberte Messenger .

3. Stiskněte Sign  (levý softkey).

4. Pokud ještě nemáte nastavený 
Windows Live Mail účet (viz. 
nastavení Windows Live Mail), 
při prvním přihlášení do Windows 
Live Messengeru, stiskněte Ac-
cept  (levý softkey).

5. Pokud budete vyzváni zadejte 
Hotmailovou emailovou adresu a 
heslo.

6. Pro posílání instant message (dále 
IM) kontaktu, který je on-line, zvý-
razněte jméno kontaktu a stiskně-
te Send IM  (levý softkey).
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TIP Pokud je kontakt, který chcete off-
line, pošlete raději emailovou zprávu. Zvý-
razněte jméno kontaktu a stiskněte Send 
e-mail (levý softkey). Vložte předmět a 
text emailové zprávy a potom stiskněte 
Send (levý softkey).

7. Proveďte jednu z následujících:

• Zvýrazněte textovou lištu a 
vložte text zprávy.

• Stiskněte Voice clip  (levý 
softkey) a nahrajte hlasovou 
poznámku, mluvte zřetelně a 
mějte smartphone natočený 
směrem k vám.

8. (volitelné) Pro přidání emoticon 
(smajlu) do zprávy, stiskněte 
Menu  (pravý softkey), vy-
berte Add emoticon a potom 
vyberte emoticon, který chcete.

9. (volitelné) Pro odeslání obrázku 
nebo jiného souboru stiskně-

te Menu  (pravý softkey), 
vyberte Send a potom vyberte 
typ souboru, který chcete poslat. 
Vyfoťte nebo vyberte obrázek 
nebo jiný soubor, který chcete.

10. (volitelné) Pro výměnu zpráv s 
více osobami stiskněte Menu 

 (pravý softkey) a vyberte 
Options > Add Participant. 
Vyberte účastníka, kterého chce-
te přidat.

11. Pro ukončení konverzace stisk-
něte Menu  (pravý softkey) 
a vyberte End conversation, 
pro ukončení konverzace s více 
účastníky najednou stiskněte 
End all conversations.

TIP Z obrazovky seznamu Messenger 
kontaktů stiskněte Menu (pravý softkey) 
a vyberte volby přidat nebo odstranit kon-
takt, změňte status na „Busy“ „Away“ 
atd., přidejte zobrazení obrázku nebo 
vlastní zprávu.

textová 
lišta
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Připojení k internetu
a bezdrátovým zařízením

Web můžete používat ke spoustě věcí, k nalezení směru jízdy, k získání 
zpráv, nakupování dárků a kontrolu emailů. Nyní s vaší bezdrátovou služ-
bou od poskytovatele sítě a Palm® Treo™ 500 smartphonem s interneto-
vým prohlížečem, můžete vzít web sebou téměř všude. 

Bluetooth® bezdrátová technologie na vašem smartphonu vám pomůže 
snadno nastavit bezdrátová spojení s řadou jiných zařízení, takže si budete 
moci užívat výhod bezdrátového spojení. Můžete také používat váš smart-
phone k připojení vašeho počítače k Internetu a sdílet kontakty nebo vaše 
oblíbené fotografie s ostatními lidmi.

VÝHODY:

·  Nosíte si web všude sebou.
·  Ukládáte webové stránky k off line prohlížení.
·  Připojíte Bluetooth náhlavní soupravu a autosadu.
·  Připojíte váš počítač k internetu přes váš smartphone.

KAPITOLA

8
N
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V této kapitole

Prohlížení webových stránek ................................................................. 147
Používání Google map ........................................................................... 152
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Použití vašeho zařízeni jako bezdrátového modemu ............................. 158
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Prohlížení webových stránek
Internet Explorer Mobile poskytuje 
rychlý a snadný přístup k webovým 
stránkám. Můžete zobrazit většinu 
webových stránek na vašem smart-
phonu, tak jako na počítači, včetně 
bezpečnostních a pokročilých funkcí 
jako např. JavaScript.

Internet Explorer Mobile podporuje 
JavaScript, Secure Sockets Layer 
(SSL), a cookies, ale nepodporuje 
pluginy (Flash, Shockwave, VBScript, 
WML script atd.) nebo Java applety.

VĚDĚLI JSTE, ŽE? Bezpečnostní certi-
fikáty a 128 bitů silné SSL kódování vám 
umožňuje prohlížet zabezpečené stránky, 
např. on-line nakupování, bankovnictví a 
email. Nezapomeňte, že některé zabezpe-
čené stránky požadují specifický prohlížeč 
a nemusí spolupracovat s Internet Explo-
rer Mobile. Zeptejte se organizace pro 
alternativní přístup, který je kompatibilní s 
Internet Explorer Mobile.

NEŽ ZAČNETE Proveďte následující: 

• Ujistěte se, že máte předplacenou 
datovou službu u poskytovatele bez-
drátových služeb. Toto je nutné pro 
prohlížení webu. 

• Ujistěte se, zda máte aktivní SIM kar-
tu vloženou do telefonu (viz. vkládání 
SIM karty a baterie), že je váš telefon 
zapnutý (viz. zapínání telefonu) a že se 
nacházíte v oblasti mobilního pokrytí.

Standardně Internet Explorer Mobile 
mění velikost obsahu stránky tak, aby 
vyhovoval obrazovce vašeho smart-
phonu, takže jste schopni vidět větši-
nu informací bez rolování po stránce.   

Zobrazení webových stránek

1. Stiskněte Home  a potom 
stiskněte Start  (levý softkey).

2. Vyberte Internet Explorer .

3. Stiskněte Menu  (pravý 
softkey) a vyberte Address Bar.

4. Vložte URL pro webovou strán-
ku, kterou chcete navštívit.

5. Stiskněte Go  (levý softkey).
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6. Stiskněte Menu  (pravý 
softkey), vyberte View a potom 
vyberte jednu z následujících:

 One Column: Uspořádá webo-
vou stránku do jednoho sloupce, 
širokého jako obrazovka smart-
phonu, takže nemusíte horizon-
tálně rolovat.

 Fit To Screen: Udržuje uspo-
řádání stránky podobné tomu na 
stolním počítači, ale zmenšuje 
položky a uspořádává obsah tak, 
aby jste viděli většinu info bez 
rolování po obrazovce.

 Desktop: Ponechává stejné roz-
vržení a velikost jako na počítači, 
což vyžaduje rolování po obrazov-
ce všemi směry.

 Full Screen: Skryje stavové a 
navigační oblasti a zaplní celou-
obrazovku webovou stránkou. 
Pro odchod z full screenu stisk-
něte pravý softkey .

 Show Pictures: Zobrazuje 
nebo skrývá obrázky na webo-
vých stránkách. Skrývání obrázků 
urychlí stahování webových 
stránek.

TIP Pokud nejste schopni prohlížet inter-
net, bude třeba,aby jste vložili nastavení 
sítě manuálně (viz.manuální nastavení 
síťového spojení).

Navigace po webových stránkách
Zde jsou rady pro prohlížení webových 
stránek a orientaci v nich:

• Pro zobrazení předchozí stránky 
stiskněte Back  nebo klávesu 
Zpět 

• Pro obnovení stránky nejnovějším 
obsahem z internetu, stiskněte 
Menu   (pravý softkey) a vyber-
te Refresh.

• Pro rolování po stránce ve sloupci 
nebo standardním nastavení, stisk-
něte Nahoru  nebo Dolů  .  

• V počítačovém zobrazení stiskněte 
Nahoru , Dolů  , Vlevo   
nebo Vpravo  pro rolování všemi 
směry.

• Pro sledování linku na další webo-
vou stránku stiskněte Nahoru  
a Dolů   pro zvýraznění textu a 
potom stiskněte Center  pro 
přechod do vybrané stránky.

• Pro odeslání emailu z webové 
stránky vyberte adresový link (spo-
jení).  

• Je třeba konfigurovat emailovou 
aplikaci na vašem smartphonu než 
můžete použít tuto funkci 
(viz. váš email).
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• Pro nastavení velikosti textu na 
webových stránkách stiskněte 
Menu  (pravý softkey), vyberte  
View > Text Size a potom 
vybere velikost.

• Pro zobrazení vlastností webo-
vých stránek, stiskněte Menu  
(pravý softkey) a vyberte Tools > 
Properties.

• Pro zobrazení každé položky v se-
znamu, vyberte seznam a rolujte 
po něm za použití Nahoru  a 
Dolů  .

• V seznamu stiskněte Vlevo  a 
Vpravo  pro pohyb mezi polož-
kami a potom stiskněte Center 

  pro přijetí volby.

• Ve formuláři např. v poli vyhle-
dávače stiskněte Center  pro 
interakci s formulářem a potom 
stiskněte Center  pro zastave-
ní interakce.

TIP Pro odeslání linku (spojení) stiskněte 
Menu (pravý softkey) a vyberte Tools > 
Send Link. Vyberte volbu pro odeslání 
linku - textovou zprávu, MMS (multimedi-
ální zpráva), Windows Live nebo emailový 
účet.

Vytvoření oblíbených 
Můžete vytvořit oblíbené webových 
stránek pro rychlý přístup k vašim 
nejnavštěvovanějším stránkám.

PŘEDTÍM NEŽ ZAČNETE Vytvořte 
složky, kde budete chtít ukládat vaše 
oblíbené. Když vytvoříte oblíbené, není 
možné je přemístit do jiné složky (viz. 
uspořádání oblíbených).

1. Přejděte na stránku, kterou chcete 
označit jako oblíbenou.

2. Stiskněte Menu  (pravý 
softkey) a vyberte Add to Favo-
rites.
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3. (volitelné) Vyberte Name a vlož-
te jiné pojmenování.

4. volitelné) Vyberte seznam Fol-
der a vyberte složku, kam chcete 
uložit oblíbené.

5. Stiskněte Add  (levý softkey).

TIP Pro vymazání složky oblíbených 
stiskněte Favorites (levý softkey),  zvý-
razněte položku pro vymazání, stiskněte 
Menu (pravý softkey) a potom vyberte 
Delete. Stiskněte Yes (levý softkey) pro 
potvrzení.

Zobrazení oblíbených

1. Stiskněte Home  a poté stisk-
něte Start  (levý softkey).

2. Vyberte Internet Explorer .

3. Stiskněte Favorites  (levý 
softkey).

4. Vyberte stránku, kterou chcete 
zobrazit nebo vyberte složku 
obsahující oblíbené.

Uspořádání oblíbených
Můžete vytvořit složky pro uspořádání 
oblíbených, například můžete uložit odka-
zy pro cestování v jedné složce, odkazy 
akcí v další a obchodní odkazy ve třetí.

1. Stiskněte Home  a poté stisk-
něte Start  (levý softkey).

2. Vyberte Internet Explorer  .

3. Stiskněte Favorites  (levý 
softkey).

4. Stiskněte Menu  (pravý 
softkey) a vyberte Add Folder.

5. Vložte jméno složky.

6. Stiskněte Add (levý softkey).

Stahování souborů a odkazů z 
webových stránek
Můžete stahovat soubory, které jsou 
použitelné na vašem smartphonu, 
například aplikace MIDI, vyzvánění a 
obrázky.

1. Přejděte na stránku která obsahu-
je odkaz pro soubor, který chcete 
stáhnout.
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2. Vyberte odkaz pro stahování 
souboru.

3. Vyberte Name a vložte nové 
jméno souboru.

4. Vyberte  seznam Folder a vyberte 
složku do které chcete soubor uložit.

5. Vyberte seznam Location a vyber-
te kam chcete složku uložit: Main 
memory nebo Storage card.

VĚDĚLI JSTE, ŽE? Volba storage card 
je možná jenom tehdy, máte-li vloženou 
rozšiřující kartu ve smartphonu.

6. Stiskněte Done  (levý softkey).

VĚDĚLI JSTE, ŽE? Můžete navštívit 
speciálně formátovaný streamingový 
obsah. Stiskněte Favorites (levý softkey) a 
vyberte WindowsMedia.com.

Návrat do nedávno prohlíže-
ných stránek
Seznam historie ukládá adresy 
stránek, které jste nedávno navštívili.
1. Stiskněte Menu  (pravý 

softkey) a vyberte History.

2. Vyberte webovou stránku, kterou 
chcete zobrazit.

Přizpůsobení nastavení Inter-
net Exploreru Mobile

1. Stiskněte Menu  (pravý 
softkey) a vyberte Tools > 
Options.

2. Vyberte General a nastavte 
některou z následujících vo-
leb. Stiskněte Done  (levý 
softkey) pro dokončení.

 Play sounds: Specifikuje zda 
váš smartphone přehrává nějaké 
zvuky spojené s webovou strán-
kou.

 Warn when changing to an 
unsecure page: Nastavuje jest-
li chcete být upozorněni zprávou, 
že přecházíte ze zabezpečených 
stránek na nezabezpečené.

 Allow cookies: Nastavuje zda 
chcete přijímat cookies.
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 Stránka posílá soubory a ukládá 
je na váš smartphone.

 Encoding: Nastavuje soubor 
znaků pro zobrazenou webovou 
stránku.

 Warn when page content is 
blocked by security set-
tings: Nastavuje to, zda chcete 
být upozorněni zprávou na to, 
že se pokoušíte otevřít stránku, 
která nevyhovuje bezpečnostním 
standardům vašeho smartphonu.

3. Vyberte Connections a na-
stavte některou z následujících 
voleb. Stiskněte  Done  (levý 
softkey) pro dokončení.

 Automatically detect set-
tings: Indikuje zda chcete, aby 
váš smartphone automaticky 
určil správné síťové nastavení pro 
připojení k internetu.

 Select network: Specifikuje 
druh sítě, ke které se chcete 
připojit.

4. Vyberte Memory, zvýrazněte 
jednu ze tří voleb: Temporary 
Files, Cookies nebo History 
a stiskněte Clear  (pravý 
softkey) pro vymazání vybraných 
souborů. Stiskněte Done  
(levý softkey) pro dokončení.

5. Stiskněte Done  (levý softkey).

Používání 
Google Map
S Google Maps můžete zobrazovat 
interaktivní mapy a opatřit si směry 
jízdy téměř kamkoli.
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POZNÁMKA 
V závislosti na vašem provozovateli 
bezdrátových služeb aplikace Google 
Maps nemusí být dostupná na vašem 
smartphonu.

1. Stiskněte Home  potom 
Start  (levý softkey).

2. Vyberte Google Maps .

TIP Navštivte www.google.com/gmm pro 
detailní informaci o používání Google Maps.

Připojení k zařízením 
s Bluetooth®

S Bluetooth® bezdrátovou technologií 
na vašem smartphonu se můžete 
připojit k mnoha Bluetooth zařízením 
například k náhlavním soupravám 
nebo hands-free auto sadě, tak jako k 
jiným telefonům, kapesním počíta-
čům a piconetům (počítačové síťové  
zařízení). Když se připojíte k jiným 
zařízením vytvoříte tak spolupráci 
(partnership) s tímto zařízením.

KLÍČOVÝ TERMÍN Partnership - Dvě za-
řízení např. váš smartphone a hands-free 
zařízení, která se spojí, protože mají stejné 
heslo. Poté co vytvoříte Partnership 
(spolupráci) se zařízením, není třeba znovu 
vkládat heslo pro spojení. 

Pokud váš počítač umožňuje Bluetoo-
th® bezdrátovou technologii, můžete 
také synchronizovat bezdrátově nebo 
použít telefon jako bezdrátový modem.

Můžete vytvořit seznam Bluetooth za-
řízení, kterým důvěřujete v komunikaci 
z vaším Smartphonem. Když komu-
nikujete s důvěryhodnými zařízeními 
smartphone přeskočí vyhledávací pro-
ces a vytvoří bezpečný odkaz, dokud 
je zařízení v dosahu. Dosah Bluetooth 
je za ideálních podmínek 10 metrů. 
Výkon a dosah je ovlivňován fyzikálními 
překážkami jako radiovou interferencí 
z blízkých elektronických zařízeních a 
dalšími faktory.

Když konfigurujete náhlavní soupravu 
(viz. připojení Bluetooth® hands-free
zařízení). Je automaticky přidána do 
seznamu důvěryhodných zařízení.
Následujte kroky v této části pro při-
dání dalších zařízení. Například vašeho 
počítače do seznamu důvěryhodných 
zařízení.
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VĚDĚLI JSTE, ŽE? Před vytvořením Blue-
tooth spojení zkontrolujte baterii, pokud je 
baterie téměř vybitá, není možné spojení 
vytvořit.

TIP Můžete vytvořit spojení s blízkou Blu-
etooth tiskárnou. Pro vytištění souboru, 
otevřete soubor, stiskněte Menu (pravý 
softkey a vyberte Print via Bluetooth v 
kterékoli aplikaci, která podporuje tuto 
funkci. 

Vložení základního nastavení 
Bluetooth

1. Stiskněte Home  potom 
Start  (levý softkey).

2. Stiskněte More  (levý 
softkey) a vyberte Settings .

3. Vyberte Connections a potom 
vyberte Bluetooth.

4. Stiskněte More  (pravý 
softkey) a vyberte Turn On 
Bluetooth.

5. Pokud chcete Bluetooth zaříze-
ním, která nejsou na seznamu 
důvěryhodných zařízení, umožnit 
požádat o spojení s vaším zaříze-
ním, stiskněte Menu  (pravý 
softkey) a vyberte Turn On 
Visibility. Vaše zařízení zůstává 
přístupné pro jiná zařízení dokud 

nestisknete Menu  (pravý 
softkey) a nevyberete Turn Off 
Visibility.

TIP Můžete nastavit vypínání viditelnos-
ti (visibility) automaticky po nastavení 
určitého časového období. (viz. pokročilé 
nastavení Bluetooth).

Stavová ikona Bluetooth
Ikona Bluethooth na vaší domácí 
obrazovce signalizuje stav funkce 
Bluetooth.
 

 
Požadování spojení s dalším 
Bluetooth zařízením

1. Stiskněte Home  potom 
Start  (levý softkey).

2. Stiskněte More  (levý 
softkey) a vyberte Settings .

 

Bluetooth je zapnutý.

Probíhá volání za použití Bluetooth 
náhlavní soupravy nebo autosady.

Hudební soubory jsou přehrávány 
přes Bluetooth náhlavní soupravu.
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3. Vyberte Connections a potom 
vyberte Bluetooth.

4. Stiskněte Menu  (pravý 
softkey) a vyberte Turn On 
Bluetooth.

5. Vyberte Add new device.

6. Vyčkejte než smartphone vyhledá 
zařízení a zobrazí jejích seznam.

7. Vyberte zařízení se kterým se 
chcete spojit a stiskněte Next 

 (levý softkey).

8. Vložte alfanumerické heslo od 1 
do 16 znaků a stiskněte Next  
(pravý softkey).

DŮLEŽITÉ Některá hands-free zaříze-
ní mají předdefinované heslo. Pokud 
má vaše zařízení předdefinované 
heslo, naleznete jej v dokumentaci 
zařízení. Jiná zařízení nabízí obrazov-
ku, kam vložíte heslo, které si vy-
tvoříte. V obou případech musíte do 
obou smartphonu i druhého zařízení 
použít  stejné heslo. Doporučujeme 
pokud možno vytvořit alfanumerické 
heslo ze 16 znaků (pouze z písmen a 
čísel) pro zvýšení bezpečnosti vašeho 
smartphonu. Čím delší je heslo tím 
složitější je jeho dešifrování.

TIP Na obrazovce do které vkládáte heslo 
je standardně nastaven Option Lock. 
Stiskněte Option pro vypnutí Option 
locku, pokud chcete vložit písmena.

9. Pokud není heslo  „vestavěno“, 
vložte stejné heslo i do druhého 
zařízení a stiskněte OK  (levý 
softkey). 

10. Vložte nové zobrazovací jméno 
pokud je vyžadováno a stiskněte 
Next  (levý softkey).
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11. (volitelné) Zaškrtněte rámeček u 
služby pro kterou chcete použít 
další Bluetooth zařízení.

12. Stiskněte Done  (levý 
softkey).

Nyní můžete komunikovat s tímto 
zařízením kdykoli je v dosahu a funk-
ce Bluetooth na vašem smartphonu 
jsou zapnuté. Dosah Bluetooth je 
ovlivňován faktory okolního prostředí 
Maximum dosahu je 10 m.
 
TIP Pro vymazání spolupráce (partner-
shipu) se zařízením, se přesuňte na obra-
zovku Bluetooth Device a zvýrazněte 
spojení, které chcete odstranit. Stiskněte 
Menu (pravý softkey) a vyberte Delete 
Stiskněte Yes (levý softkey) pro potvrze-
ní. Vymazané zařízení se již nemůže auto-
maticky připojovat k vašemu smartphonu.

Přijetí spojení s jiným Bluetoo-
th zařízením
NEŽ ZAČNETE 
Pro přípravu smartphonu k tomu, aby byl 
schopen přijmout spojení od žádajícího 
zařízení, vložte základní Bluetooth nasta-
vení (viz. Vložení základního nastavení 
Bluetooth).

1. Stiskněte Home  potom 
Start  (levý softkey).

2. Stiskněte MoreHome  
potom Start  (levý softkey) a 
vyberte Settings .

3. Vyberte Connections a potom 
vyberte Bluetooth.

4. Stiskněte Menu  (pravý 
softkey) a vyberte Turn On 
Bluetooth.

5. Pokud jste již v minulosti nastavili 
spolupráci s přenosovým zaříze-
ním, váš smartphone je připraven 
k přijímání informací. Pokud jste 
spolupráci nenastavili, stiskně-
te Menu  (pravý softkey) a 
vyberte Turn On Visibility pro 
umožnění zařízení vyhledat váš 
smartphone.

6. Pokud budete vybídnuti k vložení 
zařízení stiskněte Yes.

7. Vložte stejné heslo do smartpho-
nu i Bluetooth zařízení.

8. (volitelné) Pro účelné pojmenová-
ní spolupráce s daným zařízením 
stiskněte Display Name a 
vložte nové jméno. 
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9. Stiskněte Done (levý softkey).

10. Když váš smartphone přijímá 
informace, oznámení vám sdělí, 
že probíhá přenos. Pro zastavení 
přenosu stiskněte Cancel (pravý 
softkey). Pro zavření oznámení 
stiskněte Hide (levý softkey).

Vložení pokročilého nastavení 
Bluetooth
Můžete použít Bluetooth profil k 
vložení nastavení pro přenos snímků, 
připojit se k Bluetooth tiskárně a více.

1. Stiskněte Home  potom 
Start  (levý softkey).

2. Stiskněte More  (levý 
softkey) a vyberte Settings .

3. Vyberte Connections a potom 
vyberte Bluetooth Profiles.

4. Vyberte jednu z následujících 
možností a stiskněte Done  
(levý softkey) pro dokončení.

 File Transfer: Umožní vám 
specifikovat, kam chcete uložit 
přijaté informace z Bluetooth 
spojení. Můžete také vybrat jestli 
váš smartphone bude vyžadovat 
po serveru autorizační pověření.

 Images: Umožní vám specifiko-
vat, kam chcete uložit přijaté infor-
mace z Bluetooth spojení. Můžete 
také vybrat, jestli váš smartphone 
bude vyžadovat po serveru autori-
zační pověření. A jestli se obrázky 
po dokončení přenosu automatic-
ky otevřou a budete-li požadovat 
miniatury od přenesených obrázků.

 Security: Specifikuje dobu, po 
které se smartphone vrátí zpět ze 
stavu kdy byl viditelný pro ostatní 
zařízení do skrytého.

 Printer: Umožňuje vám zvlád-
nout tisk na Bluetooth tiskárně.
Pokud vyberete tuto volbu může-
te provést následující:

• Pokud jste vytvořili spojení 
s Bluetooth tiskárnou, ale ta 
se nezobrazuje na obrazovce, 
stiskněte Menu  (pravý 
softkey) a stiskněte Refresh. 

• Pro zobrazení právě probíha-
jícího tisku, stiskněte Menu

 (pravý softkey) a vyberte 
Status. Pro zrušení tisku na 
obrazovce managera tisku, 
stiskněte Menu ( pravý 
softkey) a vyberte Cancel 
Jobs.



158

Identification: Umožní vám vložit 
jméno pro váš smartphone a vybrat 
si jestli jej chcete použít jako jméno 
Bluetooth zařízení.

5. Stiskněte Done  (levý softkey).

Použití vašeho zařízení 
jako bezdrátového 
modemu

Internet Connection Sharing (ICS) 
je funkce, která promění váš 
smartphone v modem a vy můžete 
mít přístup na internet z vašeho 
počítače.

Internet Connection Sharing můžete 
nastavit dvěma způsoby:

• Připojte smartphone k počítači 
pomocí USB synchronizačního 
kabelu.

• Pokud je váš počítač vybaven 
bezdrátovou Bluetooth techno-
logií, nastavte smartphone jako 
bezdrátový modem.

Nastavení spojení USB Internet 
Connection Sharing 

1. Stiskněte Home  potom 
Start  (levý softkey).

2. Stiskněte  2x More  (levý 
softkey) a vyberte Internet 
Sharing 

y
.

3. Vyberte seznam PC Connecti-
on a potom vyberte USB.

4. Stiskněte Connect  (levý 
softkey).

5. Na počítači otevřete webový 
prohlížeč pro potvrzení, že jste 
připojeni k internetu.

Vytvoření spojení Bluetooth 
Internet Connection Sharing
• Ujistěte se, že je váš smartphone 

viditelný (viz. Vložení základního 
nastavení Bluetooth).

• Vytvořte spolupráci mezi vaším 
smartphonem a počítačem.

• Doporučujeme zahájit spolupráci 
ze smartphonu. (viz. požadování    
spojení s jiným Bluetooth zaříze-
ním).

1. Na počítači 2x klikněte na ikonu 
Bluetooth Connections pro 
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otevření okna. Zkontrolujte do-
kumentaci obsaženou ve vašem 
počítači pro instrukce.

2. Vyberte volbu pro zobrazení 
zařízení v dosahu.

3. Měli byste uvidět ikonu repre-
zentující váš smartphone. Dvojím 
kliknutím na tuto ikonu se ujis-
těte, že Network Access Point 
nebo něco podobného se objeví 
v seznamu služeb Bluetooth.

TIP Nevidíte ikonu smartphonu v sezna-
mu služeb? Zkontrolujte dokumentaci v 
počítači nebo kontaktujte výrobce počíta-
če pro pomoc. Různé modely  počítačů 
užívají odlišné názvosloví pro funkce 
Bluetooth spojení.

4. Stiskněte Home  potom 
Start  (levý softkey).

5. Stiskněte More  (levý 
softkey) a vyberte  Internet 
Sharing 

y
.

6. Vyberte seznam PC Connecti-
on a vyberte Bluetooth PAN.

POZNÁMKA Ponechte standardní 
nastavení na seznamu Network 
Connection.

 7. Stiskněte Connect (levý softkey) 
a následujte průvodce pro nasta-
vení Internet Sharingu.

8. Na vašem počítači následujte 
kroky pro přijetí nebo umožnění 
spojení Bluetooth PAN s vaším 
smartphonem. Pro instrukce 
nahlédněte do dokumentace ve 
vašem počítači.

9. Pokud došlo ke spojení na vašem 
počítači, otevřete internetový 
prohlížeč pro ověření, že se mů-
žete připojit k internetu.
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Vaše fotografie, 
videa a hudba

Máte peněženku přeplněnou fotografiemi přátel, rodiny, domácích 
mazlíčků a vaší poslední dovolené? 

Jste už unavený z nošení vašeho MP3 přehrávače i telefonu? 

Váš Palm® Treo™ 500 smartphone řeší oba problémy. Můžete mít vaše 
oblíbené fotografie, videa také přímo na vašem smartphonu. A není 
třeba nosit drahé MP3 přehrávače, protože můžete poslouchat hudbu na 
smartphonu. Jednoduše přeneste hudbu na smartphone nebo rozšiřující 
kartu a potom poslouchejte přes stereo sluchátka (karty a sluchátka jsou 
v prodeji samostatně).

VÝHODY:
·  Nikdy se příliš nevzdálíte od vašich oblíbených lidí, míst a hudby.
·  Uspořádáte si fotky, videa a hudbu.
·  Vyhnete se nošení jednotlivých prohlížečů fotografií, MP3 a CD přehrávačů 

nebo mini disků.

KAPITOLA

9
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Synchronizace 
mediálních souborů
Můžete synchronizovat obrázky, videa 
a hudební soubory mezi vaším smart-
phonem a počítačem tak, že změny, 
které vytvoříte se objeví jak v počítači 
tak i ve smartphonu. Pro synchronizaci 
mediálních souborů, musíte nejprve 
vybrat média jako jednu z voleb syn-
chronizace na smartphonu  (viz. Výběr 
aplikací k synchronizaci)

Postup synchronizace mediálních sou-
borů je různý pro počítače s Windows 
XP a počítače s Windows Vista.

Synchronizace mediálních sou-
borů:  Windows XP
NEŽ  ZAČNETE Musíte instalovat 
ActiveSync® desktop software dostupný z 
linku na Windows Mobile Getting Started 
CD (viz. Instalace ActiveSync® desktop 
softwaru:  Windows XP) a vyberte volbu 
pro synchronizaci médií (viz. Výběr aplikací 
k synchronizaci).

Když synchronizujete smartphone, 
vaše obrázky a videa jsou synchroni-
zovana mezi vaším smartphone a po-
čítačem. Na vašem počítači si můžete 

prohlížet obrázky a videa a můžete 
je také poslat přátelům použitím vaší 
počítačové emailové aplikace.

Pro vyhledání všech synchronizo-
vaných obrázků a videí na vašem 
počítači se podívejte do C:\Docu-
ments and Settings\<Username>\My 
Documents\Treo My Documents.

Použijte Windows Media Player pro 
synchronizaci hudebních souborů 
(viz. Přenášení mediálních souborů na 
smartphone). 

Synchronizace mediálních sou-
borů: Windows Vista
NEŽ  ZAČNETE Musíte instalovat Win-
dows Mobile Device Center dostupný z 
linku na Windows Mobile Getting Started 
CD (viz. instalace Windows Mobile Device 
Center: Windows Vista) a vyberte volbu 
pro synchronizaci médií (viz. Výběr aplikací 
k synchronizaci).
 
Na počítači s Windows Vista používejte 
Windows Media Player pro synchro-
nizaci smartphonu se všemi typy 
mediálních souborů: obrázků, videí a 
hudebních souborů. 
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Fotoaparát
Zpřístupnění obrázků na počí-
tači s Windows XP 
(viz synchronizace mediálních soubo-
rů: Windows XP).

VĚDĚLI JSTE, ŽE? Obrázky jsou zachy-
ceny a uloženy v 16-ti bitových barvách a 
JPG formátu. V nízkém nastavení rozlišení 
v rozsahu od 96 x 72 pixelů k vysokému 
do 1600 x 1200 pixelů. Můžete změnit 
standardní nastavení pro detaily (viz. 
Přizpůsobení nastavení fotoaparátu).

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Vyberte Pictures & Videos .

3. Vyberte Camera.

TIP Pokud uvidíte ikonu videokamery pod 
náhledem obrázku, je režim videa zapnu-
tý. Pro znehybnění videa stiskněte Menu 
(pravý softkey) a vyberte Still.

4. Nastavujte pozici vašeho smartpho-
nu dokud neuvidíte předmět, který 
chcete fotografovat na obrazovce.

5. (volitelné) Nastavte kterýkoli z 
následujících: 

 Zoom: Stiskněte Nahoru  
pro přiblížení nebo Dolů   pro 
oddálení.

 Brightness (jas): Stiskněte 
Menu  (pravý softkey), vyberte 
Brightness a vyberte úroveň jasu. 
Resolution: Stiskněte Menu 

 (pravý softkey), vyberte Reso-
lution a vyberte úroveň kvality 
obrazu.

6. (volitelná) Nastavte pětisekundo-
vý časovač: Stiskněte Menu  
(pravý softkey) a vyberte Mode 
> Timer.

7. Stiskněte Center  pro zachy-
cení obrázku nebo odstartování 
časovače.

8. Držte váš smartphone v klidu 
dokud nezachytíte obrázek. 
Pro zajištění zachycení obrázku 
vyčkejte než uslyšíte zvuk clony.
Poté proveďte následující:
• Stiskněte Camera  (levý 

softkey) a vyfoťte další obrázek.
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• Stiskněte Back  a potom 
stiskněte Thumbnails  
(levý softkey) pro návrat do 
zobrazení miniatur obrázku.

VĚDĚLI JSTE, ŽE? Po třech minu-
tách nečinnosti při prohlížení obrázků 
přejde  fotoaparát do úsporného režimu. 
Stisknutím libovolné klávesy se vrátíte k 
obrazovému náhledu.

Fotografování v sekvenčním 
režimu
Sekvenční režim fotí obrázky v 
rychlém sledu stisknutím jednoho 
tlačítka.

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Vyberte Pictures & Videos .

3. Vyberte Camera.

4. Stiskněte Menu  (pravý softkey) 
a vyberte Mode>Burst.

5. Stiskněte Center .

Nahrávání videa
Videa mohou mít jakoukoli délku za 
předpokladu, že máte dost
dostupného prostoru pro ukládání. 

Standardně jsou videa uložená ve 
složce My Pictures na vašem smart-
phonu. Pokud chcete ukládat videa 
na rozšiřující kartu čtěte (viz. Přizpů-
sobení nastavení fotoaparátu) pro 
změnu uložení videí. Pro informaci o 
zpřístupnění videí na vašem Win-
dows XP počítači  (viz.synchronizová-
ní mediálních souborů: Windows XP).

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Vyberte Pictures & Videos .

3. Vyberte Camera.

4. Stiskněte Menu  (pravý 
softkey) a vyberte Video
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5. Nastavte pozici vašeho smartpho-
nu dokud nevidíte předmět, který 
chcete zaznamenat na obrazovce.

6. (volitelné) Nastavte jednu nebo 
obě z následujících možností:

 Brightness (jas): Stiskněte 
Menu  (pravý softkey), vyber-
te Brightness a vybere úroveň 
jasu.

 Resolution: Stiskněte Menu 
, vyberte Quality a potom 

vyberte rozlišení videa.

7. Stiskněte Center  pro začátek 
záznamu.

8. Když jste skončili nahrávání, 
stiskněte Stop  (levý softkey) 
nebo Center  pro zastavení 
nahrávání.

9. (volitelné) Pro prezentaci videa ve 
Windows Media Player Mobi-
le stiskněte Thumbnails  
(levý softkey), zvýrazněte video 
a potom stiskněte Center  
Stiskněte Back  pro návrat 
zobrazení miniatur.

TIP Pokud se vám nelíbí video, které jste 
zaznamenali, vymažte jej. (viz. Vymazání 
obrázku nebo videa).

VĚDĚLI JSTE, ŽE? Po třech minu-
tách nečinnosti při prohlížení obrázku, 
přejde fotoaparát do úsporného režimu. 
Stisknutím libovolného tlačítka se vrátíte 
k obrazovému náhledu. Pokud přejde 
fotoaparát do úsporného režimu, zatímco 
je nahrávání pozastaveno (pauza), je obra-
zový záznam zastaven a uložen.

Přizpůsobení nastavení fotoa-
parátu
1. Stiskněte Home  potom Start 

 (levý softkey).
2. Vyberte Pictures & Videos .
3. Stiskněte Menu  (pravý 

softkey) a vyberte Options
4. Vyberte General a nastavte 

jednu nebo obě z následujících 
voleb: Stiskněte Done  (levý 
softkey) pro ukončení.
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 When sending pictures in 
e-mail, use this size: Nastavu-
je velikost obrázků, které pošlete 
v emailové zprávě.

 When rotating a picture, 
rotate 90 degrece: Nastavuje 
směr ve kterém se obrázky točí.

5. Vyberte Slide Show a nastavte 
jednu nebo obě z následujících 
voleb: Stiskněte Done  (levý 
softkey) pro dokončení.

 During slide shows, optimi-
ze for viewing: Nastavuje zda 
jsou obrázky optimalizované pro 
portrét nebo horizontální formát 
stránky během prezentace. 

 Play screensaver when 
connected to my PC and 
idle for 2 minutes: Nastavuje 
zda budou obrázky ze složky My 
Picture použity jako šetřič obra-

zovky při připojení k PC pokud 
nebude spuštěna synchronizace.

6. Vyberte Camera a nastavte 
některou z následujících voleb: 
Stiskněte Done  (levý softkey) 
pro dokončení. 

 Save Files to: Specifikuje zda 
jsou obrázky a videa uloženy na 
smartphonu nebo na rozšiřující kar-
tě. Volba rozšiřující karty je možná 
pouze pokud máte rozšiřující kartu 
vloženou ve smartphonu.

 File name prefix: Přiřadí jméno 
k sériím zachycených obrázků, 
např. Seattle001, Seattle002, atd. 
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 Still image compression 
level: Nastavuje standardní kva-
litu a velikost pro nově chycené 
obrázky.

7. Vyberte Video a nastavte jednu 
nebo obě z následujících voleb:  

 Stiskněte Done  (levý softkey) 
pro dokončení.

 Include audio when recor-
ding video files: Nastavuje 
zapnutí a vypnutí mikrofonu pro 
zaznamenání videa se zvukem 
nebo bez. 

 Time limit for video: Na-
stavuje délku videa, které vy 
zaznamenáte.  Můžete vybrat 
volbu No limits (bez omezení).

Obrázky & videa
Prohlížení obrázků
Kromě prohlížení obrázků zachy-
cených zabudovanou kamerou, si 
můžete prohlížet i obrázky zachycené 
mnoha digitálními fotoaparáty nebo 
stáhnuté obrázky z Internetu.  
Váš smartphone podporuje následují-
cí formáty:

• JPG

• PNG

• BMP

• GIF

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Vyberte Pictures & Videos .

3. Vyberte obrázky, které chcete 
prohlížet.

4. Stisknutím Back  se vrátíte 
do miniatur obrázků.

Prohlížení videa
Kromě prohlížení videa, které zachytí-
te zabudovaným fotoaparátem, 
si můžete prohlížet i videa zachycená 
na mnoha digitálních fotoaparátech 
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nebo stažených z websajtů.  
Váš smartphone podporuje a stahuje 
následující typy video souborů:

• MPEG 4

• 3GPP2

• 3GPP

• WMV, WMA, ASF

• RTSP Streaming

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Vyberte Pictures & Videos .

3. Vyberte video, které chcete prohlížet.

4. Stisknutím Back  se vrátíte 
do miniatur obrázků.

Prohlížení prezentace 

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Vyberte Pictures & Videos .

3. Stiskněte Menu  (pravý 
softkey) a vyberte Play Slide 
Show. Prezentace se spustí 
automaticky.

4. Stiskněte Back  pro zastavení 
prezentace a pro návrat do zobra-
zení miniatur.

Posílání obrázků nebo videí
Můžete poslat obrázek nebo video ji-
ným zařízením schopným přijímat ob-
rázky např. jinému smartphonu nebo 
na emailovou adresu jako přílohu.

Nemůžete poslat obrázky chráněné 
autorským právem nebo ty, které se 
zobrazí s ikonou zámku na miniatuře.

1. Zvýrazněte obrázek nebo video, 
které chcete poslat.

2. Stiskněte Menu  (pravý 
softkey) a vyberte Send.

3. Vyberte volbu, kterou chcete 
použít pro odeslání obrázku nebo 
videa, emailový účet nebo MMS.

4. Když se otevře aplikace Messa-
ging, adresujte a odešlete zprávu.    
(viz vytvoření a odeslání emailové 
zprávy nebo vytvoření a odeslání 
MMS).
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TIP Můžete také odesílat obrázky nebo 
videa použitím Bluetooth® bezdrátové 
technologie na smartphonu dalšímu 
blízkému Bluetooth zařízení. Zvýrazněte 
obrázek nebo video, stiskněte Menu 
(pravý softkey) a vyberte Beam. Vyberte 
přijímající zařízení a stiskněte Beam (levý 
softkey).

Vytváření nové složky pro ulo-
žení obrázků a videí
Můžete vytvořit složky k tomu, aby jste 
mohli uspořádat vaše obrázky a videa.
Například můžete ukládat položky z 
výletů v jedné složce a položky prázd-
ninové v jiné.

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Vyberte Pictures & Videos .

3. Stiskněte Menu  (pravý 
softkey) a vyberte Edit > New 
Folder.

TIP Můžete se přesunout do složky a 
přejmenovat ji potom co ji vytvoříte.
(viz. Prozkoumání souborů a složek).

Uspořádávání obrázků a videí
Můžete přesouvat nebo kopírovat 
obrázky a videa do dalších složek
nebo také mezi smartphonem a 
rozšiřující kartou.
1. Zvýrazněte obrázek nebo video, 

které chcete přesunout nebo 
kopírovat.

2. Proveďte jednu z následujících 
voleb:
• Pro přesunutí obrázku nebo 

videa na jiné místo, stiskněte 
Menu  (pravý softkey) a 
vyberte Edit > Cut.

• Pro ponechání obrázků nebo 
videí ve dvou lokalitách, stisk-
něte Menu  (pravý softkey) 
a vyberte Edit > Copy.

3. Stiskněte Menu  (pravý 
softkey), vyberte Folders a 
potom vybere složku, kam chcete 
zkopírovat obrázek nebo video. 
Potom co vyberete složku, 
můžete ji přesunout do podřízené 
složky uvnitř jiné.

TIP Pokud máte rozšiřující kartu vloženou 
ve smartphonu, vyberte Storage Card pro 
vložení obrázků nebo videí do karty.

4. Stiskněte Menu  (pravý 
softkey) a vyberte Edit > Paste.
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Používání obrázku jako pozadí 
domovské obrazovky
1. Vyberte obrázek, který chcete použít.

2. Stiskněte Menu  (pravý softkey) 
a vyberte Use as Home Screen.

3. Pokud budete vyzváni, stiskněte 
Nahoru  nebo Dolů   pro 
nastavení části obrázku, který se 
objeví na domovské obrazovce a 
stiskněte Next  (pravý softkey).

4. Stiskněte Vpravo  nebo Vlevo 
 a vyberte úroveň prolínání. 

Použijte vyšší procento pro více 
transparentní obraz a nižší pro-
cento pro matnější obraz.

5. Stiskněte Done  (pravý 
softkey).

Úprava obrázku
Pro rozsáhlejší editace stáhněte obrázek 
nebo video na váš počítač a editujte jej 
ve vašem oblíbeném grafickém progra-
mu. Potom synchronizujte obrázek nebo 
video zpět do vašeho smartphonu.

1. Vyberte obrázek, který chcete 
editovat.

2. Stiskněte Menu  (pravý 
softkey) a vyberte Edit.

3. Proveďte některou z následujících voleb:
• Pro otočení obrázku o 90 stup-

ňů, stiskněte Menu  (pravý 
softkey) a vyberte Rotate.

• Pro ořezání obrázku, stiskněte 
Menu  (pravý softkey) a vyber-
te Crop. Přesuňte se do horního 
levého rohu plochy, kterou chcete 
oříznout a stiskněte Center 
Přesuňte se do dolního pravého 
rohu plochy, kterou chcete oříznout 
a stisknutím Center  ořízněte 
obrázek. 

• Pro nastavení úrovně jasu a kon-
trastu obrázku, stiskněte Menu 

 (pravý softkey) a vyberte 
Auto Correct.

• Pro zrušení úpravy, stiskněte 
Menu  (pravý softkey) a vyber-
te Cancel.

• Pro zrušení veškerých neulože-
ných úprav, které jste provedli 
na obrázku, stiskněte Menu  
(pravý softkey) a vyberte Cancel.

• Pro uložení upraveného obrázku 
s novým jménem souboru,  stisk-
něte Menu  (pravý softkey) 
a vyberte Save As, vložte nové 
jméno obrázku a potom stiskněte 
Done  (levý softkey).
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Vymazání obrázku nebo videa
1. Zvýrazněte obrázek nebo video, 

které chcete  přejmenovat.

2. Stiskněte Menu  (pravý 
softkey) a vyberte Delete.

3. Vyberte Yes  (levý softkey) 
potvrďte vymazání.

Přejmenování obrázku nebo 
videa
1. Vyberte obrázek nebo video, 

které chcete přejmenovat.

2. Stiskněte Menu  (pravý 
softkey) a vyberte Properities.

3. Zadejte nové jméno obrázku nebo 
videa.

4. Stiskněte Done  (levý 
softkey).

Windows Media 
Player Mobile
Windows Media Player Mobile může 
přehrávat hudbu, zvukové a video 
soubory, které jsou uložené ve vašem 
smartphonu nebo na rozšiřující kartě 

(v prodeji samostatně), v kterémkoli z 
následujícím formátu souboru:

• WMA

• WMV

• MP3

• 3GP

• AAC

• AAC+

• MPEG 4

VĚDĚLI JSTE, ŽE? Můžete také stáh-
nout animované GIF soubory a prohlížet si 
je v Internet Explorer Mobile.

DŮLEŽITÉ Musíte mít QuickTime 
Player verzi 6.5 nebo novější instalova-
nou na vašem počítači pokud chcete 
přehrávat videa zaznamenaná na vašem 
smartphonu. 

Můžete stahovat videa z rozšiřující karty 
nebo kliknout na miniaturu videa po 
synchronizaci souborů.

Můžete poslouchat hudební, zvukové a 
video soubory z reproduktoru umís-
těného na zadní straně smartphonu 
nebo přes stereo sluchátka (v prodeji 
samostatně).
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Přenos souborů na Váš smartphone
6. Klikněte na Finish pro zahájení 

přenosu. Pokud přenášíte sou-
bory na rozšiřující kartu, mějte 
strpení, převedení mediálních 
soubory na rozšiřující kartu může 
zabrat i několik minut.

TIP Můžete také přenášet mediální sou-
bory z Windows XP počítače manuálně. 
Dvojím kliknutím na ikonu ActiveSync 
na nástrojové liště se otevře okno soft-
waru ActiveSync. Vyberte Explore a 
potom tahem přesuňte mediální soubory 
na ikonu představující váš smartphone. 
Aktualizujte knihovnu ve Windows Media 
Playeru na vašem smartphonu a dokonče-
te přenos (viz. Práce s knihovnami).

TIP Další snadná cesta jak manuálně 
přenést mediální soubory je kopírovat je na 
rozšiřující kartu. Vložte kartu do smartpho-
nu (viz. Vložení a vyjmutí rozšiřujících karet) 
a potom aktualizujte knihovnu (viz. Práce 
s knihovnami) tak, aby Windows Media 
Player mohl zpřístupnit soubory na kartě.

Přehrávání médiálních souboru 
na smartphonu

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 

a vyberte Windows Media .

3. Pokud se nezobrazí obrazovka 
knihovny, stiskněte Menu (pravý 
softkey), vyberte Library a potom 
vybere knihovnu obsahující sou-
bor, který chcete poslouchat.

TIP Pro přehrávání souboru, který není v 
knihovně, přejděte na obrazovku knihov-
ny, stiskněte Menu (pravý softkey) a 
potom vyberte Open File.

4. Vyberte kategorii obsahující medi-
ální soubor, který chcete přehrát. 
Pokračujte ve výběru dokud se 
neobjeví seznam jednotlivých 
položek (videa, písně, alba nebo 
jména interpretů).

TIP Pokud nemůžete najít položku, kterou 
chcete, aktualizujte knihovnu (viz. Práce 
s knihovnami) mezi vaším smartphone a 
počítačem.
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5. Vyberte položku, kterou chcete 
přehrát (např. video, píseň, album 
nebo jméno interpreta).

6. Stiskněte Play  (levý softkey).

7. Stiskněte Menu  (pravý 
softkey) a vyberte kteroukoli z 
následujících možností během 
přehrávání:

 Library: Zobrazuje obrazovku 
knihovny tak, aby jste si mohli 
vybrat různé písně nebo videa pro 
přehrávání.

 Play/Pause: Přehrává nebo 
přerušuje přehrávání souboru.

 Shuffle/Repeat > Shuffle: 
Přehrávání z playlistu v náhodném 
pořadí. Pokud je zapnuto objeví se 
vedle příkazu značka odškrtnutí.

 Shuffle/Repeat > Repeat: 
Přehrává playlist opakovaně. 
Pokud je zapnuto objeví se vedle 
příkazu značka odškrtnutí.

 Full Screen: Zobrazuje video 
na celé obrazovce. Pro výchozí 
zobrazení stiskněte Back .

 Options: Nastavuje volby včetně 
sítě a hardwarové tlačítkové volby.

TIP Pro podrobné informace o tracku, 
který se přehrává, stiskněte Menu (pravý 
softkey) a vyberte Properties.

Použijte některý z následujících 
ovládacích prvků obrazovky během 
přehrávání:

 Center : přerušuje nebo zapí-
ná přehrávání souboru.

 Vlevo : přeskakování na začá-
tek souboru nebo do předchozího 
souboru.

 Vpravo : Přeskakování na další 
soubor.

 Volume Button: Zvyšuje nebo 
snižuje hlasitost.

VĚDĚLI JSTE, ŽE? Můžete přehrá-
vat streamingové soubory z webu. 
Pro přehrávání MMS (Microsoft Media 
Streaming) souborů, stiskněte Menu v 
obrazovce knihovny a vybere Open URL. 
Vyberte URL a vložte adresu websajtu 
nebo vyberte History a sajt, který jste 
navštívili již dříve.

VĚDĚLI JSTE, ŽE? Pokud zavřete okno 
Windows Media Player Mobile, přehrává-
ní hudby pokračuje na pozadí.
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Práce s knihovnami
Knihovna představuje místa uložení 
dostupných souborů ve Windows Media 
Player Mobile, takže byste měli mít dvě 
knihovny: My Device a pokud jste zakou-
pili a vložili rozšiřující kartu My Storage 
Card. Každá knihovna obsahuje linky 
k mediálním souborům v místě jejich 
uložení. Windows Media Player Mobile 
obvykle aktualizuje My Device knihovnu 
automaticky, ale knihovnu My Storage 
Card musíte aktualizovat manuálně.

TIP Pokud se nezobrazí mediální soubor, kte-
rý jste přidali, manuálně aktualizujte knihovnu.

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Windows Media  .

3. Stiskněte Menu  (pravý 
softkey) a vyberte Library.

4. Stiskněte Menu  (pravý softkey) 
a vyberte Update Library.

5. Vyčkejte přidání souborů a potom 
stiskněte Done  (pravý softkey).

TIP Pro výmaz položky z knihovny, zvýrazně-
te položku, stiskněte Menu (pravý softkey) 
a vyberte Delete from Library. Stiskněte Yes 
(levý softkey) pro potvrzení výmazu.

VĚDĚLI JSTE, ŽE? Pokud přesunujete 
soubory mezi smartphonem a rozšiřující 
kartou, ujistěte se, že jste aktualizovali 
vaši knihovnu nebo nebudete schopní 
vidět soubory v jejich novém umístění.

Práce s playlisty
Playlist je seznam mediálních soubo-
rů, které jsou přehrávány v určeném 
pořadí.  Playlisty můžete použít pro 
rozdělení zvukových souborů do sku-
pin nebo pro sloučení video souborů 
pro pohodlné přehrávání. Například na 
počítači ve Windows Media Playe-
ru můžete vytvořit playlist pozitivní 
hudby na dobu, kdy cvičíte a playlist 
příjemných písní pro dlouhý let. 
Když synchronizujete vaše oblíbené 
playlisty jsou automaticky kopírovaní 
na smartphone. Playlisty se objeví 
ve vašich knihovnách (v kategorii My 
Playlists).

Dočasný playlist nazvaný Now Playing 
se objeví v menu Now Playing.Tento 
řadí aktuálně přehrávané soubory a 
také soubory pro příští přehrávání 
čekající ve frontě. Můžete přidávat, 
upravovat nebo vyprazdňovat soubo-
ry na Now Playing playtech.
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1. Přejděte do Now Playing obrazovky:

• Pokud jste na obrazovce knihovny 
vyberte Now Playing.

• Pokud jste na obrazovce Playback 
vyberte Now Playing.

2. Vyberte z následujících možností:

• Pro posunutí souboru nahoru 
nebo dolů o jednu pozici, zvýraz-
něte soubor, stiskněte Menu  
(pravý softkey) a potom vyberte 
Move Up nebo Move Down.

• Pro přidání souboru, zvýrazněte 
soubor, stiskněte Menu  
(pravý softkey) a vyberte Libra-
ry. Zvýrazněte soubor, stiskněte 
Menu  (pravý softkey) a 
potom vyberte Queue Up.

• Pro výmaz souboru z playlistu, 
zvýrazněte soubor, stiskněte 
Menu  a vyberte Remove 
from Playlist.

• Pro zobrazení více informací o 
souboru, zvýrazněte soubor, 
stiskněte Menu  a vyberte 
Properties.

• Pro uložení playlistu, stiskněte 
Menu  (pravý softkey) a vyber-
te Save Playlist.

• Pro odstranění všech položek 
z Now Playing seznamu stisk-
něte Menu  (pravý softkey) 
a potom vyberte Clear Now 
Playing.

Přizpůsobení Windows Media 
Player Mobile
1. Pokud jste na jiné obrazovce než 

Playback (přehrávací), stiskněte 
Back  pro Playback obrazov-
ku. V Now Playing (právě přehrá-
vané) obrazovce stiskněte Play 

 (levý softkey) pro přesun do 
Playback obrazovky.

2. Stiskněte Menu  (pravý 
softkey) a vyberte Options.

3. Vyberte Playback a nastavte 
některou z následujících voleb: 
Stiskněte Done  (levý softkey) 
pro dokončení.
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 Show time as: Nastavuje zda 
se čas zbývající nebo uplynulý 
zobraz na Playback obrazovce.

 Pause playback while using 
another program: Pozastavuje 
přehrávání pokud přejdete do jiné 
aplikace.

 Resume playback after a 
phone call: Nastavuje pokra-
čování přehrávání po ukončení 
hovoru. 

4. Vyberte Video a nastavte někte-
rou z následujících voleb: Stisk-
něte Done  (levý softkey) po 
dokončení. 

 Play video in full screen: 
Nastavuje zda se video automaticky 
přehrává ve formátu celé obrazovky.

 Scale to fit window: Upravuje 
videa automaticky do velikosti 
playback obrazovky.

5. Vyberte Network a nastavte 
následující volby: Stiskněte Done 

 (levý softkey) po dokončení.
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 Internet connection speed: 
Specifikuje rychlost vaší sítě spo-
jení a specifikuje zda chcete, aby 
zařízení zjistilo rychlost spojení.

 Protocol: Povoluje a zakazu-
je dostupné protokoly. Musíte 
vybrat alespoň jeden protokol. 
Můžete také nastavit UDP port.

6. Vyberte Library a nastavte zda 
chcete zobrazit obrazovku knihov-
ny nebo obrazovku přehrávače, 
když otevřete Windows Media 
Player Mobile. Stiskněte Done 

 (levý softkey) pro dokončení.

7. Vyberte Skins a stiskněte 
Vpravo  nebo Vlevo   pro 
nastavení pozadí přehrávače. 
Stiskněte Done  (levý softkey) 
pro dokončení.

8. Vyberte Buttons pro změnu 
nastavení dostupných tlačítek. 
Stiskněte Done  (levý softkey) 
pro dokončení.

• Pro přiřazení tlačítka k položce 
zvýrazněte položku, kterou chcete 
nastavit, stiskněte Menu  
(pravý softkey) a potom vyberte 
Assign. Stiskněte tlačítko, které 
chcete použít pro tuto položku.
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• Pro obnovení nastavení položek 
od výrobce, zvýrazněte polož-
ku, stiskněte Menu  (pravý 
softkey) a potom vyberte Reset.

• Pro odebrání tlačítkové volby 
z položky, zvýrazněte položku, 
stiskněte Menu  (pravý 
softkey) a potom vyberte None.

9. Stiskněte OK  (levý softkey).

10. Stiskněte Done (levý 
softkey).
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Váš osobní organizér

Rozlučte se s papírovými kalendáři a zahoďte načmárané seznamy úkolů. 
Váš Palm® Treo™ 500 smartphone je vším co potřebujete k organizování 
vašich osobních informací, které budete mít stále po ruce.

Nikdy neztratíte vaše informace, ani tehdy bude-li vaše baterie úplně 
vybitá. Všechny vaše osobní informace jsou zálohovány pokaždé, když 
synchronizujete a informace jsou v soukromí pokud používáte bezpeč-
nostní funkce dostupné na vašem smartphonu. Informace také můžete 
snadno sdílet elektronicky s ostatními.

VÝHODY:

· Můžete sledovat aktuální, budoucí a dřívější schůzky.
·  Vytvoříte seznamy úkolů, které opravdu dokončíte.
· Nastavíte si upomínky pro schůzky, narozeniny, důležité úkoly atd.

KAPITOLA

10
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Kontakty
Přidání kontaktu

1. Stiskněte Home  a potom stisk-
něte Contacts  (pravý softkey).

2. Stiskněte New  (levý softkey).

3. Vyberte druh kontaktu, který 
chcete vytvořit:

 Outlook Contact: Tento druh 
kontaktu je uložený v aplikaci 
kontakty na smartphonu a syn-
chronizuje se s aplikací kontaktů 
v Microsoft® Office Outlook® na 
vašem počítači. 

 SIM Contact: Tento druh 
kontaktu je uložený na SIM kartě 
vašeho smartphonu a není syn-
chronizován. Pokud použijete SIM 
kartu v jiném smartphonu,můžete 
zpřístupnit kterékoli kontakty na 
SIM kartě.

TIP Pokud si založíte Windows Live účet 
(viz. Používání Windows Live), můžete vy-
tvořit kontakt jako Windows Live kontakt. 
Windows Live kontakt se synchronizuje 
se seznamem Hotmailových kontaktů, 
ale ne s Microsoft Outlookem na vašem 
počítači.

4. Použijte 5-ti polohové tlačít-
ko  pro pohyb mezi poli při 
vkládání informací.

POZNÁMKA K SIM kontaktům může-
te vložit pouze jméno a telefonní číslo.

TIP Rolujte po obrazovce směrem dolů, 
aby jste si prohlédli pole v novém kontak-
tu. Zobrazí se vám pole pro více adres, 
telefonní čísla, emailové adresy a spousty 
dalších.

TIP Ujistěte se, že jste zadali mobilní 
čísla a emailové adresy do správných polí. 
Proto, aby aplikace Messaging tyto infor-
mace nalezla, když chce adresovat zprávu 
a aby kalendář mohl najít kontakty, když je 
chcete pozvat na schůzku.
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Zde jsou užitečné rady vkládá-
ní informací:
• Pro přiřazení vyzvánění, vyberte 

seznam Custom ring tone a 
potom vyberte vyzvánění.

• Pro přiřazení ID obrázku volajícího, 
který se zobrazí, když osoba volá, 
vyberte Picture a potom vyberte 
Camera a vyfoťte obrázek nebo 
vyberte existující obrázek z minia-
tur.

• Pro přiřazení záznamu do jedné 
nebo více kategorií, vyberte 
Categories a zaškrtněte kate-
gorie, pod kterými chcete, aby se 
záznam zobrazoval.

• Pro přidání poznámky k zázna-
mu, vyberte Notes vložte text 
poznámky.

5. Potom co jste vložili všechny 
informace, stiskněte Done  
(levý softkey).

TIP Pokud potřebujete zadat více kontak-
tů, které sdílí stejnou Informaci, například 
více lidí, kteří pracují ve stejné společnos-
ti, můžete vytvořit jeden kontakt, zkopí-
rujete je a potom měníte jen pole, které 
potřebujete pro další kontakt. V seznamu 
adres zvýrazněte první kontakt, stiskněte 
Menu (pravý softkey) a potom vyberte 
Copy Contact.

TIP Poté co vytvoříte kontakt, přiřaďte 
tlačítko rychlé volby ke kterémukoli z 
kontaktních telefonních čísel pro rychlou 
volbu (viz. Vytvoření rychlé volby).

Prohlížení nebo změny v infor-
macích kontaktů

1. Stiskněte Home  a potom 
stiskněte Contacts  (pravý 
softkey).

2. Do seznamu kontaktů začněte 
vkládat kombinace písmen jména    
kontaktu nebo příjmení. Pokud 
použijete první písmena jména i 
příjmení, oddělte je mezerou.

 Můžete psát nejprve písmena 
příjmení. Například vložením SM 
se vyhledá Smilla Anderson i John 
Smith. Vložením SM AN se vyhle-
dá Smilla Anderson a Anna Smith.
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VĚDĚLI JSTE, ŽE? Vyhledávací funkce 
nabízí několik funkcí, které usnadňují 
vyhledávání kontaktu, i když si nejste jisti 
přesným jménem: (1) Výsledky vyhledá-
vání zahrnují varianty jmen jako např. „Da-
vid“ pro „Davea.“(2) Vyhledávací funkce 
vkládá mezeru před posledním napsaným 
písmenem a pokouší se najít shodu.Takže 
jestliže vložíte „Davidm“ a nenalezne 
žádné výsledky, vyhledávací funkce 
automaticky zkouší pátrat po „David M.“ 
(3) Výsledky vyhledávání zahrnují podobně 
znějící položky, takže vložení „Dwayne“ 
také vyhledá výsledky pro „Duanea.“

3. Vyberte záznam, který chcete 
otevřít.

VĚDĚLI JSTE, ŽE? Když vyberete zá-
znam kontaktu, máte k dispozice několik 
voleb pro kontaktování osoby, záleží na 
tom jaké informace jste vložili do kon-
taktu.Například, můžete vidět volby pro 
volání čísla přiřazeného ke kontaktu, posí-
lání emailu na emailovou adresu kontaktu 
nebo vytočení posledního čísla, které jste 
použili pro volání u kontaktu.

4. Stiskněte Menu  (pravý 
softkey) a vyberte Edit.

5. Proveďte nezbytné změny.

6. Stiskněte Done  (levý 
softkey).

VĚDĚLI JSTE, ŽE? Můžete najít kon-
takt i přes jméno společnosti. Stiskněte 
Menu (pravý softkey) a vyberte View 
by>Company. Vyberte jméno spo-
lečnosti pro zobrazení osob, které v ní 
pracují.

TIP Pro zobrazení specifické skupiny kon-
taktů, stiskněte Menu (pravý softkey), 
vyberte Filter a potom vyberte kategorii, 
kterou chcete zobrazit.

Výmaz kontaktu
1. V seznamu kontaktů zvýrazněte 

kontakt, který chcete vymazat.

2. Stiskněte Menu (pravý softkey) a 
vyberte Delete Contact.

3. Stiskněte Yes (levý softkey) pro 
potvrzení výmazu.

Vyhledání kontaktu v online 
adresáři
Kromě kontaktů, které máte ve 
vašem zařízení, máte také přístup k 
informacím o kontaktech organizací 
v online adresářích nebo seznamu 
Global Address (GAL).
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NEŽ ZAČNETE Proveďte následující:• 
• Ujistěte se, že máte přístupný Ex-

change Server 2007 nebo Exchange 
Server 2003 Service Pack 2.

• Synchronizujte s Exchange serve-
rem, pro zobrazení volby Company 
Directory.

1. Stiskněte Home  a potom stisk-
něte Contacts  (pravý softkey).

2. Stiskněte Menu  (pravý 
softkey), vyberte Company Di-
rectory, vložte jméno kontaktu a 
potom vyberte Search.

Odeslání kontaktu
Váš smartphone nabízí několik mož-
ností odesílání informací o kontaktu 
někomu jinému:

1. Stiskněte Home  a potom 
stiskněte Contacts  (pravý 
softkey).

2. Zvýrazněte kontakt, který chcete 
odeslat.

3. Stiskněte Menu  (pravý 
softkey) a vyberte jednu z násle-
dujících voleb:

 Beam a contact to a nearby 
Bluetooth device: (odeslání 
kontaktu přes Bluetooth): Vyberte 

Send Contact > Beam, vyberte 
přijímající zařízení a potom stiskněte 
Beam  (levý softkey).

 Send a text message con-
taining the contacts infor-
mation (odeslání kontaktu text. 
zprávou): Vyberte Send Con-
tact > Text Message. Vyberte 
informaci o kontaktu, kterou chce-
te poslat a stiskněte Done  
(levý softkey). Adresujte zprávu a 
stiskněte Send  (levý softkey).

 Send a multimedia messa-
ge containing the contact 
information (odeslání kontaktu 
přes MMS): Vyberte Send as 
vCard, adresujte MMS a potom 
stiskněte Send  (levý softkey).

TIP Můžete také rychle poslat multimedi-
ální zprávu o kontaktu z aplikace kontakty.  
Zvýrazněte jméno kontaktu, stiskněte 
Menu (pravý softkey) a potom vyberte 
Send MMS.

Kalendář
Zobrazení kalendáře

1. Stiskněte Home  potom Start 
 (levý softkey).
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2. Stiskněte 2x More  (levý 
softkey) a vyberte Kalendář .

3. Stiskněte Menu  (pravý 
softkey) a vyberte jednu z násle-
dujících voleb zobrazení:

 Week View: Zobrazuje váš 
rozvrh na celý týden.

 Month View: Zobrazuje váš 
rozvrh na celý měsíc. V zobrazení 
rozvrhu na měsíc se zobrazí ke 
dni schůzky následující ikony:

 Dopolední schůzka

 Odpolední schůzka

 Obojí ranní i odpolední schůzky

 Celodenní událost

 Go to Today: Zobrazuje váš 
denní rozvrh v seznamovém 
formátu. Aktuální schůzky jsou 
tučně, uplynulé schůzky jsou 
ztlumené.

 Go to date: Zobrazuje váš denní 
rozvrh ve formátu denního pláno-
vače. Tento náhled se také zob-
razuje na horizontálním časovém 
proužku nahoře,v němž na první 
pohled vidíte, kdy máte schůzky.

VĚDĚLI JSTE, ŽE? Pokud váš rozvrh 
obsahuje dvě schůzky které se překrý-
vají,můžete to vidět v zobrazení denním, 
datovém i týdenním zobrazení. 

TIP Pro přepnutí náhledů stiskněte levý 
softkey. Nespleťte jméno náhledu zobra-
zeného nad levým softkey se současným 
náhledem. Jméno nad levým softkey je 
jméno dalšího náhledu, který se zobrazí, 
když stisknete klávesu.

Vytvoření schůzky

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte 2x More (levý softkey) 
a vyberte Kalendář .

3. Stiskněte Menu  (pravý 
softkey) a vyberte New Appo-
intment.
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4. Použijte 5-ti polohovou klá-
vesu  pro pohyb mezi poli při 
vkládání informací. Všimněte si:

• Do předmětového pole můžete 
vložit předmět nebo si stisknutím 
Center  vybrat ze seznamu 
přednastavených předmětů.

• V poli pro výběr času, pokud 
je váš formát času v AM a PM 
stiskněte klávesu A  nebo P  
nebo stisknutím některé číselné 
klávesy můžete také přepínat 
mezi AM a PM.

5. Stiskněte Done  (levý 
softkey).

TIP Pro „zapsat si“ schůzku vyberte 
seznam Status a potom vyberte Tentative 
(prozatímní).

Přidání upomínky na událost
Můžete použít seznam upomínek 
k tomu, aby jste nastavili alarm pro 
událost, kterou vytváříte. Můžete 
také přidat alarm k události později, 
až poté co jste ji vytvořili.

1. Vytvořte událost a potom ji vyberte.

2. Stiskněte Menu  (pravý 
softkey) a vyberte Edit.

3. Vyberte seznam Reminder a po-
tom vyberte počet minut, hodin, 
dnů nebo týdnů před událostí, 
dobu po kterou byste chtěli být 
na událost upozorňováni.

4. Stiskněte Done  (levý softkey).

Vytvoření předčasné události
Předčasné události jako narozeniny, 
výročí nebo dovolená, které se nevy-
skytují ve specifickém denním čase. 
Tyto události se zobrazují v záhlaví v 
horní části vašeho kalendáře, nezabírají 
časové řádky. Např. „předložit konečný 
návrh“ v následujícím snímku obrazov-
ky se zobrazí jako předčasná událost.
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VĚDĚLI JSTE, ŽE? Předčasná událost 
může trvat déle než den.

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte 2x More  (levý 
softkey) a vyberte Kalendář .

3. Zadejte předmět (popis).

4. Vyberte datum začátku a konce. 
Nevkládejte nic do času začátku 
nebo konce v časovém poli.

5. Zaškrtněte All day event (celo-
denní událost).

6. Stiskněte Done  (levý softkey).

Plánování opakované schůzky
1. Vytvořte schůzku nebo předčas-

nou událost a potom ji vyberte.

2. Stiskněte Menu  (pravý 
softkey) a vyberte Edit.

3. Vyberte seznam Occurs a po-
tom vyberte vzor opakování.

4. Stiskněte Done  (levý softkey).

Odesílání žádosti o schůzku
Můžete posílat emailem pozvání na 
schůzky kontaktům, které používají 
Microsoft Office Outlook nebo Outlo-
ok Mobile.

NEŽ ZAČNETE Vytvořte položky kon-
taktů s emailovými adresami lidí, které 
chcete pozvat na schůzku. Z vašeho 
kalendáře nemůžete vybrat kontaktní 
položky bez emailových adres.

1. Vytvořte událost a potom ji vyberte.

2. Stiskněte Menu  (pravý 
softkey) a vyberte Edit.

3. Vyberte seznam Attendees. Vy-
berte Add Required Attendee 
a potom vyberte jméno kontaktu, 
který chcete pozvat. Pro pozvání 
dalších účastníků vyberte Add 
Required Attendee a potom 
vyberte jméno.

4. (volitelný) Pro pozvání volitelného 
návštěvníka, vyberte Add Opti-
onal Attendee a potom vyberte 
jméno.
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VĚDĚLI JSTE, ŽE? Pokud používáte 
Exchange Server 2007 nebo Exchange 
Server 2003 Service Pack 2, můžete pou-
žít váš korporační Globální seznam adres 
k tomu, aby jste našli kontaktní informace 
o návštěvnících schůzky. Na seznamu 
adres vyberte Company Directory (firemní 
adresář) a potom vyberte jméno kontaktu, 
který chcete pozvat.

5. Stiskněte Done  (levý softkey).
Při příští synchronizaci je žádost o 
schůzku odeslána všem návštěv-
níkům. Když návštěvníci přijmou 
vaši žádost o schůzku je automa-
ticky přidána k jejich rozvrhům. 
Když přijmete jejich odpověď váš 
kalendář je aktualizován také.

Odpovědět  na žádost o schůzku 
Odpověď na žádosti o schůzku přijmete 
v emailové aplikaci (viz. Práce s pozván-
kami na schůzky). Pokud přijmete nebo 
dočasně přijmete pozvání, to se zobrazí 
jako schůzka ve vašem kalendáři.

Označení událost jako citlivé 
(soukromé). 
Pokud mají další lidé přístup do 
Microsoft Office Outlook kalendáře 
na vašem počítači a vy nechcete, aby 
viděli schůzku, můžete ji označit jako 
osobní, aby se skryla před ostatními 
uživateli.

1. Vytvořte událost a potom ji vyberte.

2. Stiskněte Menu  (pravý 
softkey) a vyberte Edit.

3. Vyberte seznam Sensitivity a 
potom vyberte jednu z následují-
cích možností:

Personal: Zobrazuje událost na 
vašem smartphonu i počítači.
Návštěvníci schůzky nebo příjemci 
uvidí  „please treat this as personal“ 
(zacházejte jako s osobním) v horní 
části otevřené schůzky.

Private: Zobrazuje událost na vašem 
smartphonu i počítači. Návštěvníci 
schůzky nebo příjemci uvidí „please treat 
this as private“ (zacházejte jako se sou-
kromím) v horní části otevřené schůzky. 
Pokud synchronizujete s Exchange ser-
verem další uživatelé, kteří mají přístup 
do vašich složek nemohou vidět vaše 
privátní události, vidí privátní události jen 
jako nedostupné časové úseky.

Confidential: Zobrazuje událost na 
vašem smartphonu i na vašem počíta-
či. Návštěvníci schůzky nebo příjemci 
vidí „please treat this as confidential“ 
(zacházejte jako s důvěrným) v horní 
části otevřené schůzky.
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TIP Pokud nevidíte volbu na obrazovce, 
stiskněte Down na 5-ti polohovém tlačítku 
pro rolování na další možnosti.  Například 
při úpravě události, se nezobrazí volby 
Sensitivity (citlivost) do té doby, než rolu-
jete směrem ke spodní části záznamu.

4. Stiskněte Done  (levý softkey).

Výmaz události
1. Zvýrazněte událost, kterou chcete 

vymazat.

2. Stiskněte Menu  (pravý softkey) 
a vyberte Delete Appointment.

3. Stiskněte Yes  (levý softkey) 
pro potvrzení výmazu.

Přizpůsobení kalendáře

1. Stiskněte Menu  (pravý softkey) 
a vyberte Tools > Options.

2. Nastavte některou z následujících voleb:

 

 Start in: Specifikuje, které zob-
razení po otevření kalendáře.

 First day of week: Specifikuje 
neděli nebo pondělí jako první 
den v týdnu pro všechna zobraze-
ní kalendáře.

 Week view: Specifikuje zda se 
objeví pět, šest nebo sedm dní v 
zobrazení týdne v kalendáři.

 Month view/Show week 
number: Specifikuje zda se ob-
jeví čísla týdnů (1–52) v zobrazení 
měsíce v kalendáři.

 Set reminder: Specifikuje zda 
se upomínka automaticky přidá 
k novým událostem a jak dlouho 
před událostí se zobrazí.Můžete 
zrušit toto nastavení pro jednot-
nou událost.

 Respond to meeting via: 
Specifikuje emailový účet užívaný 
pro posílání odpovědí na žádosti o 
schůzku.

3. Stiskněte Done  (levý softkey).

Odeslání schůzky

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte 2x More  (levý 
softkey) a vyberte Kalendář .
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3. Vyberte jednu z následujících 
voleb:

 Beam an appointment to a 
nearby Bluetooth device: 

 Vyberte schůzku, kterou chcete 
poslat.  Stiskněte Menu  
(pravý softkey) a vyberte Beam 
Appointment.Vyberte přijímají-
cí zařízení a stiskněte Beam  
(levý softkey).

 Send a multimedia mess-
age containing the appo-
intment: Zvýrazněte schůzku, 
kterou chcete poslat. Stiskněte 
Menu  (pravý softkey) a 
vyberte Send as vCalendar. 
Adresujte multimediální zprávu a 
stiskněte Send  (levý softkey).

Úkoly
Můžete použít Úkoly pro připomenutí 
úkolů, které potřebujete dokončit 
a ponechat si záznam dokončených 
úkolů.

Přidání úkolu

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Tasks .

3. Stiskněte Menu  (pravý 
softkey) a vyberte New Task.

4. Nastavte kterýkoli z následujících:

 Subject: Specifikuje jméno 
úkolu.

 Priority: Specifikuje úroveň 
důležitosti pro tento úkol. Později 
můžete uspořádat vaše úkoly 
podle důležitosti.

 Status: Signalizuje zda je úkol 
dokončený.

 Start Date: Specifikuje začátek 
úkolu.

 Due Date: Specifikuje termín 
vypršení úkolu.
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 Occurs: Signalizuje zda se úkol 
opakuje v pravidelných interva-
lech a četnost opakování.

 Reminder: Nastavuje upomínku 
pro úkol a signalizuje, kdy chcete 
být upozorněni.

 Categories: Přiřadí úkol k jedné 
nebo více kategoriím.

 Sensitivity: Označuje tento úkol 
jako obyčejný, osobní, soukromí 
nebo důvěrný.

 Notes: Umožní vám vložit doda-
tečný text pro úkol.

5. Stiskněte Done  (levý softkey).

TIP Můžete také přidat úkol výběrem 
úkolu z nástrojové lišty v horní části 
obrazovky úkolů, vložením popisu úkolu 
a stisknutím Center na 5-ti polohovém 
tlačítku.

Zrušení úkolu
1. Zvýrazněte úkol, který chcete 

zrušit.

2. Stiskněte Complete  (levý 
softkey).

VĚDĚLI JSTE, ŽE? Promeškané úkoly 
se zobrazují červeně.

Uspořádávání úkolů
1. V seznamu úkolů stiskněte Menu 

 (pravý softkey) a vyberte 
Filter.

2. Vyberte úkoly, které chcete 
zobrazit: All Tasks, Recent, 
Active Tasks, Completed 
Tasks nebo bez kategorie. Nebo 
specifikujte kategorie jako pracov-
ní nebo osobní.

3. Stiskněte Menu  (pravý 
softkey) a vyberte Sort by.

4. Vyberte metodu výběru: Status, 
Priority, Subject, Start Date 
nebo Due Date.
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Výmaz úkolu
1. Zvýrazněte úkol, který chcete 

vymazat.

2. Stiskněte Menu  (pravý 
softkey) a vyberte Delete Task.

3. Stiskněte Yes  (levý softkey) 
pro potvrzení výmazu.

Přizpůsobení úkolů
1. Přejděte do seznamu úkolů.

2. Stiskněte Menu  (pravý 
softkey) a vyberte Options.

3. Nastavte některou z následujících voleb:

 Nastavení upomínek pro 
nové položky:

 Automaticky přidává připomínky 
k novým úkolům. Standardní 
připomínka je nastavená na 8:00 
ráno v den úkolů. Toto nastavení 
můžete přerušit pro jednotlivé 
úkoly použitím seznamu. Upomí-
nek na úkolové obrazovce. 

 Zobrazení začátku a data 
splatnosti: Zobrazuje začátek 
úkolu a datum splatnosti v sezna-
mu úkolů. 

4. Stiskněte Done  (levý softkey).

Hlasové poznámky
Hlasové záznamy jsou skvělý způsob 
jak zachytit myšlenky, otázky a 
poznámky ze schůzek na vašem 
smartphonu.

Nahrávání hlasových poznámek

1. Stiskněte Home  potom Start 
(levý softkey).

2. Stiskněte 2x More  (levý softkey) 
a vyberte Voice Notes .

3. Stiskněte Record  (levý softkey).

4. Mluvte do mikrofonu na vašem 
smartphonu nebo jej držte blízko 
u zdroje zvuku.
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5. Když skončíte nahrávání stiskněte 
Stop  (levý softkey).

Přehrávání hlasových poznámek
1. Zvýrazněte hlasovou poznámku, 

kterou chcete přehrát.

2. Stiskněte Menu  (pravý 
softkey) a vyberte Play.

Přejmenování hlasové poznámky
1. Zvýrazněte hlasovou poznámku, 

kterou chcete přejmenovat.

2. Stiskněte Menu  (pravý 
softkey) a vyberte Rename.

3. Zadejte nové jméno poznámky.

4. Stiskněte Done  (levý 
softkey).

Výmaz hlasové poznámky
1. Zvýrazněte hlasovou poznámku, 

kterou chcete vymazat.

2. Stiskněte Menu  (pravý 
softkey) a vyberte Delete.

3. Stiskněte Yes  (levý softkey) 
pro potvrzení výmazu.

Používání hlasové poznámky 
jako vyzvánění
1. Zvýrazněte hlasovou poznámku, 

kterou chcete použít.

2. Stiskněte Menu  (pravý 
softkey) a vyberte Set As Ring-
tone.

3. Stiskněte OK  (levý softkey).
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Váš Microsoft Office
a další nástroje 

Váš Palm® Treo™ 500 smartphone vám umožní si vzít kancelář sebou 
včetně vašich Microsoft® Office souborů. S Microsoft Office Mobile 
můžete nosit, prohlížet a ovládat Microsoft Word, Excel® a PowerPoint® 
soubory na vašem smartphonu. Můžete aktualizovat kopie souborů na 
smartphonu i počítači, abyste je mohli zobrazit kdykoli a kdekoli v pohodlí.

Můžete také používat PDF Viewer pro zobrazení PDF souborů na vašem 
smartphonu.

VÝHODY:
·  Spravování Word, Excel a PowerPoint souborů na smartphonu, včetně 

souborů Office 2007.
·  Zlepšíte svou výkonnost braním důležitých dokumentů, tabulek a pre-

zentací, všude sebou.
·  Práce s PDF soubory.

KAPITOLA

11
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Synchronizace 
Microsoft Office 
souborů
Můžete vytvořit a editovat Microsoft 
Office soubory na vašem počítači a po-
tom synchronizovat soubory  tak, že se 
změny, které vytvoříte objeví na vašem 
počítači i smartphonu. Mobilní Office 
aplikace na vašem smartphonu jsou 
kompatibilní s Office 2007 aplikacemi a 
novějšími verzemi Office.

Pro synchronizaci Microsoft Office 
souborů, musíte nejprve vybrat sou-
bory jako jednu z voleb synchronizace 
vašeho smartphonu, pokud jste tak ne-
učinili v průběhu instalace softwaru (viz 
Nastavení bezdrátové synchronizace 
nebo Výběr aplikace k synchronizaci).

Postup synchronizace souborů se 
různí u počítačů  s Windows XP a 
Windows Vista.

Synchronizace souborů: Win-
dows XP
1. Připojte smartphone k počítači 

USB synchronizačním kabelem.

POZNÁMKA Většina voleb Active-
Sync® je dostupných, pouze pokud je 
váš smartphone připojený k počítači.

2. Na vašem počítači 2x klikněte 
na ikonu ActiveSync®  na 
nástrojové liště v pravém dolním 
rohu počítačové obrazovky, pro 
otevření softwarového okna Acti-
veSync. 

TIP Pokud se neobjeví ikona ActiveSync 
na nástrojové liště, přejděte na Start 
>Programy a potom vyberte Micro-
soft ActiveSync pro otevření okna 
ActiveSync.
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3. Pod Information Type 2x 
klikněte na Files pro zobrazení 
seznamu synchronizovaných 
souborů. 

TIP Pokud se Files nezobrazí pod Infor-
mation Type, otevřete nabídku Tools 
a vyberte Options. Ujistěte se, že je 
zaškrtnutý rámeček u Files.

4. Proveďte následující:

• Pro vymazání souboru ze složky 
synchronizovaných souborů na 
počítači   a z vašeho smartpho-
nu zvýrazněte jméno souboru a 
klikněte Remove.

• Pro kopírování souborů z počítače 
na smartphone, klikněte na Add,  
procházejte a zvýrazněte soubor a 
potom klikněte na Open.

POZNÁMKA Jestliže obdržíte zprávu o 
chybě při synchronizaci souborů, ujistěte 
se, že všechny soubory, které se pokouší-
te synchronizovat, jsou zavřeny na vašem 
počítači i smartphonu.

Synchronizace souborů: Win-
dows Vista
1. Na vašem počítači zkopírujte 

nebo uložte soubor do Docu-
ments\Documents ve složce uži-
vatelských jmen ve Smartphonu.

VĚDĚLI JSTE, ŽE? Documents ve složce 
uživatelských jmen na smartphonu je 
vytvořen, když vyberete volbu synchroni-
zovat soubory.

2. Připojte smartphone k počítači USB 
synchronizačním kabelem. Syn-
chronizace proběhne automaticky.

Kde jsou změny, které jsem 
provedl na souboru? Pokud 
synchronizujete soubor z vašeho po-
čítače na smartphone, editujte jej na 
vašem smartphonu a potom synchro-
nizujte zpět do počítače, nehledejte 
změněný soubor v jeho původním 
umístění na počítači. Jen synchroni-
zovaná verze obsahuje změny
a tou verzí je složka ActiveSync syn-
chronizovaných souborů.
Pro nalezení této složky proveďte 
jednu z následujících:

Windows XP: Na vašem počítači 
2x klikněte na ikonu složky synchroni-
zovaných souborů. 
Toto je zkratka do souboru synchroni-
zované složky.

Alternativně v ActiveSync softwaru 
2x klikněte na Files. Umístění složky 
synchronizovaných souborů se objeví 
v Dialogovém okně File Synchroniza-
tion Settings.
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(Tento počítač synchronizuje soubory 
v této složce).

Windows Vista: Otevřete doku-
menty\dokumenty ve složce uživatel-
ských jmen Smartphonu.

Na smartphonu můžete najít syn-
chronizované soubory následujícím 
způsobem:

• Stiskněte Home  potom Start 
 (levý softkey). Vyberte Office 

Mobile  a potom vyberte apli-
kaci, která otevírá soubor: Word 
Mobile , Excel Mobile  nebo 
PowerPoint Mobile .

• Stiskněte Home  potom 
Start  (levý softkey). Stiskněte 
More  (levý softkey) a vyberte 
File Explorer .

Word Mobile
S Word Mobile můžete zobrazit a 
změnit textové formátování doku-
mentů uložených na vašem smart-
phonu nebo na rozšiřující kartě (v 
prodeji samostatně) vloženou do 
smartphonu.

VĚDĚLI JSTE, ŽE? Pokud máte PDF 
soubor (pdf), můžete jej zobrazit použitím 
PDF Viewer. Stiskněte Home a potom 
stiskněte Start (levý softkey). Stiskněte 
More (levý softkey), vyberte Accesso-
ries a potom vyberte PDF Viewer (viz. 
PDF Viewer).

Otevírání dokumentu

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Vyberte Office Mobile  a 
potom vyberte Word Mobile .

3. Přesunujte se a vyberte soubor, 
který chcete.

4. Pro zavření dokumentu stiskně-
te Menu  (pravý softkey) a 
vyberte Close File.

TIP Jestliže chcete vytvořit nový doku-
ment, otevřete existující dokument a ulož-
te jej pod novým jménem (viz. vytvoření 
kopie dokumentu). Alternativně otevřete 
prázdný vzor Word dokumentu umístěné-
ho ve složce My Documents/Templates 
(viz.prohledávání souborů a složek) a uložte 
jej pod novým jménem.
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TIP Pro otevření informací o rozšiřující 
kartě (v prodeji samostatně) stiskněte 
Menu (pravý softkey) a vyberte Storage 
Card. Tato volba se zobrazí jen pokud je 
rozšiřující karta vložená do smartphonu.

TIP Pro přiblížení nebo oddálení otevře-
ného dokumentu, stiskněte View (levý 
softkey) a vyberte úroveň zvětšení.

Aby se vešel dokument na obrazovku 
smartphonu, stiskněte View (levý 
softkey) a vyberte Wrap to Window.

TIP Pro zobrazení vlastností dokumentu, 
včetně velikosti a data vytvoření, zvýraz-
něte jméno dokumentu, stiskněte Menu 
(pravý softkey) a potom vyberte Proper-
ties.

Formátování textu v dokumentu
1. Otevřete dokument jehož text 

chcete editovat.

2. Stiskněte Menu  (pravý 
softkey) a vyberte Edit.

3. Vložte text pro který chcete pou-
žít specifický formát.

4. Stiskněte Menu  (pravý softkey), 
vyberte Format a potom vyberte 
volbu formátování: Bold (tučný), 
Italic (kurzíva), Underline (pod-
tržený) nebo Highlight (zvýrazně-
ný). Veškerý text vlevo od kurzoru 
je ihned formátován volbou, kterou 

vyberete. Formát je aplikován na 
jakýkoli text, který vložíte z toho 
bodu dále.

TIP Můžete použít dva formáty pro stejný 
text, např., můžete vytvořit text tučný a 
kurzíva. Mějte kurzor vpravo v textu, který 
chcete formátovat a opakujte krok 4 pro 
každý formát, který chcete použít.

TIP Můžete také nejprve vybrat formát a 
potom vkládat text.

5. Pro přepnutí zpět do normálního 
(neformátovaného) textu vložte 
mezeru, stiskněte  Menu  
(pravý softkey), vyberte Format a 
potom vybere stejnou volbu formá-
tování jakou jste právě vybrali pro 
vypnutí. Ujistěte se, že jste nejprve 
vložili mezeru, pokud vypnete volbu 
formátování zatímco je kurzor hned 
vpravo od formátovaného textu, 
text ztratí své formátování.

TIP Pro zrušení úpravy, kterou jste pro-
vedli v dokumentu, stiskněte Menu (pravý 
softkey) a vyberte Undo. Pro přepracování 
úpravy, kterou jste zrušili, stiskněte Menu 
(pravý softkey) a vybrat Redo.

TIP Pro odchod z editačního režimu 
stiskněte Menu (pravý softkey) a vyberte 
Rerview.
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Vyhledání nebo nahrazení tex-
tu v dokumentu
1. Otevřete dokument obsahující 

text, který chcete najít.

2. Stiskněte Menu  (pravý 
softkey) a vyberte Find.

3. Vyberte Find What a vložte text, 
který chcete najít.

4. (volitelné) Zaškrtněte rámeček 
Match case pro vyhledání textu, 
který se shoduje velkými písmeny 
s textem z kroku 3.

5. (volitelné) Zaškrtněte ráme-
ček Whole words only pro 
vyhledání textu, který se shoduje 
celými slovy s textem z kroku 3.

6. Stiskněte Find  (levý softkey).

7. Stiskněte Next  (levý softkey) 
pro vyhledání dalších příkladů v 
textu nebo stiskněte Cancel 

 (pravý softkey) pro zastavení 
vyhledávání.

Ukládání kopií dokumentu

POZNÁMKA Pokud byl dokument 
již dříve uložený na počítači, veškeré 
nezajištěné formátování může být 
ztraceno, když soubor uložíte.

1. Otevřete dokument, který chcete 
zkopírovat.

2. Stiskněte Menu  (pravý softkey) 
a vyberte File > Save As.

3. Vyberte Name a vložte nové 
jméno souboru.

4. Vyberte seznam Location a 
potom vyberte, zda chcete uložit    
soubor do složky My Files na 
váš smartphone (Main memo-
ry) nebo na rozšiřující kartu (Sto-
rage Card). Volby Storage Card 
se objeví pouze pokud je vložena 
rozšiřující karta ve smartphonu.

5. Budete-li vyzváni, stiskněte OK 
 (levý softkey).

6. Stiskněte Save  (levý softkey).

TIP Pokud vyberete Main memory (hlavní 
paměť), dokument je standardně uložený 
ve složce My Documents na smartphonu. 
Pokud otevřete prázdný vzor ze složky 
My Documents/Templates a uložíte jej 
pod jiným jménem souboru, je uložen 
standardně do složky vzorů. Po uložení 
souboru, jej můžete přesunout do jiné 
složky (viz. Vyhledávání informací).



204

Změna zobrazení seznamu 
dokumentů 
Můžete si vybrat zda chcete zobrazit 
dokumenty v seznamech dokumen-
tů jako ikony nebo v seznamovém 
formátu. Můžete si také vybrat jak 
budou dokumenty tříděné. 

Volby, které vyberete se aplikují pou-
ze na soubory uvnitř vybrané složky. 
Když vyberete složku, všechny po-
ložky v ní včetně podsložek a dalších 
druhů souborů jsou zobrazeny nebo 
tříděny podle vybrané volby.

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Vyberte Office Mobile  a 
potom vyberte Word Mobile 

3. Pokud je zobrazený poslední doku-
ment na který jste se dívali, stisk-
něte Menu  (pravý softkey) a 
vyberte Close File pro zobrazení 
seznamu dokumentů.

4. Stiskněte Menu  (pravý softkey) 
a vyberte složku obsahující 
dokumenty, se kterými chcete 
pracovat: My Device, Storage 
Card (pokud je rozšiřující karta 
vložena do smartphonu) nebo My 
Documents.

TIP Pro třídění dokumentů v jiné složce vy-
berte My Device nebo My Documents 
a přesouvejte se do složky, kterou chcete.

5. Pro změnu zobrazení seznamu 
dokumentů, stiskněte Menu  
(pravý softkey) a vyberte View. 
Vyberte Icons nebo List.

6. Pro změnu kritéria třídění stisk-
něte Menu  (pravý softkey) a 
vyberte Sort By. Vyberte volbu 
třídění, kterou chcete: Name, 
Date, Size nebo Type.

 Poprvé, když vyberete volbu třídění, 
jsou položky tříděné vzestupně 
(A–Z, od nejstarší po nejnovější 
nebo od nejmenší po největší). Pro 
změnu na sestupné pořadí (Z–A, 
od nejnovější po nejstarší nebo od 
největší po nejmenší), stiskněte 
Menu  (pravý softkey) a vyberte 
stejnou volbu třídění.

PowerPoint mobil
S PowerPoint Mobile můžete otevírat 
a zobrazovat slide show prezentace 
vytvořených na vašem počítači.
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Mnoho prvků prezentací jako přecho-
dy slidů, animace a URL spojení jsou 
podporovany.

Spouštění prezentace

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Vyberte Office Mobile  a po-
tom vyberte PowerPoint Mobile .

3. Navigujte a vyberte soubor, který 
chcete.

TIP Pokud máte rozšiřující kartu vloženou 
do smartphonu, otevřete informace o 
kartě, stiskněte Menu (pravý softkey) a 
vyberte Storage Card.

TIP Pro zobrazení vlastnosti dokumen-
tu, včetně velikosti a data vytvoření, 
zvýrazněte jméno dokumentu, stiskněte 
Menu (pravý softkey) a potom vyberte 
Properties.

4. Stiskněte Vpravo  pro postup k 
dalšímu slidu nebo Vlevo  pro 
zobrazení předchozího slidu.

POZNÁMKA Pokud je prezentace 
sestavená jako časovaná prezentace, 
slidy postupují automaticky. Prezen-
tace se pozastaví během zvětšování.

5. (volitelné) Pokud jsou textové štítky 
softkey skryté, stiskněte pravý nebo 
levý softkey pro zobrazení štítků a 
potom proveďte následující:• 

• Stiskněte Menu  (pravý 
softkey), vyberte Go to Slide a 
potom vyberte slide, který chcete 
zobrazit. 

• Stiskněte Menu  (pravý 
softkey) a vyberte Zoom In nebo 
Zoom Out (přiblížit nebo oddálit).

TIP Pro zobrazení webových adres jako 
podtržených hyperlinek, stiskněte Menu 
(pravý softkey) a vyberte Show Links.

6. Stiskněte End  (levý softkey) 
pro zastavení ukázky. 

VĚDĚLI JSTE, ŽE? Standardně jsou štít-
ky softkey jako např. Menu, když otevřete 
prezentaci skryté, proto je třeba  jednou 
stisknout pravý nebo levý softkey pro 
jejich zobrazení a potom stisknout Menu 
(pravý softkey) pro otevření menu.

Nastavení voleb přehrávání pre-
zentace 
1. Otevřete prezentaci, pro kterou 

chcete měnit nastavení.
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2. Pokud jsou textové štítky softkey 
skryté, stiskněte pravý  nebo 
levý  softkey pro jejich zobrazení.

3. Stiskněte Menu  (pravý 
softkey) a vyberte Options.

4. Vyberte seznam Orientation a 
potom vyberte nastavení, které 
chcete.

5. Zaškrtněte rámeček Override 
playback options (potlačit 
volby přehrávání) a nastavte 
některou z následujících voleb:

 Without animation: Vypíná 
buildy a další animace.

 Without transition: Vypíná 
přechody efektů mezi slidy.

 Without media: Vypíná zvuk a 
další mediální soubory.

 Use timings: Umožňuje na-
stavení časování zaznamenaná 

s každým slidem v prezentaci. 
Pokud je prezentace sestavená 
jako časovaná slide show, slidy 
postupují automaticky. Prezentace 
se pozastaví během přibližování.

 Loop continuously: Přeska-
kuje do prvního slidu po přehrání 
posledního slidu prezentace.

6. Stiskněte Done  (levý softkey).

TIP Pro změnu prezentace do nepřetržité 
smyčky opakování slide show, zaškrtněte 
rámeček u Use timings i u Loop continu-
ously. 

TIP Pro přizpůsobení přehrávání prezen-
tace, stiskněte Menu (pravý softkey), 
vyberte Custom Show a potom vyberte 
slidy, které chcete zařadit, uspořádání 
slidu, atd. Custom slide není dostupný pro 
všechny prezentace.

Uložení  kopie prezentace

POZNÁMKA Pokud jste vytvořili pre-
zentaci na počítači, jakékoli nezajištěné 
formátování může být ztraceno při uložení 
souboru na smartphone.

1. Otevřete prezentaci, kterou chce-
te zkopírovat.
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2. Pokud jsou textové štítky softkey 
skryté, stiskněte pravý  nebo 
levý  softkey pro jejich zobrazení.

3. Stiskněte Menu  (pravý 
softkey) a vyberte Save As.

4. Vyberte Name a vložte nové 
jméno souboru.

5. Vyberte seznam Location a 
potom vyberte zda chcete uložit 
soubor do složky My Files na 
smartphonu (Main memory) 
nebo na rozšiřující kartě (Stora-
ge Card). Volba Storage Card 
se zobrazí jen pokud je rozšiřující 
karta vložená do smartphonu.

6. Pokud budete vyzváni, stiskněte 
OK  (levý softkey).

7. Stiskněte Save  (levý softkey).

TIP Pokud vyberete Main memory, pre-
zentace je standardně uložena do složky 
My Documents na smartphonu. 
Pokud chcete, můžete uložené soubory 
přesouvat do různých složek (viz. Vyhledá-
vání informací).

Změna zobrazení seznamu 
prezentace
Můžete si vybrat zda chcete zobrazit 
prezentace v seznamech prezenta-
cí jako ikony nebo v seznamovém 

formátu. Můžete si také vybrat jak 
budou prezentace tříděny. (viz. Změ-
na zobrazení seznamu dokumentů) 
kroky jsou stejné pro prezentace, 
až na to, že místo kroku 3. vyberete 
PowerPoint Mobile.

Excel Mobile
S Excel Mobile můžete zobrazit a edi-
tovat pracovní sešity na smartphonu.  
Můžete také editovat pracovní sešity, 
které vytvoříte na počítači. Mimo jiné 
mějte na paměti, že můžete ztratit 
některé informace a formátování 
při ukládání pracovních sešitů na 
smartphone.

Prohlížení pracovního sešitu

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Vyberte Office Mobile  a 
potom vyberte Excel Mobile .

3. Navigujte a vyberte soubor, který 
chcete.

TIP Pokud máte vloženou rozšiřující kartu 
do smartphonu, pro otevření informací o 
kartě, stiskněte Menu (pravý softkey) a 
vyberte Storage Card.
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4. Pokud jsou textové štítky softkey 
skryté, stiskněte pravý  nebo 
levý  softkey pro jejich zobrazení.

5. Stiskněte View  (levý softkey) a vy-
berte některou z následujících možností:

 Full screen: Zobrazuje co nej-
více z pracovní tabulky v čitelné 
velikosti textu.

 Cell text: Ukazuje plný obsah 
zvýrazněné buňky, rovněž písme-
no řádku a číslo sloupce. Volba 
Cell Text neprovádí nic, pokud je 
zvýrazněna prázdná buňka.

 Overview: Zobrazuje celou pra-
covní tabulku v přehledu. Můžete 
si vybrat část pracovní tabulky k 
jejímu zobrazení v plném rozsahu 
obrazovky. Použijete 5-ti polo-
hové tlačítko  pro pohybo-
vání červenou hranicí výběru a 
stiskněte Center  pro výběr 
oblasti, kterou chcete zobrazit.

 Freez panes: Uzamyká řady 
tak, že zůstávají viditelné zatímco 
rolujete. Předtím než vyberete 
tento příkaz, zvýrazněte některou 
buňku v řadě přímo pod řadami, 
které chcete uzamknout. Pro 
odemknutí řady vyberte View > 
Unfreeze Panes.

 Zoom: Nastavuje úroveň zvět-
šení, abyste mohli snadno číst 
pracovní tabulku.

 Sheet: Povoluje přechod na 
jinou pracovní tabulku.

TIP  Pro přeskočení na buňku nebo ob-
last, stiskněte Menu (pravý softkey) a vy-
berte Go To (v editačním režimu vyberte 
Tools > Go To). Vyberte Cell reference or 
name a vložte do cílové buňky informace.  
Stiskněte OK (odešel softkey).

TIP Pokud chcete vytvořit nový pracovní 
sešit, otevřete již existující pracovní sešit 
a uložte jej pod novým jménem (viz. Ulo-
žení kopie pracovního sešitu). Alternativně 
otevřete prázdný vzor pracovního sešitu 
ve složce My Files/Templates (viz. Prohle-
dávání souborů a složek) a uložte jej pod 
novým jménem.

Vkládání textu do buňky
1. Otevřete pracovní sešit, kam 

chcete zadat text.

2. Pokud jsou textové štítky softkey 
skryté, stiskněte pravý  nebo 
levý  softkey pro jejich zobrazení.

3. Stiskněte Menu  (pravý 
softkey) a vyberte Edit.

4. Stiskněte Menu  (pravý softkey) 
a vyberte Edit >Cell Text.
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5. Vložte text, který chcete.

6. Stiskněte Done  (levý softkey).

TIP Pro rychlé vymazání textu z buňky 
v režimu editace stiskněte Menu (pravý 
softkey) a vyberte Edit > Clear Cell.

TIP Pro zrušení nebo přepracování nějaké 
úpravy v pracovním sešitě, v editačním 
režimu, stiskněte Menu (pravý softkey) 
a vyberte Undo [last action] nebo Redo 
[last action].

TIP Pro odchod z režimu editace, stisk-
něte Menu (pravý softkey) a vyberte 
Preview. 

Vkládání funkce
1. Otevřete pracovní sešit, do které-

ho chcete vložit funkci.

2. Pokud jsou textové štítky softkey 
skryté, stiskněte pravý  nebo 
levý  softkey pro jejich zobrazení.

3. Stiskněte Menu  (pravý 
softkey) a vyberte Edit.

4. Vyberte buňku, do které chcete 
vložit funkci.

5. Stiskněte Edit (pravý softkey) a 
vyberte Insert Function.

6. Vyberte seznam Category a po-

tom vyberte druh funkce, kterou 
chcete vložit.

7. Vyberte seznam Function a 
potom vyberte specifickou funkci, 
kterou chcete vložit.

8. Stiskněte OK  (levý softkey).

9. Vložte hodnoty potřebné ve funkci.

10. Stiskněte Done  (levý softkey).

Výběr buněk, řádků nebo sloupců
1. Otevřete pracovní sešit obsahující 

položky, které chcete vybrat.

2. Pokud jsou textové štítky softkey 
skryté, stiskněte pravý  nebo 
levý  softkey pro jejich zobrazení.

3. Stiskněte Menu  (pravý 
softkey) a vyberte Edit.

4. Přesuňte se k buňce, kterou 
chcete vybrat, aby se zvýraznila.
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5. Stiskněte Menu  (pravý 
softkey), vyberte Select a potom 
vybere druh položky, kterou chcete 
vybrat: Cells (buňky), Columns 
(sloupce), Rows (řádky) nebo All 
(všechny buňky v pracovní tabulce).

6. Pokud jste vybrali buňky, sloupce 
nebo řádky, používejte 5-ti polo-
hové tlačítko  pro zvýraznění 
položky.

7. Stiskněte Done  (levý softkey).

Přidání buněk, řádků nebo sloupců
1. Otevřete pracovní sešit.
2. Pokud jsou textové štítky softkey 

skryté, stiskněte pravý  nebo 
levý  softkey pro jejich zobrazení.

3. Stiskněte Menu  (pravý 
softkey) a vyberte Edit.

4. Vyberte oblast nahoře nebo vlevo od 
místa, kam chcete vložit položku. (viz. 
Výběr buněk, řádků nebo sloupců).

5. Stiskněte Menu  (pravý softkey), 
vyberte Insert a potom vyberete jak 
chcete vložit položky:

 Row: Vkládá stejný počet nových 
řádků tak i počet buněk nebo řád-
ků, které jste vybrali svisle v kro-
ku 2. Například pokud jste vybrali 
oblast obsahující dvě buňky svisle 

(A1 a A2), výběrem Row vložíte 
dva řádky, takže původní řádky 1 
a 2 (a jejich obsah) jsou nyní řádky 
3 a 4. Řady obsahující vybranou 
oblast a všechny řádky pod ní se 
posunou o stejné množství řádků, 
v tomto příkladě dolů.

 Column: Vkládá stejný počet 
nových sloupců tak i počet buněk 
nebo sloupců, které jste vybrali 
vodorovně v kroku 2. Například 
pokud jste vybrali oblast obsahují-
cí dvě buňky (A1a B1) vodorovně, 
výběrem Column vložíte dva 
sloupce, takže původní sloupce 
A a B (a jejich obsah) jsou nyní 
sloupcem C a D. Sloupce obsa-
hující vybranou oblast a všechny 
sloupce vpravo, se posunou o 
stejné množství sloupců,v tomto 
příkladě doprava.

 Shift Right: Vkládá stejné 
množství nových buněk jako 
počet buněk, které jste vybrali 
vodorovně v kroku 2. Například 
pokud jste vybrali oblast obsahují-
cí dvě buňky (A1 a B1)vodorovně, 
výběrem Shift Right vložíte dvě 
horizontální buňky, takže původní 
A1 a B1 (a jejich obsah) jsou nyní 
C1 a D1.
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 Vybraná oblast a všechny buňky 
vpravo se přesunou o stejné 
množství sloupců, v tomto příkla-
du doprava.

 Shift Down: Vkládá stejný 
počet nových buněk tak počet 
buněk, které jste vybrali svisle v 
kroku 2. Například pokud jste vy-
brali oblast obsahující dvě buňky 
(A1 a A2) svisle, výběrem Shift 
Down vkládá dvě vertikální buňky, 
takže původní A1a A2 (a jejich 
obsah) jsou nyní A3 a A4. Vybraná 
oblast a všechny buňky pod ní 
se posunou o stejný počet řad, v 
tomto příkladě dolů.

6. Stiskněte Done  (levý softkey).

Přesun buněk, řádků nebo sloupců
Můžete oříznout nebo zkopírovat 
oblast pracovní tabulky a vložit ji kam-
koli do stejné pracovní tabulky nebo 
do jiné pracovní tabulky.

1. Otevřete pracovní sešit obsahující 
položky, kterými chcete pohybo-
vat.

2. Pokud jsou textové štítky softkey 
skryté, stiskněte pravý  nebo 
levý  softkey pro jejich zobraze-

ní.

3. Stiskněte Menu  (pravý 
softkey) a vyberte Edit.

4. Vyberte oblast, kterou chcete po-
hybovat (viz. Výběr buněk, řádků 
nebo sloupců).

5. Stiskněte Menu  (pravý 
softkey) a vyberte Edit > Cut 
nebo Edit > Copy.

6. Přesuňte se do oblasti, kam 
chcete vložit buňky, řádky nebo 
sloupce.

7. Stiskněte Menu  (pravý 
softkey) a vyberte Edit > Paste.

Výmaz buňky, řádku nebo sloupce
1. Otevřete pracovní sešit obsahující 

položky, které chcete vymazat.

2. Pokud jsou textové štítky softkey 
skryté, stiskněte pravý  nebo 
levý  softkey pro jejich zobrazení.

3. Stiskněte Menu  (pravý 
softkey) a vyberte Edit.

4. Vyberte oblast, kterou chcete 
vymazat (viz Výběr buněk, řádků 
nebo sloupců).
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5. Stiskněte Menu  (pravý 
softkey), vyberte Edit > Delete 
Cells a potom vyberte jak chcete 
položky odstranit:

 Shift cells left: Maže zvýraz-
něné buňky a přesunuje všechny 
buňky zprava nalevo.

 Shift cells right: Maže zvýraz-
něné buňky a přesunuje všechny 
buňky pod nimi nahoru.

 Entire row: Maže celou řádku(y) 
ve kterých jsou umístěné zvýraz-
něné buňky a přesunuje všechny 
řádky pod nimi nahoru.

 Entire column: Maže celý slou-
pec(e) ve kterých jsou umístěné 
zvýrazněné buňky a přesunuje 
všechny sloupce zprava nalevo.

POZNÁMKA Excel Mobile nasta-
vuje vzorce zobrazující nové umístění 
buňky. Avšak vzorec odkazující na 
vymazanou buňku zobrazuje  #REF! 
chybová hodnota.

6. Stiskněte Done  (levý softkey).

Pojmenování buňky nebo řád-
ky buněk
1. Otevřete pracovní sešit obsahující 

buňky, které chcete pojmenovat.

2. Pokud jsou textové štítky softkey 
skryté, stiskněte pravý  nebo 
levý  softkey pro jejich zobrazení.

3. Stiskněte Menu  (pravý 
softkey) a vyberte Edit.

4. Stiskněte Menu  (pravý 
softkey) a vyberte Edit > Defi-
ne Name.

5. Vyberte Range Name a vložte 
jméno pro buňku nebo řadu buněk.

6. Vyberte Refers to a vložte roz-
sah buněk, které budou zahrnuty. 

7. Stiskněte Done  (levý 
softkey).

Třídění informací v pracovní 
tabulce
1. Otevřete pracovní sešit obsahující 

položky, které chcete vymazat.

2. Pokud jsou textové štítky softkey 
skryté, stiskněte pravý  nebo 
levý  softkey pro jejich zobra-
zení.

3. Stiskněte Menu  (pravý 
softkey) a vyberte Edit. 

4. Vyberte buňky, které chcete třídit (viz 
Výběr buněk, řádků nebo sloupců)
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5. Stiskněte Menu  (pravý 
softkey) a vyberte Tools > Sort.

6. Vyberte seznam Sort by a po-
tom vyberte první sloupec třídění.

7. Zaškrtněte rámeček Ascending 
pro vzestupné třídění (A–Z nebo 0–9). 
Pokud rámeček nezaškrtnete, třídění 
bude sestupné (Z–A nebo 9–0).

8. (volitelné) Vyberte seznam Then 
by a potom vyberte druhý a třetí 
stupeň volby třídění.

9. Zaškrtněte nebo nechte volný 
rámeček třídění Exclude head-
her row from: Signalizuje zda 
chcete třídit hlavičku řádky.

10. Stiskněte OK  (levý softkey).

Vyhledávání informací v pra-
covním sešitu
1. Otevřete pracovní sešit obsahující 

informaci, kterou chcete najít.
2. Pokud jsou textové štítky softkey 

skryté, stiskněte pravý  nebo 
levý  softkey pro jejich zobrazení.

3. Stiskněte Menu  (pravý softkey) 
a vyberte Find. Pokud jste v režimu 
editace vyberte Tools > Find.

4. Vyberte Find what a vložte 
informaci, kterou chcete najít.

5. (volitelné) Zaškrtněte ráme-

ček  Match case pro vyhledání     
shodných velkých písmen v textu, 
který jste vložili v kroku 4.

6. (volitelné) Zaškrtněte rámeček 
Match entire cell, pro vyhledání 
shodného obsahu celé buňky, v 
textu, který jste vložili v kroku 4.

7. Vyberte seznam Look in a vyberte 
zda chcete nahlížet do Formulas 
(vzorce) nebo Values (významy).

8. Stiskněte Find  (levý softkey).
9. Stiskněte Next  (levý softkey) 

pro vyhledání dalšího textu nebo 
stiskněte Cancel (pravý softkey) 
pro zastavení hledání.

Ukládání kopie pracovního sešitu

POZNÁMKA Pokud byl pracovní sešit 
již dříve uložený na počítači, jakékoli neza-
jištěné formátování může být při ukládání 
souboru ztraceno.

1. Otevřete pracovní sešit, který 
chcete zkopírovat.

2. Pokud jsou textové štítky softkey 
skryté, stiskněte pravý  nebo 
levý  softkey pro jejich zobrazení. 

3. Stiskněte Menu  (pravý 
softkey) a vyberte File > Save As

4. Vyberte Name a vložte nové 
jméno souboru.
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5. Vyberte seznam Location a 
potom vyberte zda chcete uložit 
soubor do složky My Files na 
smartphone (Main memory) 
nebo na rozšiřující kartu (Stora-
ge Card). Volba Storage Card 
se zobrazí jen  pokud je rozšiřující 
karta vložena do smartphonu.

6. Pokud budete vyzváni stiskněte 
OK  (levý softkey).

7. Stiskněte Save  (levý softkey).

TIP Pokud vyberete Main memory, 
pracovní sešit je standardně uložený ve 
složce My Files na smartphonu. Po ulože-
ní souboru jej můžete přesunout do jiné 
složky (viz. Vyhledávání informací).

Změna zobrazení seznamu pra-
covních sešitů
Můžete si vybrat zda chcete zob-
razovat pracovní sešity v seznamu 
pracovních sešitů jako ikony nebo 
v seznamovém formátu. Můžete si 
také vybrat třídění pracovních sešitů 
(viz. Změna zobrazení seznamu 
dokumentů), postupy jsou stejné pro 
pracovní sešity, až na to, že vyberete 
Excel Mobile v kroku 3.

PDF Viewer
ClearVue PDF Viewer vám umožní 
prohlížení PDF souborů pokud jsou 
uloženy na smartphonu přiložené k 
emailovým zprávám, uložené na roz-
šiřující kartě vložené do smartphonu 
nebo stáhnuté z webu.

Otevření souboru

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Accessories .

3. Vyberte PDF Viewer .

4. Stiskněte File (levý softkey) a 
vyberte Open.

5. Přesouvejte se a vyberte soubor, 
který chcete.

TIP Pro otevření nedávno zobrazených 
souborů stiskněte File (levý softkey) a 
vyberte Recent Files.

TIP Pro otevření souboru na rozšiřují-
cí kartě, potom co jste vybrali Open, 
vyberte nejvýše zobrazenou ikonu složky 
se dvěma tečkami vedle a potom vyberte 
Storage Card.
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6. Stiskněte Nahoru  nebo Dolů 
  pro rolování po souboru.

7. (volitelné) Pro přiblížení nebo 
oddálení stiskněte Zoom (pravý 
softkey) a vyberte úroveň zvět-
šení. Vyberte Page Width pro 
změnu velikosti souboru tak, že 
šíře souboru odpovídá šíři obra-
zovky.

8. Pokud chcete ukončit prohlíže-
ní souboru tiskněte File (levý 
softkey) a vyberte Close.

TIP Pro detailní informaci o PDF Vieweru, 
stiskněte File (levý softkey) a vyberte 
About. Pro pomoc s používáním aplikace 
stiskněte File (levý softkey) a vyberte 
Help.
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Vaše aplikace a nástroje 
pro spravování informací

Váš Palm® Treo™ 500 smartphone jde vybavený různorodými nástroji pro 
spravování a organizování vašich informací. Využijte co nejvíce z vašeho 
smartphonu: Instalujte obchodní a vzdělávací aplikace nebo aplikace pro 
volný čas. Potom co využijete smartphone pro vytvoření nebo získání 
důležitého obchodu a osobní informace, použijte jednu z mnoha voleb 
k tomu, aby jste sdíleli informace s ostatními. Vložte rozšiřující karty (v 
prodeji samostatně) pro kompaktní a prakticky neomezenou odpověď 
na skladovací dilema. A není třeba nosit další kalkulačku, protože jednu 
najdete na vašem smartphonu.

VÝHODY:

·  Rychle lokalizujete soubory a složky.
·  Instalujete aplikace, hry a další software.
·  Skladujete a nosíte s sebou informace. 
·  Máte stále aktuální osobní a obchodní informace. 
·  Vždy máte při ruce kalkulačku. 

KAPITOLA

12
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Vyhledávání informací
Rychle vyhledáte toho nebo to co 
hledáte použitím jedné z těchto 
vyhledávacích funkcí:

• Lookup: Vyhledáte a uskuteč-
níte hovor přes jméno nebo tele-
fonní číslo kontaktu. (viz Vytáčení 
Dialing kontaktním jménem pro 
detaily.

• File Explorer: Listujte soubory  
a složkami na vášem smartphonu 
nebo na rozšiřující kartě.

• Global Address List Lookup: 
Vyhledejte jména ve vašem onli-
ne společném seznamu adres.

• Email message search: Zobra-
zí jen ty zprávy jejichž odesílatelé, 
příjemci nebo předměty se rovnají 
textu, který vy zadáte (provede 
vyhledání zpráv).

TIP Pro informaci o otvíracích a koneč-
ných aplikacích, podívej se na otvíracím a 
konečným aplikacím.

Zkoumání souborů a složek
Můžete použít File Explorer a 
brouzdat obsahem složek na vašem 
smartphonu nebo na rozšiřující kartě. 

Počáteční složka na vašem smart-
phonu je pojmenovaná My Device.  
My Device je podobný s Windows 
XP nebo s Windows Vista na vašem 
počítači.  

Váš smartphone také obsahuje slož-
ku My Dokuments kam se zachycují 
obrázky a kam Microsoft® Office 
Mobile standardně ukládá soubory.
Moje dokumenty jsou podobné My 
Documents
(Windows XP) nebo dokumenty 
(Windows Vista) na vašem počítači.

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More (levý softkey) a 
vybrat File Explorer .

3. Přesuňte se a vyberte složku, 
kterou chcete prozkoumat. Zde 
jsou nějaké návrhy:

 To move up one folder 
level: Stiskněte Nahoru (levý 
softkey).

 To quickly jump to the My 
Device folder: Stiskněte Menu  

 (pravý softkey) a vyberte My 
Device.
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 Rychlý přesun do složky My 
Documents: Stiskněte Menu 

 (pravý softkey) a vyberte My 
Documents.

TIP Když jsou zobrazeny položky ve 
složce, můžete je třídit podle jména, data, 
velikosti nebo typu. Stiskněte Menu 
(pravý softkey), vyberte Sort a potom 
vyberte metodu.

4. Proveďte některou z možností:

• Pro otevření položky, vyberte.

• Pro přesunutí nebo kopírování 
souboru v další složce zvýraz-
něte položku, stiskněte Menu 
(pravý softkey) a potom vyberte 
Edit > Cut nebo Edit > Copy. 
Otevřete cílovou složku, stisk-
něte Menu  (pravý softkey) a 
potom vyberte Edit > Paste.

• Pro výmaz nebo přejmenování 
položky, zvýrazněte položku, 
stiskněte Menu  (pravý 
softkey), vyberte Edit a potom 
vyberte vhodný příkaz.

 DŮLEŽITÉ Nemažte žádné soubory, 
které nemůžete identifikovat. Tyto 
soubory mohou být důležité pro 
správnou funkci vašeho smartphonu.

• Pro odeslání položky, zvýrazněte 
položku, stiskněte Menu  (pravý 
softkey) a potom vyberte Beam 
pro odeslání jinému blízkému Blue-
tooth zařízení nebo vyberte Send 
a vyberte metodu, kterou chcete 
použít pro odeslání položky.

TIP Pro vytvoření nové složky, stiskněte 
Menu (pravý softkey) a vyberte Edit > 
New Folder. Vložte jméno složky a stisk-
něte Center na 5-ti polohovém tlačítku.

Instalace aplikací
Váš smartphone je vybaven několika 
zabudovanými a připravenými aplika-
cemi. Můžete také instalovat aplikace 
odjinud, které jsou kompatibilní s 
Microsoft Windows. 



221

Mobile® 6 Standard verze zařízení, 
jako business software, hry a další.

Aplikace, které si stáhnete na váš 
počítač, budou pravděpodobně v 
komprimovaném formátu např. ZIP.  
Pokud je soubor komprimovaný 
potřebujete použít utilitu pro dekom-
primování na vašem počítači jako 
WinZip, rozbalte soubor dříve než 
instalujete aplikaci na smartphone.

Následující instrukce vám ukáží jak 
instalovat základní soubory na smart-
phone. Některé softwary používají 
instalátor nebo průvodce k tomu, aby 
naváděl postupem. Pro detaily se 
podívejte do dokumentace softwaru.

TIP Pokud aplikace nemá Microsoft Mo-
bile certifikát, zobrazí se vám upozornění, 
že aplikace není důvěryhodná. Pokud se 
tak stane, můžete si vybrat zda chcete v 
instalaci pokračovat.

Instalace aplikací od jiného 
výrobce
Při instalaci aplikací pocházejících 
odjinud si všimněte:

• Instalujte jen aplikace, které jsou 
určené pro Microsoft Windows 
Mobile 6 Standard.

• Aplikace navržené pro Microsoft 
Windows Mobile 6 Profesional 
nebo některé vydání Windows Mo-
bile 5.x softwary nejsou kompatibil-
ní se smartphonem.

• Pokud můžete, vyzkoušejte bezplat-
nou zkušební verzi softwaru před 
jeho nákupem, můžete jej otestovat 
a ujistit se, že to funguje správně.

POZNÁMKA Pokud narazíte na 
problém s aplikacemi odjinud (jako 
zpráva o chybě), kontaktujte pro-
davače aplikace. Pro hlavní řešení 
problémů s aplikacemi odjinud (viz. 
Řešení problémů).

VĚDĚLI JSTE, ŽE? Můžete zakoupit 
aplikaci třetí strany, která vám umožní 
spuštění Palm OS aplikaci na vašem 
smartphonu.

Instalace aplikací z Internetu
Můžete použít Internet Explorer 
Mobile k instalaci Windows Mobi-
le aplikaci v CAB formátu přímo z 
Internetu. 
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Pro soubory v jiném formátu než CAB, 
musíte nejprve stáhnout soubory 
na počítač a potom je instalovat na 
smartphone synchronizací.

NEŽ ZAČNETE Ujistěte se, že je váš 
telefon zapnutý a že se nacházíte v 
oblasti mobilního pokrytí (viz Zapínání 
telefonu).

1. Stáhněte aplikační soubor, který 
chcete instalovat (viz. Stahování sou-
borů a obrázků z webové stránky).

2. Když dokončíte stahování, stisk-
něte Home  potom Start  
(levý softkey).

3. Stiskněte More  (levý softkey) 
a vyberte File Explorer  .

4. Vyberte soubor, který jste stáhli pro 
spuštění instalačního programu.

Instalace aplikací z vašeho 
počítače

NEŽ ZAČNETE Pro instalaci aplikace 
z vašeho počítače na smartphone, mu-
síte nejprve instalovat synchronizační 
software na počítač (viz. Instalace Acti-
veSync® desktop softwaru: Windows 
XP nebo Instalace Windows Mobile 
Device Center: Windows Vista).

1. Připojte váš smartphone k počíta-
či použitím USB synchronizačního 
kabelu.

2. Otevřete My Computer nebo 
Windows Explorer na počítači.

3. 2x klikněte na ikonu představující 
váš smartphone.

4. Zkopírujte aplikační soubor(y) do 
složky.

Instalace Java her a aplikací

Můžete instalovat Java aplikační sou-
bory zvané Midlets na smartphone a 
to buď z počítače nebo z Internetu.

1. Pro instalaci Midlet z vašeho 
počítače nejprve zkopíruje soubor 
do smartphonu použitím synchro-
nizačního softwaru (viz. Synchro-
nizace informací).

2. Stiskněte Home  potom Start  
 (levý softkey).

3. Stiskněte More  (levý softkey) 
a vyberte Accessories .

4. Vyberte Java  .
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5. Stiskněte Menu  (pravý softkey), 
vyberte Install a potom vyberte 
Local (pro instalaci souboru z 
počítače) nebo Internet.

Potom co instalujete soubor, stiskně-
te Menu (pravý softkey) pro vykoná-
vání řady úkolů používáním souboru.

Instalace aplikací na rozšiřující 
kartu

NEŽ ZAČNETE Pro instalaci aplikace z 
počítače na rozšiřující kartu, musíte nej-
prve instalovat synchronizační software 
na váš počítač (viz. Instalace Active-
Sync® desktop softwaru:  Windows 
XP nebo Instalace Windows Mobile 
Device Center: Windows Vista).

1. Vložte rozšiřující kartu do otvoru 
pro rozšiřující karty (viz. Vložení a 
vyjmutí     rozšiřující karty).

2. Připojte váš smartphone k počíta-
či použitím USB synchronizačního 
kabelu.

3. Otevřete My Computer nebo 
Windows Explorer na vašem 
počítači.

4. 2x klikněte na ikonu představující 
váš smartphone.

5. Přesuňte se do složky představu-
jící rozšiřující kartu.

6. Zkopírujte aplikační soubor(y) do 
složky rozšiřující karty.

Odstranění 
aplikací

Pro uvolnění paměti na vašem 
smartphonu, můžete odstranit 
aplikace, které již déle neužíváte. 
Můžete odstranit jen aplikace, patche 
a rozšíření, které instalujete, nemů-
žete odstranit zabudované aplikace (v 
paměti pouze pro čtení - ROM) části 
vašeho smartphonu.

1. Stiskněte Home  potom Start  
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings  .

3. Vyberte More  a potom vyber-
te Remove Programs.

4. Zvýrazněte aplikaci, kterou chcete 
odstranit.
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VĚDĚLI JSTE, ŽE? Zabudované aplikace, 
které nelze vymazat nejsou uvedené v se-
znamu Remove Programs (Odstranitelných 
programů).

5. Stiskněte Menu  (pravý 
softkey) a vyberte Remove

6. Stiskněte Yes  (levý softkey) 
pro potvrzení.

7. Stiskněte Done  (levý softkey).

Sdílení informací
Váš smartphone jde vybavet varian-
tami voleb pro sdílení informací, aby 
jste si mohli vybrat ten nejrychlejší 
a nejpohodlnější způsob odesílání 
informací nebo přijímání informací z 
jiného zařízení.

• Pokud máte otevřený soubor např. 
obrázek nebo Word dokument, mů-
žete snadno sdílet soubor stisknutím 
Menu  (pravý softkey) a potom 
vybrat  volbu Send nebo Beam. 
Jméno volby se mění v závislosti na 
typu souboru, který posíláte.

• Můžete vložit obrázek, připojit 
poznámku nebo jiné soubory k 
emailové zprávě. 

• Můžete také přijímat obrázky a 
přílohy (viz. Váš email).

• Můžete připojit obrázek, video nebo 
zvukový soubor k multimediální 
zprávě (viz. Vytvoření a odesláni 
multimediální zprávy).

• Můžete synchronizací sdílet 
informace mezi smartphonem a 
počítačem nebo mezi smartpho-
nem a Microsoft Exchange Server 
2003 nebo 2007 (viz. Synchronizace 
informací).

• Pokud jste v blízkosti někoho, 
můžete si posílat (beam) soubory a 
aplikace mezi vaším smartphonem 
a sousedovým zařízením pomocí 
použitím zabudované Bluetooth® 
bezdrátové technologie. (viz. Bez-
drátové odesílání informací)
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• Můžete také ukládat soubory na 
rozšiřující kartu a sdílet rozšiřující 
kartu (viz. Použití rozšiřujících 
karet).

Přenos informací
Váš smartphone je vybaven zabudova-
nou Bluetooth bezdrátovou techno-
togií, která vám umožní informaci 
odeslat dalšímu zařízení s Bluetooth 
technologií. Maximální dosah odesílá-
ní s Bluetooth technologií je 10 metrů.

Výkon a dosah jsou ovlivněny 
fyzikálními překážkami, rušení cizím 
vysílačem z blízkých elektronických 
zařízení a dalšími faktory.

TIP Pro nejlepší výsledky musí být prostor 
mezi dvěma zařízeními bez překážek a 
obě zařízení musí být v klidu (nepohyblivé). 
Pokud máte potíže s odesláním, zkraťte 
vzdálenost.

VĚDĚLI JSTE, ŽE? Typ informace, kte-
rou můžete  přenést závisí na typu zařízení, 
kterému je odesíláte. Jiná Windows Mobile 
6 Standard zařízení jsou vždy kompatibilní s 
vaším Treo 500 smartphonem.

Přenos záznamu nebo souboru

NEŽ ZAČNETE Ujistěte se, že má 
váš smartphone zapnutou funkci 
Bluetooth (viz. Vložení základních 
Bluetooth nastavení).

1. Zvýrazněte záznam nebo soubor, 
který chcete přenést.

2. Stiskněte Menu  (pravý softkey) 
a vyberte Beam... (položka v menu 
mění název podle typu položky, 
kterou jste zvýraznili).
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3. Vyberte jméno přijímajícího zařízení.

4. Čekejte na Done , které se má 
objevit vedle jména přijímajícího 
zařízení, předtím než budete pokra-
čovat v používání smartphonu.

TIP Regionální nastavení určuje seznam 
znaků, které mohou být použity při přenosu 
informací mezi zařízeními. Pokud zkusíte 
poslat nebo přijmout znak, který není na se-
znamu zobrazí se jako otazník (viz. Nastavení 
zobrazení formátů).

Zapnutí volby pro přijímání 
přenesených informaci
Standardně je volba pro přijímání 
informací bezdrátovou technologií 
na smartphonu vypnuta. Je třeba 
zapnout volbu odesílání předtím, než 
přijmete informace z jiného zařízení.

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings .

3. Vybrat Connections a potom 
vyberte Beam.

4. Zaškrtněte rámeček Receive 
incoming beams. 

Přijímání přenesených infor-
maci

NEŽ ZAČNETE Ujistěte se, že má váš 
smartphone zapnuty Bluetooth funkci 
(viz. Vložení základního nastavení Blue-
tooth) i volbu pro přijímání přenesených 
informací (viz. Zapnutí volby pro přijímá-
ní přenesených informací).

1. Zapněte obrazovku, pokud není 
zapnutá.

2. Když se objeví Receiving Data 
message (přijímání datových 
zpráv), vyberte Yes pro přijetí 
přenosu.

TIP Pokud je volba pro přijetí informací 
přenosem zapnutá, ale vy nemůžete 
přijmout informace, zkuste měkký reset 
(viz. Resetování smartphonu). 
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Použití rozšiřujících 
karet
Zásobník pro rozšiřující kartu uvnitř 
vašeho smartphonu vám umožní 
přidat microSD rozšiřující karty pro 
rozšíření ukládací kapacity smartpho-
nu. Například rozšiřující karty mohou 
ukládat následující: 

• Obrázky

• Videa

• Hry

• Aplikace

• MP3 zvukové soubory

• Emailové přílohy

• Databáze

Rozšiřující karta v prodeji samostatně.

TIP Doporučujeme, aby jste zakoupili 
naformátované rozšiřující karty (většina 
karet je naformátovaná). Pro samostatné 
formátování karty potřebujete připojit 
čtečku karet.(v prodeji samostatně) k 
vašemu počítači.

VĚDĚLI JSTE, ŽE? Můžete tisknout ob-
rázky z rozšiřující karty nebo použít jednu 
v počítači. Většina karet je v prodeji s 
adaptérem karet, který vám umožní použí-
vat vaši kartu stejným způsobem jako SD 
kartu běžné velikosti. Adaptér lze zakoupit 
samostatně.

Vložení a vyjmutí rozšiřující 
karty
1. Sejměte víko akumulátoru zadní 

části vašeho smartphonu a od-
straňte baterii.

2. Jemně tlačte průvodce na roz-
šiřující desku směrem k straně 
oddělení baterie (1) do té doby, 
než vyskočí nahoru (2).

1

2
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3. Vysuňte zásobník dokud nebude 
celý vyčnívat a potom do něj vlož-
te rozšiřující kartu (1). Zlaté kontak-
ty na kartě by měly být obrácené 
směrem ke spodní části smartpho-
nu a měly by být viditelné.

1

2

4. Přitiskněte zásobník dolů směrem 
ke spodní části prostoru baterie (2).

5. Jemně jej odstrkujte od strany 
prostoru pro baterii dokud neza-
padne na své místo.

6. Vložte znovu baterii a vložte kryt.

7. Stiskněte a přidržte Power dokud 
se neobjeví logo Palm®.

POZNÁMKA Opakujte tyto kroky 
pokud budete vyjímat nebo měnit 
rozšiřující kartu.

Otvírací aplikací na rozšiřující 
kartě
Potom co vložíte rozšiřující kartu do 
otvoru pro rozšiřující karty, můžete 
otevřít kteroukoli aplikací uloženou na 
rozšiřující kartě.

TIP Pro spuštění aplikace na rozšiřující 
kartě, musí mít váš smartphone dostatek 
místa ve vnitřní paměti.
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1. Vložte rozšiřující kartu do otvoru 
pro rozšiřující karty.

2. Stiskněte Home  potom Start 
 (levý softkey).

3. Stiskněte  More  (levý softkey) 
a vyberte File Explorer . 

4. Stiskněte Menu  (pravý 
softkey) a vyberte Storage 
Card.

5. Vyberte aplikaci, kterou chcete 
otevřít.

Uložení souborů na rozšiřující 
kartu
Můžete ušetřit místo na smartphonu 
uložením souborů na rozšiřující kartu. 
Například, když uložite Word Mobile 
dokumenty, poznámky, Excel Mobile 
pracovní sešity, obrázky, videa a zvu-
kové soubory, můžete je uložit přímo 
do rozšiřující karty. Soubory uložené 

na rozšiřující kartě vám usnadní jejich
sdílení s ostatními. (Některé aplikace 
tuto funkci nemusí podporovat).

1. Vložte rozšiřující kartu do otvoru 
pro rozšiřující karty.

2. Otevřete aplikaci obsahující sou-
bor, který chcete uložit.

3. Stiskněte Menu  (pravý 
softkey) a vyberte volbu pro 
uložení souboru. Název volby 
jména a umístění se může měnit 
v závislosti na typu souboru.

TIP Pokud se nezobrazí volba uložit, když 
stisknete Menu (pravý softkey), 
podívejte se do podseznamu. Jestli ji 
nenajdete ani zde, aplikace tuto funkci 
pravděpodobně nepodporuje.

4. Vyberte volbu, kam uložit infor-
maci a potom vyberte Storage 
Card. Jméno volby se mění v 
závislosti na aplikaci, ve které se 
nacházíte.

5. Stiskněte Save  (levý softkey).
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Kopírování nebo přemísťování 
aplikací a souborů mezi smart-
phonem a rozšiřující kartou

1. Vložte rozšiřující kartu do otvoru 
pro rozšiřující karty.

2. Stiskněte Home  potom Start 
 (levý softkey).

3. Stiskněte More  (levý softkey) 
a vyberte File Explorer . 

4. Vyberte soubor nebo aplikaci, 
kterou chcete kopírovat nebo pře-
místit (viz. Vyhledávání souborů a 
složek).

TIP Vaše aplikace jsou obvykle umístěny 
v My Device/Program Fines Folder.

5. Stiskněte Menu  (pravý 
softkey) a vyberte Edit > Copy    
nebo Edit > Cut.

6. Stiskněte Menu  (pravý 
softkey) a vyberte Storage Card.

7. Přejděte do složky kam chcete 
umístit vybranou položku.

8. Stiskněte Menu  (pravý 
softkey) a vyberte Edit > Paste.

TIP Můžete také použít volbu vyhledá-
vání ve vašem počítači pro synchronizaci 
softwaru k tomu, aby jste přetáhli a vložili 
soubory do vašeho smartphonu nebo ko-
pírovali soubory mezi vaším smartphonem 
a rozšiřující kartou.

Vyhledávání souborů na rozši-
řující kartě

1. Vložte rozšiřující kartu do otvoru 
pro rozšiřující karty.

2. Stiskněte Home  potom Start 
 (levý softkey).

3. Stiskněte More  (levý softkey) 
a vyberte File Explorer . 

4. Stiskněte Menu  (pravý 
softkey) a vyberte Storage Card.

5. Vyberte složku nebo soubory, 
které chcete zobrazit.

Přejmenování rozšiřující karty
Pokud měníte obsah rozšiřující karty, 
můžete přejmenovat kartu, aby její 
jméno lépe odpovídalo obsahu.
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TIP Před kopírováním informací, pře-
jmenováním souborů nebo složek na 
rozšiřující kartě nebo přejmenováním 
samotné karty se ujistěte, že karta není 
chráněna proti zápisu. Pro více informaci 
se podívejte do návodu karty.

1. Vložte rozšiřující kartu do otvoru 
pro rozšiřující karty.

2. Stiskněte Home  potom Start 
 (levý softkey).

3. Stiskněte More  (levý softkey) 
a vyberte File Explorer . 

4. Stiskněte Menu  (pravý 
softkey) a vyberte My Device.

5. Zvýrazněte aktuální jméno rozšiřující 
karty (standardně Storage card). 

6. Stiskněte Menu  (pravý softkey) 
a vyberte Edit > Rename.

7. Zadejte nové jméno karty.

8. Stiskněte Center .

Kódování rozšiřující karty
Když zakódujete rozšiřující kartu, infor-
mace z ní mohou být přečteny pouze 
na vašem smartphonu, takže nikdo 
neuvidí obsah karty pokud ji ztratíte 
nebo vám je ukradena.

1. Vložte rozšiřující kartu do otvoru 
pro rozšiřující karty.

2. Stiskněte Home  potom Start 
 (levý softkey).

3. Stiskněte More  (levý softkey) 
a vyberte Settings .

4. Vyberte More   a potom 
vyberte Security.

5. Vyberte Encryption.

6. Zaškrtněte rámeček Encrypt fi-
nes placed on storage cards. 

7. Stiskněte Done  (levý softkey).

POZNÁMKA Pokud vaše organizace 
prosadí kódování, zobrazí se vám 
zaškrtnutý rámeček, u něhož nelze 
zrušit odškrtnutí.

Kalkulačka
Kalkulačku můžete použít pro zá-
kladní matematické počty jako jsou 
sčítání, odčítání, násobení a dělení.

Počítání s kalkulačkou

1. Stiskněte Home  potom Start 
 (levý softkey). 
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2. Stiskněte More  (levý softkey) 
a vyberte Accessories .

3. Vyberte Calculator .

4. Používejte číselné klávesy pro 
vkládání čísel.

5. Pro provedení výpočtu proveďte 
následující: 

 Sčítání: Stiskněte Nahoru .  

 Odečítání: Stiskněte Dolů  .

 Násobení: Stiskněte Vlevo  .

 Dělení: Stiskněte Vpravo  .

 Spočítání výsledku: Stiskněte 
Center . 

 Zadání desetinné čárky: 
Stiskněte # klávesu.

 Přepnutí čísla mezi kladným 
a záporným: Stiskněte # klávesu.

POZNÁMKA Před stisknutím * nebo 
# nemusíte stisknout Option .

 Procentuálně vyjádřit zobra-
zené číslo: Stiskněte Menu  
(pravý softkey) a vyberte %.

 Spočítat druhou odmocninu 
ze zobrazeného čísla: Stisk-
něte Menu  (pravý softkey) a 
vyberte (symbol odmocniny).

 Spočítat reciproční hodnotu 
zobrazeného čísla: Stiskně-
te Menu  (pravý softkey) a 
vyberte 1/x.

 Zrušit aktuální kalkulaci a 
zobrazené číslo: Stiskněte 
Clear  (levý softkey).

TIP Pro pokročilejší kalkulace používejte 
Excel Mobile. (viz. Excel Mobile)

Používání paměti kalkulačky
Uložení zobrazeného čísla v 
paměti: Stiskněte Menu  (pravý 
softkey) a vyberte MS.

VĚDĚLI JSTE, ŽE? Když uložíte číslo 
v paměti, toto číslo nahradí aktuálně 
uložené číslo. 

Přidání zobrazeného čísla k 
jinému číslu uloženého v pa-
měti:
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Stiskněte Menu  (pravý softkey) a 
vyberte M+.

Zobrazení čísla uloženého v 
paměti: Stiskněte Menu  (pravý 
softkey) a vyberte MR.

Vymazání paměti: Stiskněte 
Menu   (pravý softkey) a vyberte 
MC.
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Vaše osobní nastavení

Přizpůsobení nastavení je volitelné. Proč nepřizpůsobit váš Palm®Treo™ 
500 smartphone k tomu, aby se ještě více ztotožnil s vaším životním 
stylem a aby pro vás pracoval ještě pilněji.

Můžete snadno přizpůsobit zvuky, písmo, barvy obrazovky a ještě mnoho 
dalších. Využijte různé úrovně bezpečnosti. Zamezte náhodnému usku-
tečnění (drahého) telefonního hovoru zamykáním klávesnice. Je mnoho 
způsobů jak docílit toho, aby pro vás váš smartphone pracoval ještě lépe.

VÝHODY:

·  Šetříte energii 
·  Zabezpečíte váš telefon a vaše data
·  Vytvoříte svou obrazovku snadno čitelnou

KAPITOLA

13
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V této kapitole
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Nastavení domovské 
obrazovky
Výběr pozadí pro domovskou 
obrazovku
Jako pozadí pro svou domovskou 
obrazovku můžete použít nějaký 
obrázek uložený ve smartphonu nebo 
na rozšiřující kartě (v prodeji samo-
statně) vložené ve smartphonu. Váš 
smartphone automaticky vyhledá 
všechny podporované soubory obráz-
ků na vašem smartphonu nebo rozši-
řující kartě a zobrazí je jako možnosti 
seznamu pozadí. 

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings . 

3. Vyberte Home Screen.

4. Vyberte seznam Background 
Image a potom vyberte obrázek, 
který chcete použít.

5. Stiskněte Done  (levý softkey).

VĚDĚLI JSTE, ŽE? Kromě nastavení 
obrázku pro pozadí domovské obrazovky, 
můžete změnit také barevné téma vašeho 
smartphonu (viz. změna barevného téma-
tu systému).

Uspořádání  domovské obrazovky

Můžete si vybrat volbu domácí obra-
zovky, aby zobrazovala nebo skrývala 
položky jako ikony nedávno užíva-
ných aplikací, aktuální kalendáře a 
nové textové nebo emailové zprávy.

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings . .

3. Vyberte Home Screen.
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4. Vyberte seznam Home Screen 
layout a potom vyberte uspořá-
dání, které chcete.

5. Stiskněte Done  (levý 
softkey).

VĚDĚLI JSTE, ŽE? Uspořádání, které si 
vyberete určuje, které položky se zobrazí 
na domácí obrazovce. Např. Windows 
Default zobrazí aktuální kalendář zatímco 
další uspořádání ne. Najděte uspořádání, 
které vám nejvíce vyhovuje výběrem 
jednotlivých uspořádání ze seznamu a 
návratem zpět do domovské obrazovky.

 

Nastavení (systémových) 
zvuků zařízení
Když jste na jednání, v kině nebo 
kdekoli je požadované ticho, můžete 
ztlumit všechny zvuky na smartpho-
nu, včetně oznámení kalendáře a 
systémových zvuků. Toto neovlivňuje 
hovor během volání. Můžete také 
nastavit různé zvukové profily jako 
vibrace.

NEŽ ZAČNETE Pokud chcete 
používat stažené zvukové soubory, 
zvukové soubory na rozšiřující kartě 
(v prodeji samostatně) vložené do 
smartphonu nebo zvukové soubory, 
které jste instalovali  na smartphone, 
ujistěte se, že soubor uložený nebo 
kopírovany do složky My Ringtones 
na smartphonu (viz. Vyhledávání 
informací). Zvukový soubor je potom 
k dispozici pro použití ze zvukových 
nastavení popsaných v této části.

Výběr zvukového profilu
1. Stiskněte Power .

2. Vyberte zvukovou volbu, kterou 
chcete: Normal, Silent (tichý) 
nebo Vibrate. Pro výběr další vol-
by, vyberte More a potom vyberte 
Outdoor nebo Automatic.

POZNÁMKA Když je profil nastavený 
na Silent (tichý),můžete stále poslou-
chat hudbu z reproduktoru vašeho 
smartphonu. Systémové zvuky jako 
je výstraha baterie nebo clona fotoa-
parátu jsou stále ještě slyšitelné.



239

VĚDĚLI JSTE, ŽE? Automatický (auto-
matic) profil přepíná z normálního (normal) 
profilu do vibračního (vibrate), když  kalen-
dáře ve vašem smartphonu signalizuje, že 
máte schůzku.

Přizpůsobení zvukových profilů
Pro každý zvukový profil kromě Auto-
matic můžete přizpůsobit nastavení. Au-
tomatický profil užívá volby, kterou jste 
nastavili pro normální a vibrační profil.

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings .

3. Vyberte Profiles.

4. Zvýrazněte profil, který chcete 
přizpůsobit.

5. Stiskněte Menu  (pravý 
softkey) a vyberte Edit.

6. Nastavte některou z následujících voleb:

 Name: Specifikuje jméno profilu.

 Ring type: Nastavuje vyzvánění 
přidružené k tomuto profilu.

 Ring volume: Nastavuje 
hlasitost zvonění přidruženého k 
tomto profilu.

 Alarm type: Nastavuje druh 
alarmu při používání tohoto profilu.

 Alarm volume: Nastavuje hlasi-
tost alarmu u tohoto profilu.

 Reminder type: Nastavuje druh 
upomínky při používání tohoto 
profilu.

 Reminder volume: Nastavuje 
hlasitost upomínky při používání 
tohoto profilu.
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 Notification type: Nastavuje 
druh oznámení při používání toho-
to profilu.

 Notification volume: Na-
stavuje hlasitost oznámení při 
používání tohoto profilu.

 System sound volume: Na-
stavuje hlasitost všech systémo-
vých zvuků při používání tohoto 
profilu.

7. Stiskněte Done  (levý softkey).

TIP Pro obnovení standardního nastavení 
profilu, zvýrazněte profil, stiskněte Menu 
(pravý softkey) a potom vyberte Reset to 
default.

Výběr zvuků & oznámení

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings .

3. Vyberte Sounds.

4. Nastavte některou z následujících 
voleb:

POZNÁMKA Pro výběr zvukové vol-
by spojené s telefonními hovory (viz. 
Výběr zvonění a zvuků výstrahy).

 Reminders (Upomínky): Nasta-
vuje tón výstrahy pro kalendář a 
úkolové upomínky.

 New email (Nový email): 
Nastavuje tón výstrahy pro nové 
příchozí emailové zprávy.

 New text message (Nová 
textová zpráva): Nastavuje tón 
výstrahy pro novou příchozí texto-
vou nebo multimediální zprávu.

 New instant message: 
Nastavuje tón výstrahy pro nové 
příchozí okamžité zprávy, pokud 
máte nastaven Windows Live 
Messenger (viz. Použití Windows 
Live Messenger).
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 New channel message: 
Nastavuje tón výstrahy pro nová 
příchozí systémová hlášení od va-
šeho bezdrátového poskytovatele 
služeb.

 Alarm clock: Nastavuje tón bu-
díku (viz. Nastavení systémových 
alarmů).

 SIM toolkit messages: Nasta-
vuje tón výstrahy pro nové příchozí 
zprávy spojené se SIM toolkit, po-
kud váš bezdrátový poskytovatel 
služeb, službu SIM toolkit aktivoval 
(viz. Použití SIM toolkit).

 Exclamation/Question/War-
nings: Nastavuje tóny pro různé 
typy systémových výstrah na 
smartphonu.

VĚDĚLI JSTE, ŽE? Vykřičníky, dotazy a 
varování jsou výstrahy, které vyžadují určitý 
druh vašeho vstupu. Představují tři různé 
úrovně důležitosti, vykřičníky představují 
kritické chyby, které vyžadují váš vstup.

 Keypad control: Specifikuje 
jestli uslyšíte tón nebo kliknutí, 
když stisknete klávesu.

TIP Pro většinu výstrah můžete vybrat Vi-
brate (vibrovat), aby váš smartphone raději 
vibroval než dělal nějaké zvuky. Můžete také 
vybrat None (žádný) pro nepřijímání vůbec 
žádných zvuků.

VĚDĚLI JSTE, ŽE? Když vyberete zvuk, 
vybraný zvuk ještě krátce hraje, aby jste si 
jej mohli poslechnout a poté vybrat.

TIP Pro výmaz zvuků, stiskněte Menu 
(pravý softkey) a vyberte Delete Sounds. 
Můžete vymazat jen zvuky vámi přidané.

Nastavení volby varování
Můžete nastavit interval časového 
limitu pro výstrahy, který požaduje 
interakci uživatele (např. Varování a 
otázky) a nastavit hlasitost pro výstra-
hy, které přijmete v průběhu volání.

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings .

3. Vyberte More a potom vyberte 
Accessibility.

4. Nastavte některou z následujících voleb:

 Confirmation time out: Na-
stavuje časový interval výstrahy, 
která vyžaduje interakci uživatele
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 a zobrazí se před překročením 
časového limitu.

 In-call alert volume: Specifi-
kuje hlasitost výstrahy přijaté v 
průběhu hovoru.

5. Stiskněte Done  (levý softkey).

Nastavení 
vzhledu zobrazení
Regulování jasu

1. Stiskněte Option  a potom 
stiskněte P .

2. Stiskněte Vlevo  nebo Vpravo 
 pro nastavení jasu.

3. Stiskněte Done  (levý softkey).

Změna velikosti textu 
Můžete nastavit větší text na obra-
zovce pro snadnější prohlížení. Toto 
ovlivňuje text uvnitř všech aplikací 
a nastavení obrazovky, nepůsobí na 
text na domácí obrazovce.

POZNÁMKA Velikost textu na domácí 
obrazovce je určena vámi vybraným 
nastavením uspořádání obrazovky (viz. 
Uspořádání domovské obrazovky).

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings .

3. Vyberte More  a potom vyber-
te Accessibility. 

4. Vybrat System font size.

5. Stiskněte Vpravo  nebo Vlevo 
  pro nastavení velikosti textu. 

6. Stiskněte Done  (levý softkey).

Nastavení formátu zobrazení

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings .

3. Vyberte More  a potom vyber-
te Regional Settings.



243

4. Rolujte mezi poli a přizpůsobujte 
formátové nastavení. Všimněte si 
následujícího:

 Locale: Nastavuje standardní 
formátové nastavení. Nastavení 
lokality určuje všechny formáty 
zobrazení (datum, čas, atd.) na  
smartphonu, pokud nepoužíváte 
jiné Regional Settings pole k 
tomu, aby jste vybrali odlišný for-
mát pro specifický typ zobrazené 
položky.

 Short/Long date style: Nasta-
vuje krátké nebo dlouhé zobrazení 
datumu. 

 Time format: Nastavuje zobra-
zení času, oddělovače a AM a PM 
symboly.

 Positive/Negative number: 
Nastavuje desetinný symbol 
a množství desetinných míst, 
seskupování číslic a velikost se-

skupení, pořadí oddělovačů, sym-
bol záporného znaménka čísla a 
formát, zobrazení počáteční nuly 
a metrický systém.

 Positive/Negativ currency: 
Nastavuje symbol měny a pozici, 
desetinný symbol a pozici, sesku-
pování číslic a velikost seskupení 
a formát záporného čísla.

5. Stiskněte Done  (levý softkey).

Změna systémového barevné-
ho schématu

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings .

3. Vyberte Home Screen.

4. Vyberte seznam Color Scheme a 
potom vyberte schéma, které chcete.

5. Stiskněte Done  (levý softkey).

TIP Můžete také nastavit pozadí pro 
Domovskou obrazovku (viz. Výběr pozadí 
domovské obrazovky).
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Nastavení aplikací
Vytvoření klávesové zkratky
Můžete vytvořit klávesové zkratky 
pro aplikace, které používáte často, 
aby jste k nim měli rychlý přístup. Na 
smartphonu se tyto zkratky nazývají 
rychlé vytáčení.

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Zvýrazněte aplikaci pro kterou 
chcete vytvořit zkratku. Bude-li 
to nezbytné stiskněte More (levý 
softkey) dokud se aplikace, kte-
rou chcete nezobrazí.

3. Stiskněte Menu  (pravý softkey) 
a vyberte Add speed dial.

4. (volitelné) Pro změnu jména této 
zkratk, vyberte Name a vložte 
nové jméno.

VĚDĚLI JSTE, ŽE? Významové pole 
vždy zobrazuje aktuální jméno aplikace, i 
když změníte jméno zkratky.

5. Vyberte seznam Keypad assign-
ment a potom vyberte klávesu, 
kterou chcete přidělit této aplikaci.

VĚDĚLI JSTE, ŽE? Můžete vybrat kláve-
su, která je již přiřazená k jiné aplikaci. Ob-
jeví se výstraha dotazující zda potvrzujete, 
že chcete zaměnit existující aplikaci za 
novou. Číslo 0 je rezervováno pro vkládání 
+ symbolu v telefonním čísle a číslo 1 je 
rezervováno  pro vytáčení hlasové schrán-
ky. Nemůžete přiřadit ani jedno z těchto 
čísel k volbě rychlého vytáčení.

6. Stiskněte Done  (levý softkey). 
Pro zpřístupnění aplikace, stiskněte 
a přidržte klávesovou zkratku.

TIP Pro zobrazení všech aktuálních zkra-
tek stiskněte Home, stiskněte Start (levý 
softkey),stiskněte 2x More (levý softkey) a 
potom vyberte Speed Dial. Pro vymazání 
zkratky, zvýrazněte zkratku, kterou chcete 
vymazat, stiskněte Menu (pravý softkey) 
a potom vyberte Delete. Stiskněte Yes 
(levý softkey) pro potvrzení.

TIP Můžete také vytvořit rychlé vytáčení 
pro vytočení kontaktního telefonního čísla 
(viz. Rychlá volba vytáčení).
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Nastavovací volby vstupu

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings .

3. Vyberte 2x More  a potom 
vyberte Text Input Setting.

4. Nastavte některou z následujících 
voleb: 

 Input Language (vstupní jazyk): 
Specifikuje jazyk užívaný, když 
zadáváte informace použitím 
klávesnice.

 Suggest words when ty-
ping: Signalizuje zda se návrhy 
slov zobrazí při zadávání textu. 
Můžete také specifikovat kolik 
písmen vložíte, než se objeví ná-
vrh a kolik návrhů chcete zobrazit.

TIP Pro vložení navrhovaného slova, stisk-
něte Down, zvýrazněte návrh a potom 
stiskněte Center pro přijetí.

TIP Pro vymazání všech položek ze se-
znamu slovních návrhů, stiskněte Menu 
(pravý softkey) a vyberte Clear Input 
History.

 

 Add a space after word: Spe-
cifikuje zda se prostor jeví potom 
co vy vložíte navrhované slovo.

 Enable auto-correct: Signa-
lizuje jestli jsou opraveny běžné 
Chyby v pravopise automaticky.

5. Stiskněte Done  (levý softkey).

TIP Můžete také nastavit časový interval, 
který musí uplynout před tím, než kláves-
nice pozná, že jste stiskli stejnou klávesu. 
Stiskněte Home, stiskněte Start (levý 
softkey), stiskněte More (levý softkey) a 
potom vyberte Settings. Vyberte More 
a potom vyberte Accessibility. Vyberte 
seznam  Multipress time out a potom 
vyberte časový interval.

Zamykání smartphonu 
a informací
Váš smartphone obsahuje něko-
lik funkcí, které vám pomohou jej 
ochránit před náhodným použitím 
a udrží vaše informace v soukromí. 
Zabudovaný bezpečnostní software 
vám dovolí používat smartphone pro 
tísňová volání, i když je zamčený. 
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 Můžete uzamknout některou z 
následujících:

 Keyboard: Ručně vyřazuje 
všechny klávesy, aby se předešlo 
náhodným stiskům ve vaší aktov-
ce nebo kapse.

 SIM card: Požaduje PIN k tomu, 
aby se zapnul váš telefon a vy 
jste mohli přijímat hovory.

 Smartphone: Požaduje heslo, 
aby jste mohli zobrazit informace 
na smartphonu.

Uzamykání klávesnice
Proveďte následující:

• Stiskněte a přidržte End .

• Stiskněte Power  a vyberte Lock.

TIP Pokud používáte náhlavní soupravu 
nebo hands-free zařízení a váš smart-
phone je v kapse nebo tašce, můžete 
uzamknout klávesnici během volání, aby 
se předešlo náhodným stisknutím kláves.

Odemknutí klávesnice
Když je klávesnice zamčená, násle-
dujte tyto kroky k odemknutí.

1. Stiskněte Unlock  (levý softkey).

2. Stiskněte klávesu * (nemusíte 
nejprve stisknout Option )

Zamykání SIM karty

Můžete uzamknout vaši SIM kartu a 
předejít tak neautorizovanému použití 
vašeho mobilního účtu. Když je vaše 
SIM karta zamčená, musíte vložit PIN 
k tomu, aby jste mohli přijímat hovo-
ry a uskutečňovat volání, s výjimkou 
čísel tísňového volání. SIM karta 
zůstává zamčená dokonce i když pře-
místíte kartou do jiného telefonu.

NEŽ ZAČNETE 

• Ujistěte se, že je váš telefon za-
pnutý a že se nacházíte v oblasti   
mobilního pokrytí (viz. Zapínání 
telefonu).

• Získejte váš standardní PIN od 
vašeho bezdrátového poskytova-
tele služeb.

TIP PIN je čtyřmístné číslo natištěné na 
kartě, kterou jste dostali se SIM kartou. 
Uložte PIN kartu na bezpečném umístění 
pro případ, že by jste zapomněli PIN.

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings .

3. Vyberte More  a potom vyber-
te Security. 
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4. Vyberte Unable SIM PIN.

5. Vložte PIN a stisněte Done  
(levý softkey).

6. Vypněte telefon pro aktivaci funk-
ce zamykání SIM.

Když je vaše SIM karta zamčená mů-
žete ji odemknout zapnutím smart-
phonu a vložením PIN kódu, pokud 
budete vyzváni. A objeví se číselný 
blok pro zadání PIN kódu.

TIP Můžete vypnout zámek SIM karty, 
abyste již nemuseli zadávat PIN při 
zapínání smartphonu. Následujte kroky v 
předchozím postupu, ale vyberte Disable 
SIM PIN v kroku 4.

POZNÁMKA Váš PIN kód potřebu-
jete k tomu, aby jste mohli editovat 
váš PIN kód nebo odstranit funkci 
uzamknutí. Pokud zadáte nesprávný 
PIN vícekrát než je povoleno vaším 

bezdrátovým poskytovatelem služeb, 
SIM karta již nemůže být odemčena 
zadáním PIN kódu. Pokud se toto sta-
ne, potřebujete PUK (PIN unlock key) 
pro odemknutí SIM karty. Kontaktujte 
vašeho bezdrátového poskytovatele 
služeb pro více informací o PUK.

Zamykání smartphone
Pro ochranu vašich osobních informa-
cí, můžete uzamknout systém, takže 
je třeba zadat heslo pro zpřístupnění 
informací nebo funkcí smartphonu.

DŮLEŽITÉ Pokud uzamknete sys-
tém, musíte vložit přesné heslo pro 
odemknutí. Pokud vložíte nesprávné 
heslo, dostanete další šance. Vždy 
když je vloženo nesprávné heslo, 
dostanete postupně delší dobu na 
další šanci. Pokud zapomenete heslo, 
musíte provést tvrdý reset, aby jste 
mohli znovu používat váš smartpho-
ne. Provedení tvrdého resetu smaže 
všechny záznamy, všechny aplikace 
ve vašem smartphonu, které jste při-
dali, např. aplikace odjinud. Nicméně 
můžete všechno obnovit synchroni-
zací informací při příští synchronizaci.
(viz. synchronizace informaci).
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1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings .

3. Vyberte More  a potom vyber-
te Security.

4. Vyberte Device Lock.

5. Zaškrtněte rámeček Prompt 
if device unused for zapíná 
funkci hesla.

6. Vyberte první pole a potom vy-
berte jak dlouhé musí být období     
nečinnosti, aby se smartphone 
zamknul.

7. Vyberte Password type a 
potom vyberte formát pro heslo:

 Simple (jednoduchý) PIN: 
Jednoduchý PIN musí obsahovat 
přinejmenším čtyři znaky a skládá 
se pouze z čísel. Nemusíte stisk-
nout Option  před zapsaním 
čísel PIN kódu.

 Strong alphanumeric (silný 
alfanumerický): Silné alfanu-
merické heslo musí obsahovat 
přinejmenším sedm znaků a musí 
obsahovat kombinaci písmen, čí-
sel a interpunkce. Před vložením 

čísel nebo interpunkce musíte 
stisknout Option  nebo Alt 

8. Vyberte Password a zadejte 
heslo.

9. Vybrat Confirm password a 
zadejte heslo znovu.

10. Stiskněte Done  (levý softkey).

11. Stiskněte Yes  (levý softkey) 
pro potvrzení hesla.

TIP Pokud uzamknete smartphone a 
vyberete jednoduchý PIN, jako typ hesla, 
můžete vytočit naléhavý hovor vložením 
čísla do pole pro zadávání hesla a stisk-
nutím Phone/Send. Nemusíte stisknout 
Option před vložením čísla. Pokud si vybe-
rete silné alfanumerické heslo, musíte 
nejprve stisknout  2x Option před vlože-
ním hesla nebo čísla tísňového volání.

Vkládání vlastních informací
Můžete vložit osobní informace pro 
spojení se smartphonem, např. vaše 
jméno, jméno společnosti a telefonní 
číslo. Pokud ztratíte smartphone, tato 
funkce může napomoci osobě, která 
jej nalezla, k jeho vrácení.
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1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings .

3. Vyberte 2x More  a potom 
vyberte Owner Information.

4. Zadejte jakoukoli informaci, 
kterou chcete zahrnout. Užívej 
poznámková pole k tomu, aby 
jste vložili dodatečný text.

5. Stiskněte Done  (levý softkey).

Systémová nastavení
Nastavení data a času
Používejte Clock & Alarm settings 
pro nastavení časového pásma, času 
a data vaší domácí adresy a míst, kte-
ré navštívíte. Pro nastavení formátu 
zobrazení data a času (viz. Nastavení 
formátů zobrazení).

1. Stiskněte Home  potom Start 
  (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings .

3. Vyberte Clock & Alarm a 
potom vyberte Date and Time.

4. Vyberte seznam Time zone a 
potom vyberte časové pásmo.

5. Vyberte Date a vložte datum.

6. Vyberte Time a vložte čas. 
Pokud váš formát času zobrazuje 
AM a PM, stiskněte A  nebo P 

 klávesu pro výběr volby nebo 
stiskněte jakoukoli číselnou kláve-
su pro přepínání mezi AM a PM.

7. Stiskněte Done  (levý softkey).
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Nastavení systémových alarmů
Systémové alarmy vám umožní na-
stavit alarmy, které nejsou přidružené 
k úkolům nebo schůzkám. Například 
můžete použít váš smartphone jako 
budík, když cestujete nebo nastavit 
alarmy, aby vám připomněli, že si 
máte vzít léky nebo vyzvednout děti.

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings .

3. Vyberte Clock & Alarm a 
potom vyberte Alarm.

4. Vyberte Alarm time a vložte 
čas. Pokud formát času zobrazuje    
AM a PM, stiskněte A  nebo P 

 klávesu a vyberte volbu nebo 
stiskněte kteroukoli číselnou klá-
vesu pro přepnutí mezi AM a PM.

5. Vyberte seznam Alarmu a 
potom vyberte zda chcete alarm 

nastavit na všední dny nebo na 
každý den.

6. Stiskněte Done  (levý softkey).

TIP Použijte Sounds & Notifications 
nastavení k tomu, aby jstezměnili zvuk 
alarmu (viz. Výběr zvuků & oznámení).

Certifikáty identity
Váš smartphone obsahuje předin-
stalované certifikáty. Certifikáty jsou 
digitální dokumenty, které jsou použí-
vané pro ověření a změny informací o 
sítích. Certifikáty mohou být vydané 
pro uživatele, zařízení nebo službu.

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings .

3. Vybrerte More  a potom 
vyberte Security.

4. Vyberte Certificates.
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5. Vyberte typ certifikátu, který chcete 
zobrazit:

 Personal: Zobrazuje certifikáty, 
které stanoví vaši identitu při přihlá-
šení do systému zabezpečené sítě 
např. korporační sítě.

 Intermediate: Zobrazuje certifiká-
ty vydané pro root jehož účelem je 
vydání osobních certifikátů.

 Root: Zobrazuje certifikáty, které 
identifikují počítače např. servery, 
ke kterým se připojujete. Tyto 
certifikáty pomáhají zabránit neauto-
rizovaným uživatelům zpřístupnění 
vašeho smartphonu a informací.

6. Prověřte jeden z následujících:  
View certificate details( zobra-
zení podrobností o certifikátu): Zvý-
razněte certifikát, stiskněte Menu 

 (pravý softkey) a potom vyberte 
View. Stiskněte Done  (levý 
softkey), když skončíte prohlížení 
detailů.

 Delete a certificate: Zvýrazně-
te certifikát, stiskněte Menu  
(pravý softkey) a potom vyberte 
Delete. Stiskněte Yes  (levý 
softkey) pro potvrzení zrušení.

7. Stiskněte Done  (levý softkey).

Kolik mi zbývá paměti k ukládání?

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) a 
vyberte Settings .

3. Vyberte 2x More   a potom 
vyberte About. Rolujte dolů pro zob-
razení dostupné paměti a celkovou 
paměť.

TIP Pokud je nízká skladovací paměť, zvažte 
použití rozšiřující karty pro ukládání souborů 
(viz. Použití rozšiřujících karet).  
Pokud je nízká programová paměť, zavřete 
některé aplikace, aby jste se vyhnuly 
pomalému výkonu smartphone (viz. Zavírání 
aplikací).

TIP Potom vyberete More dvakrát v kroku 
3, vyberte System Information pro zobrazení 
informací o smartphonu např. sériové číslo, 
verze software atd. Tato informace může 
být užitečná pokud potřebujete kontaktovat 
podporu.

4. Stiskněte Done  (levý softkey).

Optimalizace nastavení výkonu

1. Stiskněte Home  potom Start 
 (levý softkey).
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2. Stiskněte More  (levý softkey) 
a vyberte Settings 

3. Vyberte More  a potom vyber-
te Power Management. Lišta 
baterie zobrazuje zbývající energii 
ve vaší baterii.

4. Vyberte kteroukoli z následujících 
voleb:

 Backlight time out on batte-
ry: Specifikuje jak dlouho zůstává 
podsvětlená klávesnice během 
období nečinnosti, kdy váš smart-
phone využívá baterii.

 Backlight time out on AC: 
Specifikuje jak dlouho zůstává 
podsvětlená klávesnice během 
období nečinnosti, když je smart-
phone připojený k nabíječce.

 Display time out: Specifikuje 
kolik minut zůstává obrazovka za-
pnutá během období nečinnosti.

5. Stiskněte Done  (levý softkey).

Vypínání a zapínání bezdráto-
vých služeb
1. Stiskněte Power  a vyberte 

Wireless Manager.

2. Vyberte Bluetooth nebo Phone  
pro vypnutí nebo zapnutí některé 
z těchto funkcí. Vyberte All pro 
vypnutí nebo zapnutí všech bez-
drátových funkcí.

TIP Pro změnu nastavení jedné ze zob-
razených bezdrátových funkcí, stiskněte 
Menu (pravý softkey) a vyberte bezdráto-
vou funkci, kterou chcete změnit.

3. Stiskněte Done  (levý softkey).
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Aktualizace systémového sofwaru
Windows Update vám umožní 
stáhnout na váš smartphone bez-
pečnostní aktualizace a další důležité 
aktualizace softwaru operačního 
systému Windows Mobile. 

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings .

3. Vyberte 2x More  a potom 
vyberte Windows Update.

4. Na obrazovce aktualizace nasta-
vení stiskněte Next  (pravý 
softkey).

TIP Vyberte View privacy statment pro 
čtení o tom, jak používání Windows 
Update ovlivňuje osobní informaci o 
smartphonu.

5. Vyberte, zda chcete zapnout 
Windows Update manuálně nebo 
chcete, aby aktualizace probíhala 
automaticky a potom stiskněte 
Next  (pravý softkey).

TIP Pro úsporu životnosti baterii dopo-
ručujeme, abyste vybrali manuální volbu 
aktualizace Windows.

6. Pokud jste vybrali automatickou 
aktualizaci zaškrtněte rámeček     
Use my data plan to check for 
and download updates, pokud 
chcete používat váš datový rozvrh 
namísto základního bezdrátového 
rozvrhu pro aktualizaci smartpho-
nu. Používání datového rozvrhu 
znamená, že aktualizace se mohou 
vyskytovat častěji, což může mít 
za následek zvýšení účtu za data. 
Stiskněte Next (pravý softkey).

7. Stiskněte Done  (levý softkey).    
Pokud vyberete Automatic v kroku 
6, Windows Update pravidelně 
zkontroluje a stáhne aktualizace 
automaticky. Pokud jste vybrali 
Manual v kroku 6, můžete kontro-
lovat aktualizace kdykoli otevřením 
Windows Update a stisknutím 
Check Now  (levý softkey).
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TIP Pro přepínání mezi manuální a auto-
matickou aktualizací, otevřete Windows 
Update, stisknněte Menu (pravý softkey) 
a potom vyberte Change Schedule. Pro 
výběr nebo zrušení volby použijte datové-
ho rozvrhu, aby kontroloval a stahoval ak-
tualizace, stiskněte Menu (pravý softkey) 
a vyberte Connections.

8. Pro zobrazení detailních výsledků 
poslední kontroly aktualizace, 
stiskněte Menu (pravý softkey) a 
vybere View details.

Nastavení spojení
Manuální vložení nastavení 
telefonních spojení 
Váš smartphone je již nastavený na 
připojení k Internetu použitím vysoko-
rychlostního datového spojení v síti 
vašeho bezdrátového poskytovatele 
služeb. Pro připojení k Internetu, 
zapněte Internet Explorer Mobile.

Pro zvláštní situace, jako připojování 
k poskytovateli připojení k Internetu 
(ISP) nebo k dálkovému přístupu 
serveru (RAS), můžete nastavit další 
připojení.

NEŽ ZAČNETE Získejte následující 
informace od vašeho poskytovatele 
internetových služeb nebo správce 
systému:

• Typ sítě, ke které se připojujete: 
Internet, MMS, WAP atd.

• Telefonní čísla ISP serveru nebo 
připojení

• Uživatelské jméno

• Heslo

• Doména (pokud nějaká je).

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings 

3. Vyberte Connections a potom 
vyberte Dial-up.

4. Vyberte spojení, které chcete zobra-
zit nebo změnit, nebo pro vytvoření 
nového spojení, vyberte New.

5. Pokud je to nové spojení, vyberte 
Description a vložte jméno spojení.

6. Vyberte pole Connects to a 
potom vyberte typ sítě, ke které 
se připojujete.
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7. Vyberte Phone number, User 
name, Password a Domain a 
zadejte informace, které jste získali 
o vašem ISP nebo správci systému.

8. Stiskněte Done  (levý softkey).

TIP Pro výmaz telefonního spojení, 
zvýrazněte spojení, stiskněte Menu (pravý 
softkey) a potom vyberte Delete. Stiskněte 
Yes (levý softkey) pro potvrzení zrušení.

Manuální vložení nastavení  
síťového spojení
Váš smartphone je již nastavený na 
připojení k Internetu použitím vysoko-
rychlostního datového spojení v síti 
vašeho bezdrátového poskytovatele 
služeb. Pro připojení k Internetu, pro-
stě zapněte Internet Explorer Mobile. 

Pro zvláštní situace, např. pokud 
používáte jinou SIM kartu od jiného 
poskytovatele bezdrátových služeb, 
je třeba, abyste manuálně vložili 
nastavení sítě.

PŘEDTÍM NEŽ VY ZAČNETE Získejte 
následující informace od vašeho 
poskytovatele internetových služeb 
nebo správce systému. V závislosti 
na síti nebudete potřebovat vkládat 
nastavení pro každou z těchto voleb: 

• Typ sítě, ke které se připojujete: 
Internet, MMS, WAP atd.

• Jméno připojení (SSID)

• Uživatelské jméno

• Heslo

• Typ oprávnění (pokud nějaké je)

• Primární a sekundární DNS adre-
su serveru

• IP adresu

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings 

3. Vyberte Connections a potom 
vyberte GPRS.

4. Vyberte spojení, které chcete 
zobrazit nebo změnit, pro vytvoře-
ní nového spojení, vyberte New.

5. Pokud je to nová síť, vyberte 
Description a vložte nové jmé-
no pro spojení.
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6. Vyberte každé pole a zadejte 
informace, které jste získali od va-
šeho poskytovatele bezdrátových 
služeb.

7. Stiskněte Done  (levý softkey).

TIP Pro zrušení síťového spojení, zvýrazněte 
spojení, stiskněte Menu (pravý softkey) a 
potom vyberte Delete. Stiskněte Yes (levý 
softkey) pro potvrzení zrušení.

POZNÁMKA Pokud manuálně vložíte 
nastavení sítě a potom vložíte SIM 
kartu od vašeho bezdrátového 
poskytovateleslužeb do smartphonu, 
nastavení v SIM kartě potlačí vaše 
manuální nastavení. Pokud později 
použijete jinou SIM kartu, opět je 
třeba vložit data síťového nastavení.

Spojení s VPN
Pokud chcete používat váš smartpho-
ne pro přístup ke korporačnímu emai-
lovému účtu nebo jiným souborům 
na korporačním serveru, bude třeba 
nastavit VPN (virtuální soukromou 
síť). VPN vám umožní přihlášení do 
systému vašeho korporačního serve-
ru přes firemní firewall.

NEŽ ZAČNETE Kontaktujte firemního 
správce systému pro informaci, zda 
požaduje VPN  pro zpřístupnění kor-
porační sítě. Pokud potřebujete VPN 
musíte si koupit a instalovat VPN 
klienta pro použití této funkce. 

Získejte následující informace od 
korporačního správce systému:

• VPN Typ: IPSEC/L2TP nebo PPTP

• Vaše serverové jméno

• Typ sítě, z které se připojujete a 
typ sítě, ke které se připojujete: 
Internet, MMS, WAP atd.

• Vaše VPN uživatelské jméno a heslo

• Vaše serverové doménové jméno

• IPSEC typ oprávnění (pokud je)

• IPSEC preshared key(společné 
heslo) (pokud je)

1. Instalujte vašeho VPN klienta 
odjinud (viz. Instalace aplikací).

2. Stiskněte Home  potom Start 
 (levý softkey).

3. Stiskněte More  (levý softkey) 
a vyberte Settings .

4. Vyberte Connections, vyberte 
More a potom vyberte VPN.
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5. Vyberte spojení, které chcete zob-
razit nebo změnit, nebo vytvořte 
nové spojení, vyberte New.

6. Pokud je to nové spojení, vyberte 
Description a vložte jméno spojení.

7. Vyberte každé pole a zadejte 
informace, které jste získali od 
vašeho správce systému.

8. Stiskněte Done  (levý softkey).

Nastavení proxy serveru

NEŽ ZAČNETE Získejte následující in-
formace od vašeho ISP nebo správce 
systému:

• Typ sítě, z které se připojujete 
a typ sítě ke které připojujete: 
Internet, MMS, WAP atd

• Jméno proxy serveru, port num-
ber a typ

• Uživatelské jméno 

• Heslo

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings .

3. Vyberte Connections, vyberte 
More a potom vyberte Proxy.

4. Vyberte spojení, které chcete 
zobrazit nebo změnit, pro vytvoře-
ní nového spojení, vyberte New..

5. Pokud je to nová síť, vyberte 
Description a vložte nové jméno 
pro spojení.

6. Vyberte každé pole a zadejte 
informace, které jste získali od 
vašeho správce systému.

7. Stiskněte Done  (levý softkey).

Vložení nastavení pokročilých 
spojení

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings .

3. Vyberte Connections.

4. Stiskněte More (levý softkey) a 
vyberte Advanced.

5. Pro každý typ spojení např. Internet, 
Work, WAP a Secure WAP vyberte 
volbu spojení, kterouchcete.

6. Proveďte některou následující 
Set connection options (na-
stavte volby spojení): Zvýrazněte 
pole obsahující typ spojení, stisk-
něte Menu  (pravý softkey) a 
potom vyberte Options.   
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 Nastavte počet pokusů opětovné-
ho vytáčení, interval pro odpojení 
po uplynutí doby nečinnosti a typ 
spojení. Stiskněte Done  (levý 
softkey).

 Exclude a work URL from 
these settings (vyjmutí pracovní 
URL z těchto nastavení): Zvýrazněte 
spojení, stiskněte Menu  (pravý 
softkey) a potom vyberte Work 
URL Exceptions. Stiskněte 
Menu  (pravý softkey), vyberte 
Add a potom vložte vzor pro URL, 
který chcete vyjmout. Stiskněte 
Done  (levý softkey).

TIP Na Work URL obrazovce vyjmutí, 
zvýrazněte URL, stiskněte Menu (pravý 
softkey) a potom vyberte Edit nebo De-
lete pro vytvoření změn nebo vymazání 
vyjímky.

7. Stiskněte Done  (levý softkey).

Ukončení datového spojení
Pokud váš tarif zahrnuje poplatky za 
délku trvání datového spojení, může-
te snížit náklady ukončením datového 
spojení po ukončení brouzdání po 
webu.

1. Stiskněte Power  a vyberte 
Wireless Manager.

2. Stiskněte Menu  (pravý 
softkey) a vyberte Disconnect 
Cellular Data.
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Řešení problémů

Ačkoli nemůžeme předvídat všechny situace, které by mohli nastat,
tato kapitola poskytuje užitečné informace a odpovědi na některé
nejvíce kladené otázky. Pro další informace a technickou podporu, 
navštivte www.go.palm.com/treo500/.

KAPITOLA

14
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Přenášení informací 
z jiného zařízení

Pro informaci o přenášení informa-
cí z předchozího Microsoft Win-
dows®Mobile® zařízení nebo z Palm 
OS® zařízení od ACCESS na váš 
nový Palm® Treo™ 500 smartphone, 
navštivte go.palm.com/treo500/.

VĚDĚLI JSTE, ŽE? Můžete koupit odji-
nud pocházející aplikaci, která vám umožní 
spustit Palm OS® ACCESS aplikaci na váš 
smartphonu.

VĚDĚLI JSTE, ŽE? Pokud máte otázky 
na Windows Mobile, můžete se podívat 
na webovou stránku Microsoft Windows 
Mobile. Pro info hledejte Palm zařízení.

DŮLEŽITÉ Nepoužívejte zálohovací 
program pro převádění informaci z 
jiného zařízení na nový smartphone. 
Můžete tím způsobit špatnou funkci 
smartphonu.

Reinstalování 
desktop softwaru
Pokud máte problém se synchroniza-
cí, pomocí synchronizačního softwa-
ru, bude třeba jej znovu nainstalovat.

PŘEDTÍM NEŽ ZAČNETE 
Ujistěte se, že váš počítačový profil 
zahrnuje oprávnění správce na instalaci 
softwaru. Ve velkých organizacích, jsou 
povoleny od správcem systému.

1.  Vypněte počítač a znovu jej 
zapněte.

2.  Na počítači klikněte na Start 
> Control Panel > Add or 
remove programs.

3.  Odstraňte desktop software. 
Pro počítače s Windows XP, 
se software nazývá Microsoft 
ActiveSync®. Pro počítače s Win-
dows Vista, se software nazývá 
Windows Mobile Device Center.
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4.  Vypněte všechny aktivní aplikace, 
včetně virových scannerů a inter-
netových bezpečnostních aplikací.

5. Pro reinstalování softwaru, vložte 
Windows Mobile Getting Started 
CD do počítačové CD mechaniky 
a následujte instrukce na obra-
zovce (viz. Instalace ActiveSync® 
desktop softwaru: Windows XP 
nebo instalace Windows Mobile 
Device Center:  Windows Vista).

DŮLEŽITÉ Musíte instalovat desk-
top synchronizační software, který 
stáhnete z Windows Mobile Getting 
Started CD (součástí balíčku smart-
phonu). Jiné verze s tímto smartpho-
nem nefungují.

VĚDĚLI JSTE, ŽE? Pokud chcete 
synchronizovat s jiným PIM (osobním 
manažerem Informací), musíte instalovat 
odjinud pocházející řešení. Kontaktujte 
PIM prodavače softwaru pro váš smart-
phone.

Resetování 
smartphonu
Provedení měkkého resetu 
Provedení měkkého resetu je podob-
né restartování počítače. Pokud váš 
smartphone nereaguje nebo máte 
problém se synchronizovat se s počí-
tačem, měkký reset může pomoci.

1.  Držte smartphone obrazovkou 
dolů, použijte dva nebo více prstů 
pro stlačení krytu proti baterii. 
Potom sesuňte kryt ze zadní části 
smartphonu.
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2.  Odstraňte a znovu vložte baterii a 
potom vraťte zpět kryt baterie.p y

3.  Stiskněte a přidržte Power  
dokud se neobjeví logo Palm®.

VĚDĚLI JSTE, ŽE? Pokud byl telefon 
nebo funkce Bluetooth® bezdrátové tech-
nologie zapnuty před resetem, automatic-
ky se po resetování zapnou.

Provedení tvrdého resetu
Tvrdý reset maže veškeré osobní in-
formace jako jsou schůzky, kontakty 
a úkoly, stejně tak programy, které 
jste přidali a software jiných firem ze 
smartphonu. Nikdy nedělejte tvrdý 
reset bez předešlého vyzkoušení 
měkkého resetu. Můžete obnovit 
dříve synchronizované informace při 
příští synchronizaci.

DŮLEŽITÉ 
Synchronizujte obnovená Micro-
soft Office Outlook® data, jako jsou 
Outlook email, kalendář, kontakty a 
úkoly. Můžete také použít zálohování 
a řešení obnovení.  Ujistěte se, že je 
aplikace schválená Palmem.

TIP Některé odjinud pocházející aplikace 
se při synchronizaci nezálohují na vašem 
počítači. Pokud provedete tvrdý reset,  
můžete ztratit informace z těchto aplikací 
a bude třeba je znovu nainstalovat na váš 
smartphone. Prosím kontaktujte prodejce, 
abyste zjistili, jestli jsou informace  z těch-
to aplikací zálohovány při synchronizaci.

VĚDĚLI JSTE, ŽE? Když synchronizujete 
po tvrdém resetu, zdrojová složka v My 
Documents se změní z Treo My Docu-
ments na WM_vaše jméno.

VĚDĚLI JSTE, ŽE? Doporučujeme 
vykonání tvrdého resetu před prodejem, 
opravou nebo recyklaci smartphonu, 
aby byli všechny informace vymazány. 
Nezapomeňte také odstranit SIM kartu a 
rozšiřující karty vložené do smartphonu.

Tvrdý reset vám napoví zda problém 
pochází ze smartphonu nebo z nain-
stalované aplikace.
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Jestli nepocítíte problémy po vykoná-
ní tvrdého resetu, problém může sou-
viset s vámi instalovaným softwarem 
(viz. Aplikace pocházející odjinud) pro 
možné podněty pro diagnostikování 
problémů softwarů odjinud.

1.  Synchronizujte smartphone s počí-
tačem, tak aby mohli být aplikace 
a informace synchronizací znovu 
obnoveny, poté co jste vykonali 
tvrdý reset.

2. Držte smartphone obrazovkou 
dolů, použijte dva nebo více prstů 
pro stlačení krytu proti baterii. 
Potom sesuňte kryt ze zadní části 
smartphonu.

3.  Odstraňte a znovu vložte baterii a 
potom vraťte zpět kryt baterie.

4.  Při stisknutí a přidržení End 
, stiskněte a přidržte Power  
dokud  se obrazovka nezapne.

5.  Pokud budete vyzváni stiskněte 
Nahoru  pro vymazání všech dat.

6.  (volitelné) Synchronizujte pro obno-
vení vašich předtím synchronizo-
vaných informací. Pokud používáte 
zálohovací program, bude třeba 
obnovit zálohování, aby obnovilo 
přidané informace a nastavení.

TIP Můžete také provádět tvrdý reset 
použitím Default Settings (standard-
ních nastavení) aplikace na smartphonu. 
Stiskněte Home a potom stiskněte Start 
(levý softkey). Stiskněte More (levý 
softkey), vyberte Accessories a potom 
vyberte Default Settings. Vložte 1234 
( nemusíte stisknout Option) a stiskněte 
OK (levý softkey).

Výměna baterie
Součástí smartphonu je vyměnitel-
ná baterie. Ujistěte se, že používáte 
náhradní baterii kompatibilní s PalmTreo 
500 modelem. Nepoužívejte baterii z 
předešlých modelů smartphonu.

VAROVÁNÍ Je zde riziko exploze ba-
terie, pokud ji nahradíte nesprávným 
typem. Naložte s použitými bateriemi 
dle instrukcí.

TIP Ujistěte se, že nakládáte se starou 
baterií zodpovědně k životnímu prostředí 
a zákonnou cestou. V některých oblastech 
je zakázána likvidace s odpadem z domác-
nosti nebo zaměstnání. Navštivte palm.
com/environment pro více informací.

VĚDĚLI JSTE, ŽE? Smartphone ukládá 
veškeré vaše informace dokonce i když 
vyjmete baterii.



265

1. Stiskněte a přidržte Power  
pro vypnutí smartphonu.

2.  Držte smartphone obrazovkou 
dolů, použijte dva nebo více prstů 
pro stlačení krytu proti baterii. 
Potom sesuňte kryt ze zadní části 
smartphonu.

3.  Vklouzněte prsty pod levou stranu 
baterie a vyjměte ji.

4.  Zarovnejte kontakty baterie s 
kontakty telefonu uvnitř prostoru 
pro baterii.

5.  Vložte novou baterii pod úhlem 
45 stupňů a vtlačte ji na místo.  
Vložte kryt zpět dokud nezapadne 
na místo.

6. Stiskněte a přidržte Power  
dokud se neobjeví logo Palm®.

Výkon
Aplikace běží pomaleji než 
obvykle

1.  Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Accessories .

3. Vyberte Task Manager .

4.  Stiskněte Menu  (pravý 
softkey) a vyberte Close All pro 
zavření všech otevřených aplikací.

5. Stiskněte Done  (levý 
softkey).

Ba
co

S
co

Kontakty 
baterie

Kontakty 
smartphonu
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Pokud předchozí kroky nevyřešili pro-
blém, zkuste provést měkký reset (viz. 
Provedení měkkého resetu). 

Pokud problém přetrvává a vy jste 
vybrali volbu mít Windows Live Mail na 
domovské obrazovce, tak tuto volbu 
vypněte (viz. Nastavení Windows Live 
Mail). 

TIP Ujistěte se, že odjinud pocházející 
aplikace jsou určené pro Windows Mobile 
6 Standard. Aplikace pro Windows Mobile 
6 Profesionál nebo dřívější verze Windows 
Mobile software nespolupracují 
s vaším smartphonem.

Pokud můžete zkusit zdarma verzi softwaru 
před jeho nákupem, můžete jej otestovat a 
ujistit se, že funguje.

Má baterie se rychle vybíjí 
Pokud máte Microsoft Direct Push 
pro email nebo pokud jste nastavili 
program na bezdrátovou synchronizaci, 
kontaktujte vašeho emailového doda-
vatel nebo správce systému a ujistěte 
se, že server je nastaven správně pro 
spolupráci s vaším smartphonem. 
Nesprávné nastavení serveru může 
způsobit nadměrnou zátěž baterie. Pro 
více rad prodloužení životnosti baterie 
(viz. Maximalizování životnosti baterie).

Obrazovka
Obrazovka se zobrazí prázdná
1. Pokud během telefonatu uplyne 

doba nastavená v Power Manage-
ment, obrazovka se ztlumí. Stisk-
něte libovolnou klávesu, kromě 
End  pro obnovení obrazovky. 
Tlačítko End  ukončuje hovor.

2. Podívejte se z blízka na obrazov-
ku. Pokud uvidíte matný obraz, 
zkuste regulovat jas na obrazovce 
(viz. Regulace jasu).

3. Pokud toto nefunguje, proveďte 
měkký reset (viz. Provedení měk-
kého resetu).

4. Pokud toto nefunguje, připojte 
smartphone k AC nabíječce (viz. 
Nabíjení baterie) a znovu proveďte 
měkký reset. 

5. Pokud toto nefunguje, proveďte 
tvrdý reset (viz. Provedení tvrdého 
resetu).
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TIP Pokud používáte aplikace pocházející 
odjinud ujistěte se, že aplikace podporují 
rozlišení obrazovky 320 x 240.

Síťová připojení
Intenzita signálu je slabá
1.  Pokud stojíte, pohybujte se 3 

metry v různém směru.

2.  Pokud jste v budově, pohybujte 
se blízko okna. Otevřete všechny 
kovové žaluzie.

3.  Pokud jste v budově, přesuňte se 
ven nebo na otevřené prostran-
ství.

4.  Pokud jste venku, vzdalte se 
od velkých budov, stromů nebo 
elektrických drátů.

5.  Pokud jste ve vozidle, přesuňte 
smartphone tak, aby byl v jedné 
rovině s oknem.

TIP Obeznamte se s oblastmi slabého po-
krytí ve svém okolí, v zaměstnání, v práci 
atd., aby jste věděli, kde máte očekávat 
problémy s intenzitou signálu.

Můj smartphone se nechce 
připojit k mobilní síti
1.  Zkuste návrhy při slabé intenzitě 

signálu.

2.  Vypněte a znovu zapněte telefon 
(viz. Zapínání a vypínání  Palm® 
Treo™ 500 smartphonu).

3.  Proveďte měkký reset (viz. Prove-
dení měkkého resetu).

Můj telefon se sám od sebe vypíná
Pokud se vyskytne systémová chyba 
a reset, telefon se automaticky zapne, 
pokud byl před resetem zapnut. Nic-
méně pokud váš smartphone nemůže 
určit zda váš telefon byl zapnut před 
resetem, telefon se po resetu automa-
ticky nezapne(viz. Zapínání telefonu).

Nepoznám zda jsou datové 
služby dostupné

Následující ikona se zobrazí na titulní 
liště, signalizuje zda jsou datové 
služby dostupné:

Telefon je připojen k 3G 
UMTS síti, ale nedochází k 
přenosu dat. Můžete telefono-
vat i přijímat hovory.



268

 Telefon je zapnutý a 3G UMTS 
datové spojení je aktivní. Mů-
žete uskutečňovat současně 
přenos dat i odchozí a příchozí 
hovory.

 Jste v roamingové zóně a váš 
telefon je připojen k síti 3G 
UMTS, ale nedochází k aktiv-
nímu přenosu dat. Sazby za 
přenos dat  a volání jsou vyšší.

 Telefon je připojen k síti GPRS, 
ale nedochází k přenosu dat. 
Můžete telefonovat i přijímat 
příchozí hovory.

 Telefon je zapnutý a GPRS 
datové spojení je aktivní. Datový 
přenos bude při telefonování a 
přijímání hovorů automaticky 
přerušen.

 Jste v roamingové zóně a váš 
telefon je připojen k síti GPRS, ale 
nedochází k přenosu dat, sazby za 
přenos dat a volání jsou vyšší.

Můj smartphone se nechce 
připojit k internetu
Váš smartphone podporuje GPRS nebo 
UMTS (3G) bezdrátovou datovou síť. 
Pro připojení k internetu musíte mít 
předplacené datové služby u vašeho 
bezdrátového poskytovatele služeb.

.· Kontaktujte vašeho bezdrátového 
poskytovatele služeb pro ověření, že 
máte tarif zahrnující datové služby a 
že jsou tyto služby aktivovány. Váš 
bezdrátový poskytovatel služeb by 
měl být také schopný vám říct, zda 
jsou ve vašem okolí výpadky sítě.

· Stiskněte Power , vyberte Wi-
reless Manager a potom vyberte 
Phone pro vypnutí telefonu, po-
tom opakujte tyto kroky pro zapnutí.

· Proveďte měkký reset (viz. Prove-
dení měkkého resetu).

· Ověřte si, že datové služby jsou 
správně konfigurované na smart-
phonu provedením následujících 
kroků:

1.  Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings .
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3. Vyberte Phone.

4.  Vyberte More  a potom vyber-
te Networks.

5.  Pokud se objeví jméno provozova-
tele bezdrátové sítě, v aktuálních 
sítích(Current Network), stiskněte 
Done  (levý softkey). Pokud 
se jméno provozovatele nezobra-
zí, kontaktujte jej pro pomoc.

Nemohu poslat nebo přijmout tex-
tové nebo multimediální zprávy
· Ujistěte se, že je váš telefon zapnu-

tý a že se nacházíte v oblasti mobil-
ního pokrytí (viz. zapínání telefonu).

· Kontaktujte vašeho bezdrátového 
poskytovatele služeb, aby potvr-
dil, že váš tarif zahrnujete službu 
messaging, že jsou tyto služby 
aktivované, a že jsou dostupné v 
místě, kde právě jste. Váš bezdrá-
tový poskytovatel služeb by měl 
být schopný  říci vám, jestli služba 
messaging nemá zpoždění při 
přenosu.

· Podle možností, kontaktujte 
příjemce nebo odesílatel zprávy 
a ujistěte se, že je přijímající zaří-
zení schopno přijímat druh zpráv, 
které posíláte. 

· Pokud textová zpráva přijde, ale 
nezobrazí se oznámení, proveďte 
měkký reset (viz.provedení měk-
kého resetu).

· Síťová nastavení pro textové 
a multimediální zprávy jsou 
přednastavena poskytovatelem 
bezdrátových služeb a SIMkarty 
ve smartphonu.  Pokud používáte 
SIM kartu od jiného poskyto-
vatele bezdrátových služeb, je 
třeba nastavit manuálně síťové 
nastavení.(viz. manuálni nastavení 
síťového nastavení)

Nemohu uskutečňovat nebo 
přijímat volání použitím hands 
- free zařízení s Bluetooth® 
bezdrátovou technologií
Ověřte následující:

· Zda je funkce Bluetooth zapnutá 
na smartphonu (viz. Základní 
Bluetooth nastavení).

· Zda je Bluetooth zařízení nabito
a zapnuto.

· Zda je smartphone v dosahu 
hands - free zařízení. Dosah Blue-
tooth za optimálních podmínek je 
10 metrů.
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 Výkon a dosah může být ovlivněn 
fyzikálními překážkami, radiovou 
interferencí s blízkými elektronic-
kými přístroji a dalšími faktory.

·  Že jste mimo další zařízení použí-
vající 2.4 GHZ radiovou frekvenci 
např. bezdrátové telefony, mikro-
vlnky a WiFi zařízení. Pokud je to 
možné přibližte se s telefonem k 
hands – free zařízení. 

· Zda je zařízení kompatibilní s 
vašim s vašim smartphonem.

Ztratil jsem spojení mezi 
smartphonem a Bluetooth® 
náhlavní soupravou
Pokud náhlavní souprava nefunguje, 
vymažte existující spojení (partner-
ship) a vytvořte novou. Pro výmaz 
spojení:

1. Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte More  (levý softkey) 
a vyberte Settings .

3. Vyberte Connections a potom 
vyberte Bluetooth.

4. V seznamu Bluetooth Devices, zvý-
razněte náhlavní soupravu-headset.

5. Stiskněte Menu  (pravý 
softkey), vyberte Delete  a 
potom stiskněte Yes  (levý 
softkey) pro potvrzení zrušení.

6. Vytvořte novou spolupráci (viz.
připojení k zařízením s Bluetooth 
bezdrátovou technologií).

Synchronizace: přehled
Synchronizace vám umožní záloho-
vat informace ze smartphonu na váš 
počítač nebo server. Pokud někdy 
potřebujete provést tvrdý reset nebo 
jinak vymazat veškeré informace ze 
smartphonu, můžete synchronizovat 
smartphone s vaším počítačem, k 
tomu abyste uložili informace. Ověřte 
si zda vždy máte zálohovány aktuální 
informace, synchronizujte často. 

Můžete synchronizovat email a další 
informace přímo z Microsoft Exchan-
ge Server 2003 Service Pack 2, nebo 
Exchange Server 2007 používáním 
Microsoft Exchange ActiveSync® 
můžete synchronizovat smartphone s 
počítačem, používáním synchronizační-
ho softwaru,přístupného ze spojení na 
Windows Mobile Getting Started CD. 
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VĚDĚLI JSTE, ŽE? Můžete najít více in-
formací na stránkách windowsmobile.com.

VĚDĚLI JSTE, ŽE? Běžnou příčinou 
problémů se synchronizací, je přítomnost 
ochranného softwaru, jako je VPNS nebo 
firewall na vašem počítači nebo síti.

Synchronizace 
desktop 
synchronizační 
software

Tato část zahrnuje otázky spojené s 
používáním desktopu synchronizač-
ního softwaru, který jste obdrželi s 
vaším smartp honem. Pokud máte 
počítač s Windows XP, synchronizač-
ní software se nazývá ActiveSync®. 
Pokud máte počítač s Windows 
Vista, synchronizační software se 
nazývá Windows Mobile Device 
Center.

POZNÁMKA (viz.synchronizace: 
Exchange ActiveSync bezdrátová 
synchronizace) pro pomoc s přímou 
bezdrátovou synchronizací Exchange 
serverem.

Desktop synchronizační soft-
ware nereaguje na pokus o 
synchronizaci

Po dokončení jednotlivých kroků, 
zkuste synchronizaci,pokud je 
synchronizace úspěšná, nemusíte již 
zbývající kroky dokončovat.

1  Ověřte si, že USB synchronizační 
kabel je správně připojen (viz.
připojení smartphonu k počítači).

2 Ujistěte se, že všechny soubory, 
které zkoušíte synchronizovat 
jsou zavřené, na počítači i smart-
phonu.

3  Ve Windows XP počítači, hle-
dejte ikonu ActiveSync  na 
nástrojové liště. Ujistěte se, že je 
ActiveSync desktop software v 
činnosti na počítači.

 Pokud nejsou zobrazeny správné 
ikony , proveďte následující:

 Smartphone: Home  potom 
Start  (levý softkey).
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 Stiskněte 2x More  (levý 
softkey) a vyberte ActiveSync 

. Stiskněte Menu  (pravý 
softkey) a vyberte Connections. 
Ujistěte se, že rámeček Synchro-
nize all PCs using this con-
nection je zaškrtnutý, a že je ze 
seznamu vybrán USB.

 Počítač s Windows XP: 
Klikněte na Start, přesuňte se 
do Programs a potom vyberte 
Microsoft ActiveSync.

 Počítač s Windows Vista: Klik-
něte na Start, vyberte All Programs 
a potom vyberte Windows Mobile 
Device Center.

4 Proveďte jednu z následujících:
 Počítač s Windows XP: Dvoj-

klikněte na ikonu ActiveSync 
  na nástrojové liště. Z File menu 

vyberte Connection Settings. 
Ujistěte se, že rámeček Allow 
USB connections box je zaškrt-
nutý a potom klikněte na Connect. 

 Počítač s Windows Vista: 
Klikněte na Start, vyberte All 
Programs a potom vyberte Win-
dows Mobile Device Center. 
Vyberte Connect without 
setting up your device a potom 

vyberte Connection settings.
Ujistěte se, že je rámeček Allow 
USB connections box zaškrtnu-
tý a klikněte na Connect.

5 proveďte měkký reset (viz.provede-
ní měkkého resetu).

6  Spusťte znovu váš počítač a 
ujistěte se, že desktop synchroni-
zační software běží.

7  Pokud problém přetrvává, aktivuj-
te rozšířené nastavení. Stiskněte 
Home a potom stiskněte Start 

 (levý softkey). Stiskněte 
More  (levý softkey) a vyberte 
Settings . Vyberte Con-
nections, vyberte More a po-
tom vyberte USB PC. Zaškrtněte 
rámeček pro Enable advanced 
network functionality.

8  Pokud problém přetrvává a vy 
synchronizujete přes USB rozbo-
čovač, zkuste připojit synchroni-
zační kabel do jiného USB portu 
nebo přímo do zabudovaného 
USB portu na vašem počítači.

9  Pokud již synchronizujete přes 
zabudovaný USB port na počítači, 
přesuňte synchronizační kabel do 
USB portu na zadní straně počí-
tače, pokud má váš počítač USB 
porty na obou těchto místech.
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10  Odinstalujte desktop synchroni-
zační software, který jste obdrželi 
se smartphonem, spusťte znovu 
počítač a potom vložte Windows 
Mobile Getting Started CD, které 
jste obdrželi se smartphonem. 
Opakujte instalační proces (viz.
reinstalování desktop softwaru).

11 U Windows XP počítače, jen 
vymažte existující spolupráci mezi 
smartphonem a počítačem a 
vytvořte nový postupně následují-
cími kroky:

· Odpojte smartphone a počítač 
od synchronizačního kabelu.

·  Klikněte pravým tlačítkem myši 
na šedou ikonu ActiveSync 

 na nástrojové liště dolním 
pravém rohu obrazovky počí-
tače a potom vyberte Open 
Microsoft ActiveSync.

·  Klikněte na File a potom klikně-
te na Delete Mobile Device. 
Pokud budete vyzvání potvrďte 
kliknutím na Yes.

· Připojte smartphone a počítač k 
synchronizačnímu kabelu.

· Pokud se objeví průvodce 
nastavení synchronizace, 

následujte kroky ke zřízení 
synchronizačního vztahu mezi 
smartphonem a počítačem.

12  Pokud vaše organizace používá 
firewall nebo VPN spojení, synchro-
nizace s ActiveSync nemusí fungo-
vat. Pouze u Windows XP počítače, 
přejděte na stránky Microsoft.com 
a hledejte následující témata pro 
pomoc ve specifických situacích při 
nastavování firewallu:

· ActiveSync USB spojení průvod-
ce řešením problémů.

· ActiveSync se Sygate Personal 
Firewall

·  ActiveSync s TrendMicro PC-
cillin Internet Security

· ActiveSync s Norton Personal 
Firewall

·  ActiveSync se Zone Alarm Secu-
rity Suite

·  ActiveSync s McAfee Personal 
Firewall

· ActiveSync s Windows firewall

13  Ověřte si u prodavače počítačového 
hardwaru, zda vaše operační systé-
mové příslušenství podporuje vnitřní 
USB controller.
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Synchronizace skončí, ale infor-
mace se neobjeví, kde by měla
Nejprve zkontrolujte, zda některá z 
těchto položek platí pro vaši situaci:
· S desktop synchronizačním soft-

warem, může váš smartphone 
synchronizovat složky Microsoft 
Office Outlook kontakty, kalendář a 
úkoly (Outlook je v prodeji samostat-
ně;bezplatná í verze pro vyzkoušení 
je k dispozici ke stažení na Windows 
Mobile Getting Started CD). Pokud 
chcete synchronizovat s globálním 
Exchange Address Book, musíte 
zkopírovat adresy do kontaktních 
adres v Microsoft Office Outlook 
(kliknněte pravým tlačítkem na 
adresy a vyberte Add to Personal 
Address Book)

· Podřízené složky a veřejné složky 
Microsoft Office Outlook, nejsou 
přístupné se zahrnutým softwarem. 
Místo toho můžete použít řešení 
odjinud (softwarem od jiného doda-
vatele). 

· Pokud zkoušíte synchronizaci 
offline, ujistěte se, že jste nastavili 
Microsoft Office Outlook kalendář, 
kontakty a úkoly k dispozici offline.
Pokud máte ještě problémy, zkuste 
následující:

1  Ověřte si, zda synchronizujete 
s desktop osobním manažerem 
informací (PIM). Windows Mobile 
Getting Started CD obsahuje desk-
top software synchronizaci, ta vám 
umožní synchronizovat Microsoft 
Outlook pro Windows. Pokud použí-
váte jiný PIM, je třeba, aby jste pro 
synchronizaci instalovali software 
odjinud. Pro více informací se poraď-
te se společností, která PIM vyrábí.

2 Otevřete desktop synchronizač-
ní software na vašem počítači a 
ujistěte se, že volba synchronizace 
souborů je vybraná (viz.výběr apli-
kací k synchronizaci).

3 Odinstalujte desktop synchroni-
zační software, restartujte počítač, 
vložte Windows Mobile Getting 
Started CD, které jste obdrželi se 
smartphone a potom opakujte 
instalační proces (viz.reinstalování 
desktop softwaru).

Synchronizace začne, ale neu-
končí se
Ujistit se, že jste instalovali desktop 
software, patřící k vašemu smart-
phonu. Pokud si nejte jisti, zda tento 
software je instalován, znovu jej 
nainstalujte (viz.reinstalování desktop 
softwaru).
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Mé video a hudební soubory se 
nesynchronizují
1.  Ověřte si, zda máte instalován Win-

dows Media Player10 nebo novější 
na vašem počítači

2.  Znovu nainstalujte desktop syn-
chronizační software, přístupný ze 
spojení na Windows Mobile Get-
ting Started CD, které jste obdrželi 
se smartphonem (viz. Reinstalování 
desktop softwaru).  Synchronizace 
mediálních souborů selhává, pokud 
jste instalovali desktop synchroni-
zační software předtím, než jste 
instalovali Windows Media Player.

Mé schůzky se zobrazují ve 
špatném časovém úseku poté 
co synchronizuji
1.  Ujistit se, že jste instalovali desktop 

synchronizační software, který jste 
obdrželi se smartphonem. Pokud 
si nejste jisti zda je tento software 
instalován, znovu jej instalujte (viz. 
Reinstalování desktop softwaru).

2.  Otevřete Microsoft Office Outlook 
a opravte chybné zápisy.

3.  Manuálně zadejte informace, které 
jste přidali na smartphone před 
poslední synchronizací.

4.  Synchronizujte smartphone s počí-
tačem.

Má naplánovaná synchronizace 
nefunguje
Standardně naplánovaná synchroniza-
ce nefunguje při roamingu. Toto před-
chází zvýšení poplatků za účet. Pokud 
vás poplatky neznepokojují, následujte 
tyto kroky pro nastavení pokračování 
plánu synchronizace i při roamingu:

1 Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte 2x More (levý softkey) 
a vyberte ActiveSync  .

3. Stiskněte Menu (pravý softkey) a 
vyberte Schedule.

4. Zaškrtněte rámeček Use above 
setting when roaming.

5. Stiskněte Done  (levý softkey).

Výstraha mi oznamuje, že se 
ActiveSync setkal s problé-
mem na serveru
Může být dočasný problém se serve-
rem nebo server může být dočasně
přetížený. Zkuste to později znovu. 
Pokud problém přetrvává, kontaktujte 
vašeho správce systému.
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Výstraha mi oznamuje, že není 
dost volné paměti pro synchro-
nizaci informaci

ActiveSync aplikace na vašem smart-
phonu vyčerpala zásobu prostoru 
paměti. Zkuste následující:

1.  Zavřete všechny spuštěné progra-
my (viz. Zavírání aplikací).

2. Pokud problém přetrvává, podí-
vejte se na návrhy (viz. Vytvoření 
prostoru na vašem smartphonu), 
jak uvolnit místo na smartphonu.

Výstraha mi oznamuje, že Acti-
veSync se setkala s problémem 
[typ položky], [jméno položky]

Chyba nastala během synchronizace 
jednotlivých položek. Tato chyba 
může být obvykle opravena jen 
odstraněním položky, která způsobila 
chybu. Pokud synchronizujete, znovu 
uvidíte, zda chyba přetrvává, buďte si 
vědomi toho, že položky způsobující 
tento druh chyby, jsou přeskočeny a 
neukáží se znovu.

Moje nastavení domovské 
obrazovky není obnovena po 
tvrdém resetu

Nastavení jako např. pozadí nejsou 
během synchronizace zálohovány, 
takže nemohou být obnoveny po 
tvrdém resetu. Pokud používáte zálo-
hovací program, můžete být schopni 
obnovit zálohování, aby obnovilo 
nastavení a další dodatečné informa-
ce domovské obrazovky.

Synchronizace 
Exchange ActiveSync 
(bezdrátová 
synchronizace)

Tato část zahrnuje otázky spojené s 
přímou bezdrátovou synchronizací s 
Exchange serverem (viz. Synchroni-
zace: desktop synchronizační soft-
ware). Pro pomoc se synchronizací 
za použití desktop synchronizačního 
softwaru.
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TIP Pokud synchronizujete s Exchange 
Serverem a nebudete schopni změnit vaše 
nastavení, kontaktujte vašeho správce sys-
tému, abyste zjistili zdali je server pro tuto 
ověřovací metodu nakonfigurovaný.

Výstraha mi oznamuje,
že server nemohl být dosažený
Váš smartphone musel čekat příliš 
dlouho na připojení k Exchange ser-
veru. Spojení bylo možná ztracené, 
server mohl být dočasně přetížený 
nebo se server možná setkal s interní 
chybou: Zkontrolujte vaše Exchange 
server jméno a nastavte zprostřed-
kovatelský server (viz. Nastavení 
bezdrátové synchronizace) a zkuste 
to později znovu.

Výstraha mi oznamuje,že 
informace o mém účtu nebyly 
nalezeny
Když jste nastavovali Exchange 
server volby synchronizace, pověřo-
vací stránka byla zanechána prázd-
ná. Opravte pověřovací listy (viz. 
Nastavení bezdrátové synchronizace) 
nebo nastavte smartphone pouze pro 
synchronizaci s počítačema zkuste 
synchronizovat znovu.

Výstraha mi oznamuje, že zaří-
zení se odpojilo při čekání na 
pověření
Exchange server pověřovací obra-
zovky byl zanechán otevřený příliš 
dlouho.  Znovu vložte data Exchange 
server pověřovací listy a zkuste syn-
chronizaci znovu.

Email
Mám problémy při používání 
mého účtu
Příležitostně můžete zažít problémy při 
používání emailového účtu, potom co 
jste jej nastavili. Pokud jste následovali 
návod na nastavení (viz. Nastavení 
emailu) a přesto máte problémy při po-
užívání účtu, ověřte si, že účet vyhovuje 
požadavkům vašeho emailového posky-
tovatele následováním těchto kroků:

· Zkontrolujte vaše heslo i uživatelské 
jméno pro váš emailový účet

· Někteří poskytovatelé emailových 
služeb požadují, abyste používali váš 
emailový účet na jejich síti. Pokud 
je tomu tak, ujistěte se, že užíváte 
vaši dodavatelskou síť pro spojení s 
vaším účtem.
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·  Někteří poskytovatelé emailo-
vých služeb mají další specifické 
požadavky pro své služby.Napří-
klad Yahoo! vyžadujte, aby jste 
nastavili POP pro zasílání pošty na 
Yahoo! účet pro stahování emailo-
vých zpráv na smartphone. Zjistěte 
se u poskytovatele služeb zda má 
nějaké další specifické požadavky.

·  Nastavení poskytovatele služeb 
se často mění. Pokud váš emai-
lový účet fungoval, ale vy máte 
aktuálně problémy, kontaktujte 
vašeho poskytovatele služeb, 
zda nedošlo ke změně nastavení 
účtu.

Mám problém s odesíláním
a přijímáním emailu
Krátká časová období, kdy je email 
nedostupný, jsou běžná kvůli problé-
mům serveru nebo nedostatečnému 
bezdrátovému pokrytí. Pokud máte 
problémy s odesíláním nebo přijímá-
ním pošty po delší časové období, 
kontaktujte ISP nebo poskytovatele 
emailový služeb pro to, aby ověřil, že 
služba funguje správně.

Naplánovaná emailová syn-
chronizace nepracuje
Pokud probíhá synchronizace emailu 
a vy vypnete smartphone nebo se 
přeruší spojení s poskytovatelem 
emailových služeb, synchronizace 
selhává.

·  Zkontrolujte plán synchronizace, 
aby jste se ujistili, že je emailová 
synchronizace nastavena tak, 
aby začala v určený den a čas(viz. 
Nastavení plánu synchronizace). 

·  Stiskněte Home  potom 
Start  (levý softkey). Stiskněte 
2x More  (levý softkey) a vy-
berte ActiveSync  . Stiskněte 
Menu  (pravý softkey) a vy-
berte Configure Server. Ujistěte 
se, že je ověření hesla nastaveno. 
Toto je požadováno pro synchro-
nizaci (vzduchem).

Mám problémy s odesíláním 
emailu
Pokud jste schopni přijmout emailové 
zprávy, ale nemůžete je posílat, vy-
zkoušejte postupně následující kroky:

·  Ujistěte se, že ISP nebo poskyto-
vatel emailových služeb vám povo-
lí zpřístupnit email na smartphonu.
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 Někteří provozovatelé vůbec tyto 
služby nenabízejí a jiní dodavatelé 
požadují aktualizaci pro zpřístupnění 
emailu na smartphonu.

 · Stiskněte Home  potom Start 
 (levý softkey). Stiskněte 2x 

More  (levý softkey) a vyberte 
ActiveSync . Stiskněte Menu 

 (pravý softkey) a vyberte Con-
figure Server. Ujistěte se, že je 
zaškrtnutý rámeček This server 
requires an encrypted (SSL) 
connection.

· Vložte jméno jiného serveru odchozí 
pošty pro odesílání pošty. Mnoho 
ISP např. kabelové společnosti poža-
dují, abyste měli internetové připo-
jení k jejich síti pro odesílání emailů 
z jejich serveru. V tomto případě, 
můžete téměř vždy přijmout email 
z těchto účtů, ale pokud chcete 
poslat email, musíte jej poslat přes 
jiný server (viz. Nastavení POP/IMAP 
účtu: Běžní emailoví dodavatelé).

Mé vCard nebo vCal emailové 
přílohy nejsou posílány správně
Microsoft Office Outlook poskytuje ně-
kolik funkcí, včetně vCard a vCal, které 
spolupracují s emailovým klientským 

softwarem na Windows počítači. Proto, 
aby tyto funkce pracovaly správně musí 
být řádně nastaven emailový klientský 
software. Následujte tyto kroky pro 
kontrolu nastavení:

1.  Klikněte na Start na vašem počíta-
či a potom vyberte Settings.

2. Vyberte Control Panel.
3. Vyberte Internet Options a potom 

klikněte Program tabulátor.
4. Ujistěte se, že v emailovém poli je 

nastaven správný emailový klient-
ský software.

5. Klikněte na OK.

6. Spusťte emailový klientský software 
a ujistěte se, že je konfigurován na 
standard MAPI klienta. Podívejte se 
do dokumentace vaší desktop emai-
lové aplikace pro více informací.

Když synchronizuji s Exchange 
server, mé informace se nestáh-
nou na smartphone
U svého správce systému získejte 
jméno poštovního serveru, který vám 
nabízí bezdrátový přístup ke korpo-
račnímu poštovnímu systému. Pokud 
nemůžete získat jméno tohoto serveru 
(některé společnosti jej nedávají, proto-
že nechtějí bezdrátový přístup k jejich
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 serverům), nemůžete užívat Exchange 
ActiveSync a synchronizovat se Exchan-
ge serverem. Můžete také zkontrolovat 
následující nastavení:

1.  Stiskněte Home  potom Start 
 (levý softkey).

2. Stiskněte 2x More  (levý 
softkey) a vyberte ActiveSync  

3. Stiskněte Menu  (pravý 
softkey) a vyberte Configure 
Server.

4. Ujistěte se, že je rámeček This 
server requires an enscrypted 
(SSL) connection zaškrtnutý. 

Web
Nemohu zpřístupnit webovou 
stránku
Nejprve si ověřte, zda máte přístup na 
Internetu: Otevřete Internet Explorer 
Mobile a zkuste zobrazit webovou 
stránku, kterou jste stáhli již dříve. 
Pro ujištění, že zobrazujete stránku 
přímo z Internetu, stiskněte Menu  
(pravý softkey) a vyberte Refresh. Po 
potvrzení internetového spojení, zkuste 
zobrazit zmíněnou stránku znovu. 
Pokud se zobrazí prázdná, stiskněte 

Menu  (pravý softkey) a vyberte 
Refresh. Pokud máte ještě problém, 
stránka může obsahovat elementy, 
které nejsou podporované Internet Ex-
plorer Mobile např. Flash, Shockwave, 
VBScript, WML skript a jiné plug-iny.

Nějaké websajty užívají program zajišťu-
jící přesměrování k jejich skutečné do-
movské stránce. Například, když vložíte 
adresu http://palm.com/support může 
přejít na http://palm.com/us/support. 
Pokud Internet Explorer Mobile nemů-
že následovat přesměrování, zkuste 
použít desktop prohlížeč, pro zobrazení 
vstupní stránky programu zajišťujícího 
přesměrování a zadejte tuto adresu do 
Internet Explorer Mobile.

TIP Váš smartphone může otevřít vaši 
emailovou aplikaci, když vyberete emai-
lovou adresu na webové stránce. Pokud 
se nic nestane, když zvýrazníte spojení, 
zkuste nejprve nastavit vaší emailovou 
aplikaci (viz. Nastavení emailu).

Obrázek nebo mapa se zobrazují pří-
liš malé na obrazovce smartphonu 
Internet Explorer Mobile má několik 
zobrazovacích režimů: jeden sloupec, 
standardní, Desktop a celá obrazovka. 
Přepněte na Desktop pro zobrazení plné 
velikosti obrázku (viz. Prohledávání webu).
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Bezpečné stránky odmítají 
povolit spojení
Některé websajty nepodporují jisté 
prohlížeče pro spojení. Prosím kon-
taktujte správce stránky a ujistěte se, 
že stránka povoluje spojení použitím 
Internet Explorer Mobile.

Bluetooth® 
bezdrátová 
technologie

Nejsem schopný poslat in-
formace použitím Bluetooth 
spojení s dalším zařízením
Ujistěte se, že druhé zařízení má zapnu-
tou volbu viditelnosti pro Bluetooth. 

Nejsem schopný přijmout in-
formace od jiného zařízení po-
sílané přes Bluetooth spojení
Ujistěte se, že je volba pro přijímání 
přenesených informací na vašem 
smartphonu zapnutá (viz. Zapínání vol-
by pro příjem přenesených informací).

Fotoaparát

VĚDĚLI JSTE, ŽE? Obrázky jsou
v 16-ti bitové barvě. Nastavení rozlišení 
je v rozsahu od nízkého 96 x 72 pixelů k 
vysokému 1600 x 1200 pixelů. Nastavení 
rozlišení videa je v rozsahu od nízkého 176 
x 144 pixelů k vysokému 320 x 240 pixelů.  
Změnit nastavení můžete stisknutím 
Menu (pravý softkey) a vybráním Resolu-
tion (obrázky) nebo Quality (video).

Zde jsou rady pro to jak fotit kvalitní 
obrázky zabudovaným fotoaparátem:

·  Čistěte čočky měkkým hadříkem 
bez volných vláken.

·  Foťte obrázky v dobrých světel-
ných podmínkách.  

·  Obrázky focené ve špatných 
světelných podmínkách, mohou 
být zrnité s ohledem na citlivost 
fotoaparátu.

·  Držte fotoaparát v co nejvíc v kli-
du. Zkuste si opřít ruku při focení 
o tělo nebo o nehybný objekt 
(např. zeď).
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·  Držte objekt focení v klidu. Doba 
expozice je delší s nižšími světlými 
podmínkami, takže můžete vidět 
rozmazaně.

·  Pro co nejlepší výsledky si ověřte, 
že máte dobrý světelný zdroj 
přicházející za vašimi zády a dobré 
osvětlení tváře objektu.

·  Vyhněte se focení obrázků uvnitř 
místnosti s objekty před oknem 
nebo osvětlením.

·  Ujistěte se, že je předmět při-
nejmenším 0.5 metru vzdálený od 
fotoaparátu, pro zajištění zaostření.

Nezapomeňte, že když synchronizu-
jete s Windows XP počítačem, vaše 
fotografie jsou uložené 
v C:\Documents a Settings\
<Username>\My documents\Treo 
My Documents složce na vašem 
pevném disku (viz. Fotoaparát).

Náhled obrázku vypadá jinak
Nějaké odjinud pocházející aplikace 
přepíší nastavení barev na vašem 
smartphonu svým vlastním 8-bito-
vým barevným nastavením. Toto 
může ovlivnit režim náhledu obrázku. 
Vymažte odjinud pocházející aplika-
ce jednu po druhé dokud se obraz 

náhledu nezlepší (viz. Odstraňování 
aplikací).

Odjinud pocházející 
aplikace
Některé odjinud pocházející aplikace 
mohou způsobit konflikty na vašem 
smartphonu. Odjinud pocházející 
aplikace, které modifikují bezdrátové 
funkce mohou ovlivnit výkon smart-
phonu a mohou působit problémy. 
Dávejte pozor při instalaci následují-
cích aplikací:

· Ringtone manažeři

· Aplikace ID Volajícího 

· Instant messaging

· Aplikace, které modifikují zapínání 
a vypínání telefonu nebo da-
tových spojení a to jak se váš 
telefon chová.

Pokud jste nedávno instalovali apli-
kaci a váš smartphone se zasekává, 
zkuste následující:
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1.  Proveďte měkký reset (viz. Prove-
dení měkkého resetu).

2. Ujistěte se, že odjinud pocházející 
aplikace je kompatibilní s Win-
dows Mobile 6 Standard operač-
ním systémem na smartphonu.

3. Vymažte poslední instalovanou 
aplikaci z vašeho smartphonu (viz. 
Odstranění aplikací).

4. Pokud problém přetrvává proveď-
te další měkký reset.

5. Pokud možno synchronizujte 
nebo použijte zálohovací program 
pro zálohování vašich posledních 
informací.

6. Proveďte tvrdý reset (viz. Prove-
dení tvrdého resetu).

7. Synchronizujte nebo obnovte zá-
lohování, aby obnovilo informace 
v zabudovaných aplikacích.

8. Po vyřešení problému, začněte 
znovu instalovat vaše odjinud po-
cházející aplikace jednu po druhé.

9. Pokud se problém znovu objeví, 
vymažte poslední instalovanou 
aplikaci a oznamte problém jeho 
vývojáři.

Další informace 
Kontaktujte prodávajícího jakéhokoli 
softwaru pocházejícího odjinud, 
pokud potřebujete pomoc.

TIP Pamatujte si, že ne všechny odjinud 
pocházející aplikace byly vytvořené pro 
Treo 500 smartphone klávesnici a 5-ti 
polohové tlačítko. Můžete se setkat s 
nadstandardním chováním nebo chyba-
mi v těchto aplikacích, pokud používáte 
klávesnici a 5-ti polohové tlačítko.

Vytvoření místa 
na smartphonu
Jestli ukládáte velké množství infor-
mací nebo instalujete mnoho aplikací
pocházejících odjinud, vnitřní paměť 
na vašem smartphonu se může napl-
nit. Zde jsou běžné způsoby vytvoře-
ní místa na vašem smartphonu:

· Fotoaparát: Velké obrázky nebo 
videa zaberou hodně paměti. Pře-
suňte obrázky na rozšiřující kartu 
nebo vymažte obrázky ze smart-
phone (viz. Obrázky & videa).

· Zprávy: Multimediální obsah a 
emailové přílohy mohou konzumovat



284

 nadměrně paměť. Přesuňte 
multimediální obsah a přílohy do 
rozšiřující karty nebo vymažte 
velké soubory  ze smartphonu 
(viz. Výmaz zprávy a výmaz 
zpráv). Můžete také pokud chcete 
vyprázdnit složku obsahující Vy-
mazané položky.

· Internet: Pokud ukládáte spojení 
na stránky, které jste navštívili v 
Internet Explorer Mobile, můžete 
je vymazat (viz. Přizpůsobení na-
stavení Internet Explorer Mobile).

· Odjinud pocházející aplikace: 
Můžete vymazat zřídka užívané 
aplikace nebo je přesunout na 
rozšiřující kartu (viz. Kopírovaní 
nebo přesun aplikací a souborů 
mezi smartphonem a rozšiřující 
kartou).

Také si pamatujte, že smartphone 
obsahuje zásobník na rozšiřující 
karty a že můžete ukládat aplikace 
a informace na rozšiřujících kartách. 
Nicméně ještě potřebujete volnou 
paměť na smartphonu pro spuštění 
aplikací z rozšiřující karty.

Hlasová kvalita
Slyší druhá osoba ozvěny 
hlasu?
Zkuste postupně následující:

· Zkuste snížit hlasitost na smart-
phonu a vyhnout se tak vazbě 
nebo ozvěně na druhém konci (u 
druhého volajícího). Toto platí pro 
hlasitý odposlech i sluchátka.

· Umístěte smartphone blíže k 
vašemu uchu, aby se předešlo 
prosakování zvuku zpět do mik-
rofonu. Držte vaši ruku od otvoru 
mikrofonu, který je na dolní pravé 
straně smartphonu.

· Pokud používáte hlasitý režim hla-
sitého odposlechu na smartphonu 
ležícího na rovné ploše, zkuste 
otočit smartphone obrazovkou 
dolů.

Slyšíte ozvěnu svého vlastního 
hlasu?
Požádejte osobu na druhém konci, 
aby zeslabila hlasitost nebo držela 
telefon blíže u ucha.
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Váš hlas je příliš tichý
na druhém konci?

Ujistěte se, že držíte spodní část 
smartphonu nebo hands-free mikro-
fonu blízko úst.

Zkontrolujte indikátor intenzity sig-
nálu. Pokud je signál slabý, zkuste najít 
místo s lepším pokrytím.


